### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assigning a static IP address</td>
<td>48</td>
</tr>
<tr>
<td>Changing wireless settings after installation</td>
<td>48</td>
</tr>
<tr>
<td>Switching between USB and wireless connections (Windows only)</td>
<td>49</td>
</tr>
<tr>
<td>Switching between USB and wireless connections (Macintosh only)</td>
<td>50</td>
</tr>
<tr>
<td><strong>Advanced wireless setup</strong></td>
<td>51</td>
</tr>
<tr>
<td>Creating an ad hoc wireless network</td>
<td>51</td>
</tr>
<tr>
<td>Adding a printer to an existing ad hoc wireless network</td>
<td>53</td>
</tr>
<tr>
<td>Using WPS (Wi-Fi Protected Setup)</td>
<td>54</td>
</tr>
<tr>
<td><strong>Frequently asked questions</strong></td>
<td>54</td>
</tr>
<tr>
<td>Where do I find my WEP key or WPA passphrase?</td>
<td>54</td>
</tr>
<tr>
<td>What is an SSID?</td>
<td>54</td>
</tr>
<tr>
<td>Where do I find my SSID?</td>
<td>55</td>
</tr>
<tr>
<td>What is a network?</td>
<td>55</td>
</tr>
<tr>
<td>What types of wireless network security are available?</td>
<td>55</td>
</tr>
<tr>
<td>How do I find out what type of security my network is using?</td>
<td>56</td>
</tr>
<tr>
<td>How are home networks configured?</td>
<td>56</td>
</tr>
<tr>
<td>Why do I need an installation cable?</td>
<td>58</td>
</tr>
<tr>
<td>How do I attach the installation cable?</td>
<td>59</td>
</tr>
<tr>
<td>How are infrastructure and ad hoc networks different?</td>
<td>59</td>
</tr>
<tr>
<td>Finding the signal strength</td>
<td>60</td>
</tr>
<tr>
<td>How can I improve wireless signal strength?</td>
<td>61</td>
</tr>
<tr>
<td>Can I use my printer on a USB and a network connection at the same time?</td>
<td>62</td>
</tr>
<tr>
<td>What is a MAC address?</td>
<td>62</td>
</tr>
<tr>
<td>How do I find the MAC address?</td>
<td>62</td>
</tr>
<tr>
<td>What is an IP address?</td>
<td>63</td>
</tr>
<tr>
<td>What is TCP/IP?</td>
<td>63</td>
</tr>
<tr>
<td>How do I locate IP addresses?</td>
<td>63</td>
</tr>
<tr>
<td>How are IP addresses assigned?</td>
<td>64</td>
</tr>
<tr>
<td>What is a key index?</td>
<td>64</td>
</tr>
<tr>
<td><strong>Loading paper</strong></td>
<td>66</td>
</tr>
<tr>
<td>Loading paper</td>
<td>66</td>
</tr>
<tr>
<td>Loading various paper types</td>
<td>66</td>
</tr>
<tr>
<td>Loading original documents on the scanner glass</td>
<td>70</td>
</tr>
<tr>
<td>Loading original documents into the Automatic Document Feeder</td>
<td>71</td>
</tr>
<tr>
<td>Using the automatic paper type sensor</td>
<td>73</td>
</tr>
<tr>
<td><strong>Printing</strong></td>
<td>74</td>
</tr>
<tr>
<td>Printing basic documents</td>
<td>74</td>
</tr>
<tr>
<td>Printing a document</td>
<td>74</td>
</tr>
<tr>
<td>Printing Web pages</td>
<td>74</td>
</tr>
<tr>
<td>Printing multiple copies of a document</td>
<td>75</td>
</tr>
</tbody>
</table>
Collating printed copies .................................................................................................................. 75
Printing the last page first (reverse page order) ............................................................................. 76
Printing multiple pages on one sheet (N-Up) .................................................................................... 76
Printing documents from a memory card or flash drive ................................................................. 77
Printing specialty documents ........................................................................................................... 78
Choosing compatible specialty paper types ....................................................................................... 78
Printing envelopes ............................................................................................................................. 79
Printing labels .................................................................................................................................. 79
Printing on custom-size paper .......................................................................................................... 80
Managing print jobs .......................................................................................................................... 81
Pausing print jobs ............................................................................................................................... 81
Resuming print jobs ......................................................................................................................... 82
Canceling print jobs .......................................................................................................................... 83

Working with photos ....................................................................................................................... 85
Connecting photo storage devices ................................................................................................... 85
Inserting a memory card .................................................................................................................... 85
Inserting a flash drive ........................................................................................................................ 86
Printing photos .................................................................................................................................. 87
Printing photos using the printer control panel ................................................................................ 87
Printing photos from the computer using the printer software ....................................................... 88
Printing photos from a memory device using the printer software ............................................... 88
Printing photos from a PictBridge-enabled digital camera ............................................................ 90
Printing photos stored on a memory device using the proof sheet ............................................... 91
Printing photos from a digital camera using DPOF ......................................................................... 92

Scanning ............................................................................................................................................. 93
Scanning original documents .......................................................................................................... 93
Scanning color or black-and-white original documents ................................................................. 95
Scanning photos for editing ........................................................................................................... 95
Scanning to a computer over a network .......................................................................................... 96
Canceling scan jobs ......................................................................................................................... 96

Copying ........................................................................................................................................... 98
Making copies ................................................................................................................................. 98
Copying photos ............................................................................................................................... 98
Enlarging or reducing images ......................................................................................................... 98
Adjusting copy quality .................................................................................................................. 99
Making a copy lighter or darker .................................................................................................... 99
Collating copies using the printer control panel .......................................................................... 100
Repeating an image on one page .................................................................................................. 101
Faxing.................................................................103

Sending a fax.................................................................103
  Sending a fax using the printer control panel .................103
  Sending a fax while listening to a call (On Hook Dial) .......103
  Sending a broadcast fax at a scheduled time ..................104
Receiving a fax..............................................................105
  Receiving a fax automatically .......................................105
  Receiving a fax manually ..............................................105
  Receiving a fax with an answering machine ................105
  Forwarding faxes .........................................................106

Customizing dial settings ..............................................106
  Setting up the Address Book .......................................106
  Setting up a dialing prefix ...........................................107
  Setting up Caller ID ......................................................107
  Setting the distinctive ring .........................................107
  Setting a fax manual answer code ...............................108
  Setting up to fax while behind a PBX .........................108

Managing faxes ............................................................108
  Setting up a fax footer ................................................108
  Printing fax activity reports .......................................109
  Printing the Fax Settings List ......................................109
  Blocking junk faxes .....................................................109
  Blocking unwanted changes to fax settings .................110

Maintaining the printer .................................................111

Maintaining print cartridges .........................................111
  Installing print cartridges ............................................111
  Removing a used print cartridge ...................................112
  Refilling print cartridges .............................................113
  Using genuine Lexmark print cartridges .......................113
  Aligning print cartridges ............................................114
  Cleaning the print cartridge nozzles ............................114
  Checking ink levels .....................................................114
  Wiping the print cartridge nozzles and contacts ..........116
  Preserving the print cartridges ...................................117

Cleaning the scanner glass ..........................................117
Cleaning the exterior of the printer ..............................117
Ordering supplies .........................................................118
  Ordering print cartridges ............................................118
Troubleshooting

Using the printer troubleshooting software (Windows only)

Setup troubleshooting
- Incorrect language appears on the display
- Power button is not lit
- Software did not install
- Page does not print
- Solving printer power problems
- Removing and reinstalling the software
- Enabling the USB port in Windows

Wireless troubleshooting
- Wireless troubleshooting checklist
- Printing a network setup page
- Wireless configuration does not continue after the USB cable is attached
- Why isn't my printer in this list?
- Cannot print over wireless network
- Cannot print and there is a firewall on the computer
- Wi-Fi indicator light is not lit
- Wi-Fi indicator light is green but the printer does not print (Windows only)
- Wi-Fi indicator light is blinking orange during installation (Windows only)
- Wi-Fi indicator light is blinking orange during installation (Macintosh only)
- Wi-Fi indicator light is still orange
- Wireless print server not installed
- “Communication not available” message displays when printing wirelessly
- Communication with printer lost when connected to Virtual Private Network (VPN)
- Resetting the internal wireless print server to factory default settings

Fax troubleshooting
- Cannot send or receive a fax
- Can send but not receive faxes
- Can receive but not send faxes
- Printer receives a blank fax
- Received fax has poor print quality
- Caller ID information is not displayed
- Fax Error
- Fax Mode Unsupported
- Remote Fax Error
- Phone Line Busy
- Phone Line Error
- No Answer
- Failed to Connect

Contents
Use only the power supply and power supply cord provided with this product or the manufacturer’s authorized replacement power supply and power supply cord.

Connect the power supply cord to a properly grounded electrical outlet that is near the product and easily accessible.

**CAUTION—POTENTIAL INJURY:** Do not twist, bind, crush, or place heavy objects on the power cord. Do not subject the power cord to abrasion or stress. Do not pinch the power cord between objects such as furniture and walls. If the power cord is misused, a risk of fire or electrical shock results. Inspect the power cord regularly for signs of misuse. Remove the power cord from the electrical outlet before inspecting it.

Use only a 26 AWG or larger telecommunications (RJ-11) cord when connecting this product to the public switched telephone network.

Refer service or repairs, other than those described in the user documentation, to a professional service person.

This product is designed, tested, and approved to meet strict global safety standards with the use of specific Lexmark components. The safety features of some parts may not always be obvious. Lexmark is not responsible for the use of other replacement parts.

**CAUTION—SHOCK HAZARD:** Do not use the fax feature during a lightning storm. Do not set up this product or make any electrical or cabling connections, such as the power supply cord or telephone, during a lightning storm.

SAVE THESE INSTRUCTIONS.
## Introduction

### Finding information about the printer

<table>
<thead>
<tr>
<th>Publications</th>
<th>For</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>See the</strong></td>
<td><strong>For</strong></td>
</tr>
<tr>
<td>Quick Setup sheet</td>
<td>Initial setup instructions.</td>
</tr>
<tr>
<td>Printed <em>Networking Guide / Fax Guide</em></td>
<td>Additional setup instructions.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Your printer may not come with these publications.</td>
</tr>
<tr>
<td>Electronic <em>User's Guide</em></td>
<td>Complete instructions for using the printer. The electronic version installs automatically with the printer software.</td>
</tr>
<tr>
<td>Windows Help</td>
<td>Additional instructions for using the printer software on a Windows operating system. The Help installs automatically with the programs.</td>
</tr>
<tr>
<td></td>
<td>1 Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• In Windows Vista, click 🌐.</td>
</tr>
<tr>
<td></td>
<td>• In Windows XP and earlier, click <strong>Start</strong>.</td>
</tr>
<tr>
<td></td>
<td>2 Click <strong>All Programs</strong> or <strong>Programs</strong>, and then select the printer program folder from the list.</td>
</tr>
<tr>
<td></td>
<td>3 From the program, click <strong>Help</strong> to view the main page of the Help.</td>
</tr>
<tr>
<td></td>
<td>Click 📕 to view context-sensitive information.</td>
</tr>
<tr>
<td>Mac Help</td>
<td>Additional instructions for using the printer software on a Macintosh operating system. The Help installs automatically with the applications.</td>
</tr>
<tr>
<td></td>
<td>1 From the Finder desktop, double-click the printer folder.</td>
</tr>
<tr>
<td></td>
<td>2 Double-click the application.</td>
</tr>
<tr>
<td></td>
<td>3 From the application, click <strong>Help</strong> on the menu bar to view the main page of the Help.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you have several applications open, then make sure that the application that you want to use is the active application. The correct menu bar does not appear if the application is not active. Click the main screen to make it the active application. Click 📕 to view context-sensitive information.</td>
</tr>
</tbody>
</table>
## Customer support

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find (North America)</th>
<th>Where to find (rest of world)</th>
</tr>
</thead>
</table>
| **Telephone support** | Call us at  
- US: 1-800-332-4120  
  - Monday–Friday (8:00 AM–11:00 PM ET), Saturday (Noon–6:00 PM ET)  
- Canada: 1-800-539-6275  
  - Support in English: Monday–Friday (8:00 AM–11:00 PM ET), Saturday (Noon–6:00 PM ET)  
  - Support in French: Monday–Friday (9:00 AM–7:00 PM ET)  
- Mexico: 01-800-253-9627  
  - Monday–Friday (8:00 AM–8:00 PM ET)  
**Note:** Support numbers and times may change without notice. For the most recent telephone numbers available, see the printed warranty statement that came with your printer. | Telephone numbers and support hours vary by country or region.  
Visit our Web site at [www.lexmark.com](http://www.lexmark.com).  
Select a country or region, and then select the Customer Support link.  
**Note:** For additional information about contacting Lexmark, see the printed warranty that came with your printer. |
| **E-mail support**   | For e-mail support, visit our Web site: [www.lexmark.com](http://www.lexmark.com).  
  1. Click **SUPPORT**.  
  2. Click **Technical Support**.  
  3. Select your printer family.  
  4. Select your printer model.  
  5. From the Support Tools section, click **e-Mail Support**.  
  6. Complete the form, and then click **Submit Request**. | E-mail support varies by country or region, and may not be available in some instances.  
Visit our Web site at [www.lexmark.com](http://www.lexmark.com).  
Select a country or region, and then select the Customer Support link.  
**Note:** For additional information about contacting Lexmark, see the printed warranty that came with your printer. |
## Limited Warranty

<table>
<thead>
<tr>
<th>Description</th>
<th>Where to find (USA)</th>
<th>Where to find (rest of world)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limited Warranty Information</td>
<td>Lexmark International, Inc. furnishes a limited warranty that this printer will be free of defects in materials and workmanship for a period of 12 months after the original date of purchase.</td>
<td>Warranty information varies by country or region. See the printed warranty that came with your printer.</td>
</tr>
</tbody>
</table>
|                                                  | To view the limitations and conditions of this limited warranty, see the Statement of Limited Warranty included with this printer, or set forth at www.lexmark.com.  
1 Click SUPPORT.  
2 Click Warranty Information.  
3 Click Statement of Limited Warranty for Inkjet & All-In-One Printers.  
4 Scroll through the Web page to view the warranty.                                                                                                                                   |                                                                                                                                                                                                                                                   |

Record the following information (located on the store receipt and the back of the printer), and have it ready when you contact customer support so that they may serve you faster:

- Machine Type number
- Serial number
- Date purchased
- Store where purchased
Setting up the printer

Granting access to the software during installation

Third-party applications, including antivirus, security, and firewall programs may alert you about the printer software being installed. For your printer to work properly, you must grant access to the printer software.

Setting up the printer as a copier only or fax only

Use the following instructions if you do not want to connect the printer to a computer.

Note: If you want to connect the printer to a computer, use the setup documentation and the printer software CD that came with the printer.

1 Unpack the printer.

Note: Contents, such as the number of print cartridges, may vary by model.

| 1 | Power cord |
| 2 | Telephone cord |
| 3 | Printer software CD |
| 4 | USB cable or installation cable |
|   | Note: Your printer model may not come with a USB cable. Purchase a USB cable separately. |
| 5 | Networking Guide |
|   | Note: Your printer model may not come with this publication. |
| 6 | Fax Guide |
|   | Note: Your printer model may not come with this publication. |
| 7 | Quick Setup sheet |
| 8 | Print cartridges |
| 9 | Stick-on overlays for your language |
2 Remove tape and packing material from all areas of the printer.

3 Raise the printer control panel.

4 If a stick-on overlay for your language needs to be installed, peel off the covering from the back of the overlays to expose the adhesive.

5 Place the stick-on overlays on the recessed areas of the printer control panel, and then press down on the stick-on overlays.
6  Extend the paper exit tray.

7  Raise the paper support, and then press down on the paper adjustment lever to extend the paper guides.

8  Load paper, and then pull up the paper adjustment lever to adjust the paper guides. The paper guides should rest against the edges of the paper.
9 Connect the power cord to the printer.

![Power cord connected to printer]

**CAUTION—SHOCK HAZARD:** Read the safety information included with this product before connecting power or making any cabling connections.

10 If the printer does not automatically turn on, press ⬅️.

11 If prompted, set the language.

Press the arrow buttons until the language that you want appears, and then press OK.

12 If prompted, set the country/region.

Press the arrow buttons until the country or region that you want appears, and then press OK.
13 Set the date and time.

- Using the keypad of the printer control panel, enter the month, day, and year, and then press OK to save.
- Enter the time, and then press OK to save.
- Press the arrow buttons to choose a time format, and then press OK to save.

14 Set the fax number and fax name.

- Enter a fax number, and then press OK to save.
- Enter a fax name, and then press OK to save.

15 Open the printer, and then press down on the print cartridge carrier levers.

16 Open the color cartridge foil, and then remove the cartridge from the pack.

17 If a storage unit is included, remove the color cartridge from the storage unit.
18 Remove the tape from the color print cartridge, insert the cartridge in the right carrier, and then close the color cartridge carrier lid.

19 If a black print cartridge is included in the box contents, open the black cartridge foil, and then remove the cartridge from the pack.

Note: You may need to purchase a black print cartridge separately.
20 Remove the tape from the black print cartridge, insert the cartridge in the left cartridge carrier, and then close the black cartridge carrier lid.

21 Close the printer.

22 Press OK.

An alignment page prints.
23 Discard or recycle the alignment page.

Notes:
- The alignment page may differ from the one shown.
- Streaks on the alignment page are normal and do not indicate a problem.

Understanding the parts of the printer

<table>
<thead>
<tr>
<th>Use the</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Paper adjustment lever</td>
<td>Adjust the paper guides.</td>
</tr>
<tr>
<td>2 Paper support</td>
<td>Load paper.</td>
</tr>
<tr>
<td>3 Paper guides</td>
<td>Keep paper straight when feeding.</td>
</tr>
<tr>
<td>4 Paper feed guard</td>
<td>Prevent items from falling into the paper slot.</td>
</tr>
<tr>
<td>5 Automatic Document Feeder (ADF)</td>
<td>Scan, copy, or fax multiple-page letter-, legal-, and A4-size documents.</td>
</tr>
</tbody>
</table>

Setting up the printer

20
<table>
<thead>
<tr>
<th>Use the</th>
<th>To</th>
</tr>
</thead>
</table>
| 6 | Automatic Document Feeder (ADF) tray | Load original documents in the ADF. Recommended for scanning, copying, or faxing multiple-page documents.  
*Note:* Do not load postcards, photos, small items, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass. |
| 7 | Automatic Document Feeder (ADF) output tray | Hold documents as they exit from the ADF. |
| 8 | Automatic Document Feeder (ADF) paper guide | Keep paper straight when feeding into the ADF. |
| 9 | Printer control panel | Operate the printer. |
| 10 | Paper exit tray | Hold paper as it exits. |
| 11 | Memory card slots | Insert a memory card. |
| 12 | Quick Connect laptop port | Connect a laptop computer to the printer using a USB cable.  
*Note:* Your printer model may not have this port.  
*Warning—Potential Damage:* Do not touch the USB port except when plugging in or removing a USB cable or installation cable. |
| 13 | Card reader light | Check card reader status. The light blinks to indicate that a memory card is being accessed. |
| 14 | PictBridge port | Connect a PictBridge-enabled digital camera or a flash drive to the printer. |
| 15 | Wi-Fi indicator | Check wireless status:  
- *Off* indicates that the printer is turned off, is powering up, or is in Power Saver mode. In Power Saver mode, the power light pulses on and off.  
- *Orange*  
  – indicates that the printer has not yet been configured for a wireless network.  
  – indicates that the printer is configured for an ad hoc connection, but is not communicating with another ad hoc device.  
- *Orange blinking* indicates that the printer is configured but is unable to communicate with the wireless network.  
- *Green* indicates that the printer is connected to a wireless network.  
*Note:* Your printer model may not have wireless capability and may not have this indicator. |
<table>
<thead>
<tr>
<th>Use the</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong> Top cover</td>
<td>Access the scanner glass.</td>
</tr>
<tr>
<td><strong>2</strong> Scanner glass</td>
<td>Scan and copy photos and documents.</td>
</tr>
<tr>
<td><strong>3</strong> Scanner unit</td>
<td>• Access the print cartridges.</td>
</tr>
<tr>
<td></td>
<td>• Remove paper jams.</td>
</tr>
<tr>
<td><strong>4</strong> Print cartridge carrier</td>
<td>Install, replace, or remove a print cartridge.</td>
</tr>
</tbody>
</table>
| **5** EXT Port      | Connect additional devices, such as a data/fax modem, telephone, or answering machine, to the printer. This connection method may not be available in all countries or regions.  
**Note:** Remove the plug to access the port. |
| **6** LINE Port     | Connect the printer to an active telephone line to send and receive faxes. The printer must be connected to a telephone line to receive incoming fax calls.  
**Note:** Do not connect additional devices to the LINE port, and do not connect a DSL (digital subscriber line), ISDN (integrated services digital network), or cable modem to the printer. |
<p>| <strong>7</strong> Power supply with port | Connect the printer to a power source. |</p>
<table>
<thead>
<tr>
<th>Use the</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 Rear USB port</td>
<td>Connect the printer to a desktop computer using a USB cable.</td>
</tr>
<tr>
<td></td>
<td><strong>Warning—Potential Damage:</strong> Do not touch the USB port except when plugging in or removing a USB cable or installation cable.</td>
</tr>
<tr>
<td>9 Internal wireless print server</td>
<td>Connect the printer to a wireless network.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Your printer model may not have wireless capability and may not have this print server.</td>
</tr>
</tbody>
</table>

### Using the printer control panel buttons and menus

#### Using the printer control panel

The printer control panel contains:

- Power on/off button
- Two-line display that shows the printer status, messages, and menus
- 27 buttons

![Printer control panel diagram](image)

The following diagrams explain the sections of the printer control panel:
<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Setup</strong>&lt;br&gt;Access the setup menu and change printer settings.&lt;br&gt;&lt;strong&gt;Note:&lt;/strong&gt; The Copy, Scan, and Photo button lights are off when this button is selected.</td>
</tr>
<tr>
<td>2</td>
<td><strong>Address Book</strong>&lt;br&gt;Access fax numbers from a saved list of numbers.</td>
</tr>
<tr>
<td>3</td>
<td><strong>Redial/Pause</strong>&lt;br&gt;In Fax mode:&lt;br&gt;• Insert a three-second pause in the number to be dialed to wait for an outside line or get through an automated answering system. Enter a pause only when you have already begun entering the number.&lt;br&gt;• Display the last number dialed. Press the arrow buttons to view the last five numbers dialed.</td>
</tr>
<tr>
<td>4</td>
<td><strong>Dialtone</strong>&lt;br&gt;Dial the telephone number manually using the keypad before sending the fax.</td>
</tr>
<tr>
<td>5</td>
<td><strong>Keypad</strong>&lt;br&gt;In Copy mode or Photo mode: Enter the number of copies or prints you want to make.&lt;br&gt;In Fax mode:&lt;br&gt;• Enter fax numbers.&lt;br&gt;• Navigate an automated answering system.&lt;br&gt;• Select letters when creating a Speed Dial list.&lt;br&gt;• Type numbers to enter or edit the date and time shown on the display.</td>
</tr>
<tr>
<td>6</td>
<td><strong>Display</strong>&lt;br&gt;View:&lt;br&gt;• Printer status&lt;br&gt;• Messages&lt;br&gt;• Menus&lt;br&gt;&lt;strong&gt;Notes:&lt;/strong&gt;&lt;br&gt;• The display times out after two minutes of inactivity. Press any button to restore the display.&lt;br&gt;• The display is turned off in Power Saver mode.</td>
</tr>
<tr>
<td>7</td>
<td>Access the photo menu and print photos.</td>
</tr>
<tr>
<td>8</td>
<td>Access the fax menu and send faxes.</td>
</tr>
<tr>
<td>9</td>
<td>Access the scan menu and scan documents.</td>
</tr>
</tbody>
</table>

Setting up the printer
<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Access the copy menu and make copies.</td>
</tr>
</tbody>
</table>
| 11    | • Turn the printer on and off.  
      | • Switch to Power Saver mode.  
      | **Note:** Press \( \) to switch to Power Saver mode. Press and hold \( \) for two seconds to turn off the printer. |

### Table 1: Presses and Their Functions

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
</table>
| 1     | • Decrease a number.  
      | • Delete a letter or number.  
      | • Move the cursor one place to the left.  
      | • Scroll through menus, submenus, or settings on the display. |
| 2     | • Select a menu item that appears on the display.  
      | • Save settings.  
      | • Move one level deeper in a submenu.  
      | • Feed or eject paper. Press and hold \( \) for 3 seconds to feed or eject paper from the printer. |
| 3     | • Increase a number.  
      | • Move the cursor one place to the right.  
      | • Scroll through menus or settings on the display. |
| 4     | • Return to the previous screen.  
      | • Exit from one menu level to a higher one. |

**Setting up the printer**

25
Using the printer menus

A number of menus are available to make it easy for you to change printer settings:

<table>
<thead>
<tr>
<th>Press</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>✗</td>
</tr>
<tr>
<td>6</td>
<td>Color / Black</td>
</tr>
<tr>
<td>7</td>
<td>☓</td>
</tr>
</tbody>
</table>

- **Press 5 (✗):**
  - Cancel a print, copy, scan, or fax job in progress.
  - Exit from a menu level of the Copy, Scan, Fax, Photo, or File Print menu to the top level of a menu.
  - Exit from a menu level of the Setup menu to the top level of the previous mode.
  - Clear current settings or error messages, and return to default settings.

- **Press 6 (Color / Black):** Switch to color mode or black-and-white mode.

- **Press 7 (ץ):** Start a print, scan, or copy job, depending on which mode is selected.
Menus List

Setup menu
- Maintenance
  - Ink Levels
  - Clean Cartridges
  - Align Cartridges
  - Print Test Page
- Device Setup
  - Language
  - Country
  - Date/Time
  - Host Fax Settings
  - Button Beep
  - Power Saver
  - Clear Settings Timeout
- Fax Setup
  - Address Book
  - Reports
  - Ringing and Answering
  - Fax Printing
  - Dialing and Sending
  - Fax Blocking
- Network Setup (appears only if the printer has an internal wireless print server)
  - Print Setup Page
  - Wi-Fi Protected Setup
  - Wireless Information
  - TCP/IP
  - Network Time
  - File Print
  - Reset Network Adapter Defaults
- Defaults
  - Paper Size
  - Paper Type
  - Photo Print Size
  - Set Defaults

Photo menu

Note: The Photo menu is enabled only when you insert a memory device into the printer.

- Easy Photo
  - Print
  - Paper Size
  - Photo Size
- Print Photos
  - Print
  - Lighter/Darker
  - Photo Effects
  - Paper Size
  - Photo Size
  - Paper Type
  - Layout
  - Quality
- Proof Sheet
  - Print Last 20
  - Print All
  - Print Date Range
  - Scan Sheet
- Save Photos
  - Computer (appears only if the printer is connected directly to a computer)
  - Network (appears only if the printer is connected to a network)
  - USB Flash Drive
  - Memory Card
- Select Computer (appears only if the printer is connected to a network)
Note: The File Print menu is enabled when you insert a flash drive that contains document files into the printer. The menu is composed of the folders and files stored on the flash drive.

**Saving settings**

You can set the default paper size, paper type, and photo print size for the documents and photos that you print.

**Note:** These default settings apply only to print, copy, and scan jobs that you initiate from the printer.

1. From the printer control panel, press 
2. Press the arrow buttons until **Defaults** appears, and then press **OK**.
   Paper Size appears on the display.
3. Press **OK** again.
4. Press the arrow buttons to select the default paper size for the printer, and then press **OK**.
5. Press the arrow buttons until **Paper Type** appears, and then press **OK**.
6. Press the arrow buttons to select the default paper type for the printer, and then press **OK**.
7. Press the arrow buttons until **Photo Print Size** appears, and then press **OK**.
8. Press the arrow buttons to select the default photo print size for the printer, and then press **OK**.
9. Press ** until you exit Setup, or press another mode button.

**Changing temporary settings into new default settings**

The printer has default temporary settings for the menus. The printer reverts to these default temporary settings after two minutes of inactivity or after the printer is turned off:
### Temporary settings

| Copy menu | • Copies  
|           | • Resize  
|           | • Lighter/Darker  
|           | • Quality  
|           | • Copies per Sheet  
|           | • Pages per Sheet  
|           | • Original Size  
|           | • Content Type |
| Scan menu | • Quality  
|           | • Original Size |
| Fax menu  | • Lighter / Darker  
|           | • Quality |
| Photo menu | The following Photo options will not time out after two minutes of inactivity or after turning off the power but will return to the default factory settings when a memory card or flash drive is removed.  
|           | • Photo Effects  
|           | • Photo Size  
|           | • Layout  
|           | • Quality |

### To change the temporary settings into new default settings

1. From the printer control panel, press ↵.
2. Press the arrow buttons until **Defaults** appears, and then press OK.
3. Press the arrow buttons until **Set Defaults** appears, and then press OK.
   - **Use Current** appears on the display.
4. Press OK again.
5. Press ℹ️ until you exit Setup, or press another mode button.

### To disable the settings timeout feature

You can disable the settings timeout feature if you do not want the printer to revert to the default temporary settings after two minutes of inactivity or after turning off the printer.

1. From the printer control panel, press ↵.
2. Press the arrow buttons until **Device Setup** appears, and then press OK.
3. Press the arrow buttons until **Clear Settings Timeout** appears, and then press OK.
4. Press the arrow buttons until **Never** appears, and then press OK.
5. Press ℹ️ until you exit Setup, or press another mode button.
Changing the Power Saver timeout

You can customize the Power Saver timeout of the printer. The Power Saver timeout is the time it takes for the printer to switch to Power Saver mode when the printer is left idle. Change the Power Saver timeout to avoid interruptions when doing multiple jobs on your printer.

1. From the printer control panel, press ↗.
2. Press the arrow buttons until Device Setup appears, and then press OK.
3. Press the arrow buttons until Power Saver appears, and then press OK.
4. Press the arrow buttons to select a Power Saver timeout, and then press OK.
   - **Note:** If you want to be efficient on power usage, then select the minimum Power Saver timeout from the options. If you do not want to turn the printer back on from Power Saver mode as often, then select the maximum Power Saver timeout.
5. Press ↘ until you exit Setup, or press another mode button.

Using the printer software

Installing printer software

Using Windows

1. Close all open software programs.
2. Insert the installation software CD.
   - If the Welcome screen does not appear after a minute, do one of the following:
     - **In Windows Vista**
       - a Click 🔄.
       - b In the Start Search box, type D:\setup.exe, where D is the letter of your CD or DVD drive.
     - **In Windows XP and earlier**
       - a Click Start.
       - b Click Run.
       - c Type D:\setup.exe, where D is the letter of your CD or DVD drive.
3. Follow the instructions on the Welcome screen to set up the printer.

Using Macintosh

1. Close all open software applications.
2. Insert the installation software CD.
   - If the Welcome screen does not appear after a minute, click the CD icon on the desktop.
3. Double-click Install.
4. Follow the instructions on the Welcome screen to set up the printer.
Using the World Wide Web

1 Go to the Lexmark Web site at www.lexmark.com.
2 From the home page, navigate through the menu selection, and then click Drivers & Downloads.
3 Choose the printer and the printer driver for your operating system.
4 Follow the instructions on the screens to download the driver and install the printer software.

Installing the optional XPS driver (Windows Vista users only)

The XML Paper Specification (XPS) driver is an optional printer driver designed to make use of the advanced XPS color and graphics features that are available only for Windows Vista users. To use XPS features, you must install the XPS driver as an additional driver after you install the regular printer software.

Notes:

- The XPS driver is supported only in Windows Vista Service Pack 1 or later.
- Before installing the XPS driver, you must install the printer on your computer.
- To install the XPS driver, you must have administrator privileges on the computer.

To extract the driver:

1 Insert the installation software CD, and then click Cancel when the Setup Wizard appears.
2 Click Computer.
3 Double-click the CD or DVD drive icon, and then double-click Drivers.
4 Double-click the xps folder, and then double-click the setupxps file.
   The XPS driver files are extracted and copied to your computer, and any required Microsoft XPS files are launched. Follow the instructions on the computer screen.

To install the XPS driver:

1 Click Control Panel.
2 Under Hardware and Sound, click Printer, and then click Add a Printer.
3 From the Add Printer dialog, click Add a local printer.
4 From the “Use an existing port” drop-down menu, select Virtual printer port for USB, and then click Next.
5 Click Have disk.
   The Install From Disk dialog appears.
6 Click Browse, and then navigate to the XPS driver files on your computer:
   a Click Computer, and then double-click (C:).
   b Double-click the folder that has your printer model number, and then double-click Drivers.
   c Double-click the xps folder, and then double-click the xps file.
   d Click OK.
7 Click Next on the two additional dialogs that appear.
   For more information on the XPS driver, see the XPS readme file on the installation software CD. The file is located in the xps folder with the setupxps batch file (<CD drive>:\Drivers\xps\readme).

Setting up the printer


**Using the Windows printer software**

When you set up the printer using the printer software CD, all the necessary software was installed. You may have chosen to install some additional programs. The following table provides an overview of various software programs and what they can help you do.

**Note:** Your printer may not come with some of these programs or some of the functions of these programs, depending on the features of the printer that you purchased.

<table>
<thead>
<tr>
<th>Use the</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lexmark™ Productivity Studio</td>
<td>• Scan, copy, fax, e-mail, or print a photo or document.</td>
</tr>
<tr>
<td></td>
<td>• Manage and edit photos.</td>
</tr>
<tr>
<td></td>
<td>• Transfer photos.</td>
</tr>
<tr>
<td></td>
<td>• Scan documents to PDF format.</td>
</tr>
<tr>
<td></td>
<td>• Create posters and photo greeting cards from your own photos.</td>
</tr>
<tr>
<td></td>
<td>• Adjust settings for the printer.</td>
</tr>
<tr>
<td>Lexmark Fast Pics</td>
<td>Manage, edit, transfer, and print photos and documents.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This program is installed automatically with the printer software if you choose not to install the Lexmark Productivity Studio.</td>
</tr>
<tr>
<td>Lexmark Toolbar</td>
<td>• Print black or text-only Web pages to save ink.</td>
</tr>
<tr>
<td></td>
<td>• Schedule automatic printing of Web pages.</td>
</tr>
<tr>
<td></td>
<td>• Access Picnik and edit photos online.</td>
</tr>
<tr>
<td></td>
<td>• Print, scan, or convert local files from Windows.</td>
</tr>
<tr>
<td>Lexmark Fax Solutions</td>
<td>• Send a fax.</td>
</tr>
<tr>
<td></td>
<td>• Receive a fax in three-in-one printers.</td>
</tr>
<tr>
<td></td>
<td>• Add, edit, or delete contacts in the built-in phone book.</td>
</tr>
<tr>
<td></td>
<td>• Access the Lexmark Fax Setup Utility in four-in-one printers.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This program is installed automatically with the printer software if you choose not to install the Lexmark Productivity Studio.</td>
</tr>
<tr>
<td></td>
<td>Use the Lexmark Fax Setup Utility to set the Speed Dial and Group Dial numbers, set Ringing and Answering, and print fax history and status reports.</td>
</tr>
<tr>
<td>Abbyy Sprint OCR</td>
<td>Scan a document and produce text that you can edit with a word-processing program.</td>
</tr>
<tr>
<td>Lexmark Wireless Setup Utility</td>
<td>• Set up the wireless printer on a wireless network.</td>
</tr>
<tr>
<td></td>
<td>• Change the wireless settings of the printer.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This program is installed automatically with the printer software if the printer has wireless capability.</td>
</tr>
</tbody>
</table>

**Setting up the printer**

32
<table>
<thead>
<tr>
<th>Use the</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lexmark Service Center</td>
<td>• Troubleshoot the printer.</td>
</tr>
<tr>
<td></td>
<td>• Access the printer maintenance functions.</td>
</tr>
<tr>
<td></td>
<td>• Contact customer support.</td>
</tr>
<tr>
<td><strong>Notes:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• This program is installed automatically with the printer software.</td>
</tr>
<tr>
<td></td>
<td>• You may be prompted to install this program from the Web, depending on your printer model.</td>
</tr>
<tr>
<td>Printing Preferences</td>
<td>When you select <strong>File ➞ Print</strong> with a document open and then click <strong>Properties</strong>, a Printing Preferences dialog appears. The dialog lets you select options for the print job such as the following:</td>
</tr>
<tr>
<td></td>
<td>• Select the number of copies to be printed.</td>
</tr>
<tr>
<td></td>
<td>• Print two-sided copies.</td>
</tr>
<tr>
<td></td>
<td>• Select the paper type.</td>
</tr>
<tr>
<td></td>
<td>• Add a watermark.</td>
</tr>
<tr>
<td></td>
<td>• Enhance images.</td>
</tr>
<tr>
<td></td>
<td>• Save settings.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>Printing Preferences is installed automatically with the printer software.</td>
</tr>
</tbody>
</table>

If you have not installed these additional programs during initial installation, reinsert the installation software CD, run the installation software, and then select **Install Additional Software** from the Software Already Installed screen.

**Using the Macintosh printer software**

<table>
<thead>
<tr>
<th>Use the</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print dialog</td>
<td>Adjust the print settings and schedule print jobs.</td>
</tr>
<tr>
<td>Printer Services dialog</td>
<td>• Access the printer utility.</td>
</tr>
<tr>
<td></td>
<td>• Troubleshoot.</td>
</tr>
<tr>
<td></td>
<td>• Order ink or supplies.</td>
</tr>
<tr>
<td></td>
<td>• Contact Lexmark.</td>
</tr>
<tr>
<td></td>
<td>• Contact us.</td>
</tr>
<tr>
<td></td>
<td>• Check the printer software version installed on the computer.</td>
</tr>
</tbody>
</table>

Applications are also installed with the printer software during installation. These applications are saved in the printer folder that appears on the Finder desktop after installation.

1. From the Finder desktop, double-click the printer folder.
2. Double-click the icon of the application that you want to use.

<table>
<thead>
<tr>
<th>Use the</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lexmark All-In-One Center</td>
<td>• Scan photos and documents.</td>
</tr>
<tr>
<td></td>
<td>• Customize settings for scan jobs.</td>
</tr>
</tbody>
</table>

**Setting up the printer**
<table>
<thead>
<tr>
<th>Use the</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lexmark Fax Setup Utility</td>
<td>• Customize settings for fax jobs.</td>
</tr>
<tr>
<td></td>
<td>• Create and edit the Speed Dial list.</td>
</tr>
<tr>
<td>Lexmark Network Card Reader</td>
<td>• View the contents of a memory device inserted into a network printer.</td>
</tr>
<tr>
<td></td>
<td>• Transfer photos and documents from a memory device to the computer over a network.</td>
</tr>
<tr>
<td>Lexmark Printer Utility</td>
<td>• Get help with cartridge installation.</td>
</tr>
<tr>
<td></td>
<td>• Print a test page.</td>
</tr>
<tr>
<td></td>
<td>• Print an alignment page.</td>
</tr>
<tr>
<td></td>
<td>• Clean the print cartridge nozzles.</td>
</tr>
<tr>
<td></td>
<td>• Order ink or supplies.</td>
</tr>
<tr>
<td></td>
<td>• Register the printer.</td>
</tr>
<tr>
<td></td>
<td>• Contact customer support.</td>
</tr>
<tr>
<td>Lexmark Wireless Setup Assistant</td>
<td>Set up the printer on a wireless network.</td>
</tr>
</tbody>
</table>

*Note:* Your printer may not come with these applications, depending on the features of the printer that you purchased.

**Switching between the rear USB port and the Quick Connect laptop port (selected models only)**

If the printer is connected to a desktop computer through the rear USB port and you decide to connect a laptop computer to the printer through the Quick Connect laptop port, then the Quick Connect laptop port connection overrides the rear USB port connection. The active print jobs on the desktop computer may be canceled. Pause or cancel active jobs on the desktop computer before switching between ports.

**Switching from a desktop computer to a laptop computer**

1. Pause or cancel active jobs on the desktop computer.
2. Connect a USB cable to the laptop computer and then to the Quick Connect laptop port on the front of the printer.
   
   **Warning—Potential Damage:** Do not plug in or remove the USB cable from the Quick Connect laptop port while a memory device is being accessed by the printer.
3. If you have not yet installed the printer software on the laptop, then install it.

**Using Windows**

a. Insert the installation software CD.

   
   If the Welcome screen does not appear after a minute, do one of the following:

   **In Windows Vista**
   
   1. Click 📜.
   2. In the Start Search box, type `D:\setup.exe`, where D is the letter of your CD or DVD drive.
In Windows XP and earlier
1 Click Start.
2 Click Run.
3 Type D:\setup.exe, where D is the letter of your CD or DVD drive.
c Follow the instructions on the computer screen.

Using Macintosh
a Insert the installation software CD.
b Wait for the Welcome screen to appear.
   Note: If the Welcome screen does not appear after a minute, then click the CD icon on the desktop.
c Double-click Install.
d Follow the instructions on the computer screen.

Getting the printer ready to fax

⚠️ CAUTION—SHOCK HAZARD: Do not use the fax feature during a lightning storm. Do not set up this product or make any electrical or cabling connections, such as the power supply cord or telephone, during a lightning storm.

Using an RJ11 adapter

Country/region
• United Kingdom
• Ireland
• Finland
• Norway
• Denmark
• Italy
• Sweden
• Netherlands
• France
• Portugal

To connect your printer to an answering machine or other telecommunications equipment, use the telephone line adapter included in the box with the printer.

1 Connect one end of the telephone cord into the Line port [1] of the printer.
2 Connect the adapter to the telephone line that came with the printer.

![Diagram of adapter connected to telephone line]

**Note:** The UK adapter is shown. Your adapter may look different, but it will fit the telephone outlet used in your location.

3 Connect the telephone line of your chosen telecommunications equipment to the left outlet of the adapter.

![Diagram of telephone connected to adapter]

If your telecommunications equipment uses a US-style (RJ11) telephone line, follow these steps to connect the equipment:

1 Remove the plug from the EXT port on the back of the printer.

![Diagram of plug being removed from EXT port]

**Note:** Once this plug is removed, any country- or region-specific equipment you connect to the printer by the adapter, as shown, will not function properly.
2 Connect your telecommunications equipment directly to the EXT port on the back of the printer.

![Image](image1.png)

**Warning—Potential Damage:** Do not touch cables or the printer in the area shown while actively sending or receiving a fax.

**Country/region**

- Saudi Arabia
- United Arab Emirates
- Egypt
- Bulgaria
- Czech Republic
- Belgium
- Australia
- South Africa
- Greece
- Israel
- Hungary
- Poland
- Romania
- Russia
- Slovenia
- Spain
- Turkey

To connect an answering machine or other telecommunications equipment to the printer:

1 Remove the plug from the back of the printer.

![Image](image2.png)

**Note:** Once this plug is removed, any country- or region-specific equipment that you connect to the printer by the adapter, as shown, will not function properly.
2 Connect your telecommunications equipment directly to the EXT port on the back of the printer.

Warning—Potential Damage: Do not touch cables or the printer in the area shown while actively sending or receiving a fax.

Country/region
- Germany
- Austria
- Switzerland

There is a plug installed in the EXT port of the printer. This plug is necessary for the proper functioning of the printer.

Note: Do not remove the plug. If you remove it, other telecommunications devices in your home (such as telephones or answering machines) may not work.

Choosing a fax connection

You can connect the printer with equipment such as a telephone, an answering machine, or a computer modem. If problems occur, see “Setup troubleshooting” on page 121.

Note: The printer is an analog device that works best when directly connected to the wall jack. Other devices (such as a telephone or answering machine) can be successfully attached to pass through the printer, as described in the setup steps. If you want a digital connection such as ISDN, DSL, or ADSL, a third-party device (such as a DSL filter) is required.

You do not need to attach the printer to a computer, but you do need to connect it to a telephone line to send and receive faxes.
You can connect the printer to other equipment. See the following table to determine the best way to set up the printer.

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Benefits</th>
<th>See this section</th>
</tr>
</thead>
<tbody>
<tr>
<td>• The printer</td>
<td>Send and receive faxes without using a computer.</td>
<td>“Connecting directly to a telephone wall jack” on page 40</td>
</tr>
<tr>
<td>• A telephone cord</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• The printer</td>
<td>• Use the fax line as a normal telephone line.</td>
<td>“Connecting to a telephone” on page 43</td>
</tr>
<tr>
<td>• A telephone</td>
<td>• Send and receive faxes without using a computer.</td>
<td></td>
</tr>
<tr>
<td>• Two telephone cords</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• The printer</td>
<td>Receive both incoming voice messages and faxes.</td>
<td>“Connecting to an answering machine” on page 39</td>
</tr>
<tr>
<td>• A telephone</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• An answering machine</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Three telephone cords</td>
<td>Send faxes using the computer or the printer.</td>
<td>“Connecting to a computer with a modem” on page 42</td>
</tr>
<tr>
<td>• The printer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• A telephone</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• A computer modem</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Three telephone cords</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Connecting to an answering machine**

Connect an answering machine to the printer to receive both incoming voice messages and faxes.

**Note:** Setup steps may vary depending on your country or region. For more information on connecting the printer to telecommunications equipment, see the related topic, “Using an RJ11 adapter.”

1. Make sure you have the following:
   - A telephone
   - An answering machine
   - Three telephone cords
   - A telephone wall jack

2. Connect one telephone cord into the LINE port of the printer, and then plug it into an active telephone wall jack.
3 Remove the protective plug from the EXT port of the printer.

4 Connect a second telephone cord from the telephone to the answering machine.

5 Connect a third telephone cord from the answering machine to the EXT port of the printer.

**Connecting directly to a telephone wall jack**

Connect the printer directly to a telephone wall jack to send and receive faxes without using a computer.

1 Make sure you have a telephone cord and a telephone wall jack.

2 Connect one end of the telephone cord into the LINE port of the printer.
3 Connect the other end of the telephone cord into an active telephone wall jack.

**Connecting directly to a telephone wall jack in Germany**

Connect the printer directly to a telephone wall jack to send and receive faxes without using a computer.

1 Make sure you have a telephone cord (provided with the product) and a telephone wall jack.

2 Connect one end of the telephone cord into the LINE port of the printer.

3 Connect the other end of the telephone cord into the N slot of an active telephone wall jack.

4 If you would like to use the same line for both fax and telephone communication, connect a second telephone line (not provided) between the telephone and the F slot of an active telephone wall jack.
5 If you would like to use the same line for recording messages on your answering machine, connect a second telephone line (not provided) between the answering machine and the other N slot of the telephone wall jack.

Connecting to a computer with a modem

Connect the printer to a computer with a modem to send faxes from the software application.

**Note:** Setup steps may vary depending on your country or region. For more information on connecting the printer to telecommunications equipment, see the related topic, “Using an RJ11 adapter.”

1 Make sure you have the following:
   - A telephone
   - A computer with a modem
   - Two telephone cords
   - A telephone wall jack

2 Connect a telephone cord into the LINE port of the printer, and then plug it into an active telephone wall jack.
3 Remove the protective plug from the EXT port of the printer.

4 Connect a second telephone cord from the computer modem to the EXT port of the printer.

**Connecting to a telephone**

Connect a telephone to the printer to use the fax line as a normal telephone line. Then set up the printer wherever your telephone is located to make copies or to send and receive faxes without using a computer.

**Note:** Setup steps may vary depending on your country or region. For more information on connecting the printer to telecommunications equipment, see the related topic, “Using an RJ11 adapter.”

1 Make sure you have the following:
   - A telephone
   - Two telephone cords
   - A telephone wall jack

2 Connect one telephone cord to the LINE port of the printer, and then plug it into an active telephone wall jack.
3 Remove the protective plug from the EXT port of the printer.

4 Connect the other telephone cord to a telephone, and then plug it into the EXT port of the printer.

Using a digital phone service

The fax modem is an analog device. Certain devices can be connected to the printer so that digital telephone services can be used.

- If you are using an ISDN telephone service, connect the printer to an analog telephone port (an R-interface port) on an ISDN terminal adapter. For more information and to request an R-interface port, contact your ISDN provider.
- If you are using DSL, connect to a DSL filter or router that will support analog use. For more information, contact your DSL provider.
- If you are using a PBX telephone service, make sure you are connecting to an analog connection on the PBX. If none exists, consider installing an analog telephone line for the fax machine. For more information on faxing when using a PBX telephone service, see the related topic, “Setting up to fax while behind a PBX.”
Installing the printer on a wireless network (selected models only)

Wireless network compatibility

Your printer contains an IEEE 802.11g wireless print server. Your printer is compatible with IEEE 802.11 b/g/n routers that are Wi-Fi certified. If you are having issues with an n router, verify with your router manufacturer that the current mode setting is compatible with g devices, as this setting varies depending on the router brand/model.

Information you will need to set up the printer on a wireless network

To set up the printer for wireless printing, you need to know:

- The name of your wireless network. This is also known as the Service Set Identifier (SSID).
- If encryption was used to secure your network.
- The security key (either a WEP key or WPA passphrase) that allows other devices to communicate on the network if encryption was used to secure your network.

You can locate your network WEP key or WPA passphrase by accessing your wireless access point or router and checking the security information.

If your wireless access point (wireless router) is using Wired Equivalent Privacy (WEP) security, the WEP key should be:

- Exactly 10 or 26 hexadecimal characters. Hexadecimal characters are A–F, a–f, and 0–9.
  or
- Exactly 5 or 13 ASCII characters. ASCII characters are letters, numbers, punctuation, and symbols found on a keyboard.

If your wireless access point is using Wi-Fi Protected Access (WPA) security, the WPA passphrase should be:

- From 8 to 63 ASCII characters. ASCII characters in a WPA passphrase are case-sensitive.
  or
- Exactly 64 hexadecimal characters. Hexadecimal characters are A-F, a-f, and 0-9.

If your wireless network is not using security, then you will not have a security key.

Note: If you do not know the SSID of the network that your computer is connected to, launch the wireless utility of the computer network adapter and look for the network name. If you cannot find the SSID or the security information for your network, see the documentation that came with the wireless access point, or contact your system support person.

Installing the printer on a wireless network

Before you install the printer on a wireless network, make sure that:

- Your wireless network is set up and working properly.
- The computer you are using is connected to the same wireless network where you want to set up the printer.
Using Windows

1 Insert the installation software CD.
   If the Welcome screen does not appear after a minute, do one of the following:

   **In Windows Vista**
   - Click 🌋.
   - In the Start Search box, type D:\setup.exe, where D is the letter of your CD or DVD drive.

   **In Windows XP and earlier**
   - Click Start.
   - Click Run.
   - Type D:\setup.exe, where D is the letter of your CD or DVD drive.

2 Follow the instructions on the Welcome screen to set up the printer.

Using Macintosh

1 Insert the installation software CD.
   If the Welcome screen does not appear after a minute, click the CD icon on the desktop.

2 Double-click Install.

3 Follow the instructions on the Welcome screen to set up the printer.

Installing the printer on other computers

Once the printer is set up on the wireless network, it can be accessed wirelessly by any other computer on the network. However, you will need to install the printer driver on every computer that will access it. You do not need to configure the printer again, although you will need to run the setup software on each computer to install the driver.

Using Windows

1 Insert the installation software CD.

2 Wait for the Welcome screen to appear.
   If the Welcome screen does not appear after a minute, do one of the following:

   **In Windows Vista**
   - Click 🌋.
   - In the Start Search box, type D:\setup.exe, where D is the letter of your CD or DVD drive.

   **In Windows XP and earlier**
   - Click Start.
   - Click Run.
   - Type D:\setup.exe, where D is the letter of your CD or DVD drive.
3 Follow the on-screen instructions for installing a configured printer on a new computer.

Using Macintosh

1 Insert the installation software CD.
2 Wait for the Welcome screen to appear.
   
   **Note:** If the Welcome screen does not appear after a minute, click the CD icon on the desktop.
3 Double-click *Install*.
4 Follow the on-screen instructions for installing a configured printer on a new computer.

Interpreting the colors of the Wi-Fi indicator light

The colors of the Wi-Fi indicator light show the network status of the printer.

- **Off** means one of the following:
  - The printer is turned off or is powering up.
  - The printer is not connected to a wireless network and is in Power Saver mode. In Power Saver mode, the power light pulses on and off.
- **Orange** means one of the following:
  - The printer has not yet been configured for a wireless network.
  - The printer is configured for an ad hoc connection, but it is not currently communicating with another ad hoc device.
- **Blinking orange** means one of the following:
  - The printer is out of the range of the wireless access point (wireless router).
  - The printer is trying to communicate with the wireless access point, but the wireless access point is turned off or not working properly.
  - Either the configured printer or the wireless access point has been turned off and back on, and the printer is trying to establish communications with the network.
  - The wireless settings of the printer may no longer be valid.
- **Green** means that the printer is connected to a wireless network and is ready for use.
- **Blinking green** means that the printer internal print server is being updated.

Special wireless installation instructions

The following instructions apply to customers using a LiveBox, AliceBox, N9UF Box, FreeBox, or Club Internet.

**Before you begin**

- Make sure your box is wireless-enabled and activated to work on a wireless network. For more information about configuring the box to work wirelessly, see the documentation that came with your box.
- Make sure your box is turned on and that your computer is on and connected to your wireless network.
Adding the printer to your wireless network

1 Set up your printer using the setup instructions provided.

2 If there is an associate/registration button on the back of your box, press it when you are prompted to select a network.
   
   **Note:** After pressing the associate/register button, you have five minutes to complete the printer installation.

3 Return to the computer screen, and select the network you want to connect to. If you want to use the network shown, select **Connect to <network name>**, and then click **Continue**.

   If you do not want to use the network shown:
   
   a Select **Connect to another network**, and then click **Continue**.
   b Select the network you want to use from the list of available networks, and then click **Continue**.

4 Type the Network key, and then click **Continue**.
   
   **Note:** Your WEP, WPA, or WPA2 key may be obtained from the bottom of the box, the user’s guide that came with the box, or from the box Web page. If you have already changed the key for your wireless network, use the key you created.

5 Follow the instructions on your screen to complete installation.

Assigning a static IP address

The printer will be assigned an IP address automatically through DHCP on most wireless networks.

If the printer is not automatically assigned an IP address, the installation software will prompt you to manually assign an IP address to the printer. This will occur if there is no server or router capable of automatically assigning DHCP addresses on your network.

For more information, contact your system support person.

Changing wireless settings after installation

To change wireless settings on the printer, such as the configured network, the security key, or other settings:

Using Windows

1 Do one of the following:
   - In Windows Vista, click 🌐.
   - In Windows XP and earlier, click **Start**.

2 Click **All Programs** or **Programs**, and then select the printer program folder from the list.

3 Click **Tools → Lexmark Wireless Setup Utility**.
   
   **Note:** If the cable is not already connected, you may be prompted to connect the printer to the computer again using the installation cable as part of the setup process.

4 Follow the prompts on the computer screen to reinstall the software, and then make the changes that you want.
Using Macintosh

1. From the Finder desktop, double-click the printer folder.
3. Follow the instructions on the computer screen.

Switching between USB and wireless connections (Windows only)

You can change the way you access your printer depending on your needs. The procedures below assume that you have configured your printer for one type of connection. See related topics on troubleshooting specific connection types if you encounter difficulties during configuration.

Using the printer wirelessly

Select the connection type that describes how you currently access your printer:

If the printer is currently set up locally (using USB connection)

1. Do one of the following:
   - In Windows Vista, click 📲.
   - In Windows XP and earlier, click Start.
2. Click All Programs or Programs, and then select the printer program folder from the list.
4. Follow the instructions on the Welcome screen.

Note: There is no need to remove the USB cable connecting the printer to the computer during wireless configuration.

Using the printer locally (USB)

Select the connection type that describes how you currently access your printer:

If the printer is currently set up for wireless

1. Do one of the following:
   - In Windows Vista, click 📲.
   - In Windows XP and earlier, click Start.
2. Click All Programs or Programs, and then select the printer program folder from the list.
4. Follow the on-screen instructions, attaching the USB cable when prompted to do so.
5. When prompted to choose a wireless network, select Choose Another Network.
6. Select Don't use wireless.
7. Follow the on-screen instructions to complete the setup.
Switching between USB and wireless connections (Macintosh only)

You can change the way you access your printer depending on your needs. The procedures below assume that you have configured your printer for one type of connection. See related topics on troubleshooting specific connection types if you encounter difficulties during configuration.

Using the printer wirelessly

If the printer is currently set up locally (using USB connection)

1. From the Finder desktop, double-click the printer folder.
2. Double-click **Lexmark Wireless Setup Assistant**.
3. Follow the on-screen instructions for configuring the printer wirelessly.

*Note:* There is no need to remove the USB cable connecting the printer to the computer during wireless configuration.

Using the printer locally (USB)

If the printer is currently set up for wireless

1. Attach one end of a USB cable to the USB port on the back of the printer. Attach the other end to a USB port on the computer.
2. Add the printer:

   **In Mac OS X version 10.5**
   a. From the menu bar, click **System Preferences**.
   b. Click **Print & Fax** under the Hardware section.
   c. Click **+**.
   d. Select the printer from the list and click **Add**.

   **In Mac OS X version 10.4 or earlier**
   a. From the Finder desktop, choose **Go ➔ Applications ➔ Utilities ➔ Print Center** or **Print Center** or **Printer Setup Utility**, depending on the operating system version you are using.
      The Printer List dialog appears.
   b. Choose the printer you want to use.
   c. Click **Add**.
      The Printer Browser appears.
   d. Select your printer.
   e. Click **Add**.
3. A second print queue will be created. Remove the wireless queue if you do not want to switch back to accessing the printer over a wireless connection.

Installing the printer on a wireless network (selected models only)
Advanced wireless setup

Creating an ad hoc wireless network

The recommended way to set up your wireless network is to use a wireless access point (wireless router). A network set up this way is called an infrastructure network. If you have an infrastructure network, you should configure the printer for use on that network.

Note: The printer can communicate on only one wireless network at a time. Configuring the printer for an ad hoc wireless network will keep it from working on any other wireless network, either ad hoc or infrastructure.

You can set up an ad hoc network if you:
- Do not have an access point or wireless router
- Do not already have a wireless network (but do have a wireless adapter for your computer)
- Want to set up a standalone network between the printer and a computer with a wireless network adapter

In Windows Vista

1 Click 📔.
2 Click Control Panel.
3 Click Network and Internet.
4 Under Network and Sharing Center, click Connect to a Network.
5 In the Connect to a Network dialog, click Set up a wireless ad-hoc (computer-to-computer) network, and then click Next.
6 Follow the instructions in the “Set up a wireless ad hoc network” wizard. As part of the setup:
   a Create a network name or SSID for the network between the computer and your printer.
   b Write down the name of your network. Be sure to use the exact spelling and capitalization.
   c Go to the Security Type list, select WEP, and then create a WEP key.
      WEP keys must be:
      • Exactly 10 or 26 hexadecimal characters. Hexadecimal characters are A-F, a–f, and 0–9.
      or
      • Exactly 5 or 13 ASCII characters. ASCII characters are letters, numbers, and symbols found on a keyboard
   d Write down the password for your network. Be sure to use the exact spelling and capitalization.

Windows Vista will enable the ad hoc network for you. It will appear in the “Connect to a network” dialog under “Available networks,” indicating that the computer is configured for the ad hoc network.

7 Close the Windows Control Panel and any remaining windows.
8 Insert the installation software CD, and follow the directions for wireless installation.
   Note: Do not connect the installation or network cables until instructed to do so by the setup software.
9 When the available networks are displayed, provide the network name and the security information you created in step 6. The installer will configure the printer for use with your computer.
10 Store a copy of your network name and security information in a safe place for future reference.

Installing the printer on a wireless network (selected models only)
In Windows XP

1. Click **Start**.
2. Click **Control Panel**.
3. Click **Network and Internet Connections**.
4. Click **Network Connections**.
5. Right-click the icon for your wireless network connection.
6. Click **Enable**, if it appears in the pop-up menu.
   - **Note:** If Enable does not appear, your wireless connection is already enabled.
7. Right-click the **Wireless Network Connection** icon.
8. Click **Properties**.
9. Click the **Wireless Networks** tab.
   - **Note:** If the Wireless Networks tab does not appear, your computer has third-party software that controls your wireless settings. You must use that software to set up the ad hoc wireless network. For more information, see the documentation for the third-party software to learn how to create an ad hoc network.
10. Select the **Use Windows to configure my wireless network settings** check box.
11. Under Preferred Networks, delete any existing networks.
   - a. Select the network to be removed.
   - b. Click **Remove** to delete the network from the list.
12. Click **Add** to create an ad hoc network.
13. In the Network Name (SSID) box, type the name you want to give your wireless network.
14. Write down the network name you chose so you can refer to it when running the wireless setup. Be sure to use the exact spelling and capitalization.
15. If Network Authentication appears in the list, select **Open**.
16. In the “Data encryption” list, select **WEP**.
17. If necessary, clear the “The key is provided for me automatically” check box.
18. In the Network Key box, type in a WEP key.
19. Write down the WEP key you chose so you can refer to it when running the wireless setup. Make sure you copy it down exactly, including any capital letters.
20. In the “Confirm network key” box, type the same WEP key.
21. Select **This is a computer-to-computer (ad hoc) network; wireless access points are not used**.
22. Click **OK** twice to close the two open windows.
23 It may take a few minutes for your computer to recognize the new settings. To check on the status of your network:
   a Right-click the **Wireless Network Connections** icon.
   b Select **View Available Wireless Networks**.
      • If the network is listed but the computer is not connected, select the ad hoc network and then click **Connect**.
      • If the network does not appear, wait a minute and then click **Refresh network list**.

24 Insert the installation software CD, and follow the directions for wireless installation.
   **Note:** Do not connect the installation or network cables until instructed to do so by the setup software.

25 When the available networks are displayed, provide the network name and the security information you created beginning in step 13. The installer will configure the printer for use with your computer.

26 Store a copy of your network name and security information in a safe place for future reference.

**In Windows 2000**
- Refer to the documentation that shipped with your wireless network adapter for information on configuring an ad hoc network with Windows 2000.

**For Macintosh users**
1 Create a network name.

   **In Mac OS X version 10.5**
   a From the Finder desktop, click **System Preferences**.
   b Click **Network**.
   c Click **AirPort**.

   **In Mac OS X version 10.4 and earlier**
   a From the Finder desktop, click **Applications**.
   b From the Applications folder, double-click **Internet Connect**.
   c From the toolbar, click **AirPort**.

2 From the Network menu, click **Create Network**.
3 Create a name for the ad hoc network, and then click **OK**.
   **Note:** Store the network name and password in a safe place for future reference.

**Adding a printer to an existing ad hoc wireless network**

   **Note:** The printer can communicate on only one wireless network at a time. Configuring the printer for an ad hoc wireless network will remove it from any other wireless network, either ad hoc or infrastructure, for which it is configured.

**Using Windows**
1 Do one of the following:
   • In Windows Vista, click 🌐.
   • In Windows XP and earlier, click **Start**.

**Installing the printer on a wireless network (selected models only)**
2 Click **All Programs** or **Programs**, and then select the printer program folder from the list.

3 Click **Lexmark Wireless Setup Utility**.

4 Follow the instructions on the Welcome screen.

**Using Macintosh**

1. From the Finder desktop, double-click the printer folder.

2. Double-click **Lexmark Wireless Setup Assistant**.

3. Follow the instructions on the Welcome screen.

**Using WPS (Wi-Fi Protected Setup)**

*Wi-Fi Protected Setup* (WPS) is a method of configuring devices on a secure wireless network using fewer steps than in most other methods. The printer supports WPS and can be configured for a wireless access using WPS. In order to use WPS to configure the printer, the wireless router must support WPS.

**Using a WPS-capable router**

If your router supports WPS, you can add the printer to your wireless network using the method supported by your router. Refer to your router documentation for instructions.

**Using Windows Vista**

For information on using Windows Vista to set up the printer using WPS, refer to the documentation that came with the operating system.

**Note:** Lexmark recommends that you use the installation software on the CD that shipped with the printer to configure it for wireless access.

**Frequently asked questions**

**Where do I find my WEP key or WPA passphrase?**

To find the WEP key or WPA passphrase for the wireless network, view the security settings on the access point or wireless router. Most access points have a built-in Web server that can be accessed using a Web browser. If you do not know how to access the built-in Web server, or if you do not have administrator access to the wireless access point on your network, contact your system support person.

**What is an SSID?**

A Service Set Identifier (SSID) is the name that identifies a wireless network. All devices on the network must know the SSID of the wireless network or they will not be able to communicate with each other. Usually, the wireless network broadcasts the SSID to allow wireless devices in the area to connect to it. Sometimes, the SSID is not broadcast for security reasons.

If the SSID of your wireless network is not broadcast, it cannot be detected automatically and will not show up in the list of available wireless networks. You must enter the network information manually in this situation.

An SSID can contain up to 32 alphanumeric characters.
Where do I find my SSID?

You can find the SSID for the wireless network by viewing the settings on the access point or wireless router. Most access points have a built-in Web server that can be accessed using a Web browser.

Many network adapters provide a software application that allows you to view the wireless settings of your computer, including your SSID. Check your computer to see if a program was installed with your network adapter.

If you are unable to locate your SSID using either of these methods, contact your system support person.

What is a network?

A network is a collection of devices such as computers, printers, Ethernet hubs, wireless access points, and routers connected together for communication through cables or through a wireless connection. A network can be wired, wireless, or designed to have both wired and wireless devices.

Devices on a wired network use cables to communicate with each other.

Devices on a wireless network use radio waves instead of cables to communicate with each other. For a device to be able to communicate wirelessly, it must have a wireless print server attached or installed that lets it receive and transmit radio waves.

What types of wireless network security are available?

The wireless printer supports four security options: no security, WEP, WPA, and WPA2.

No Security

It is not recommended to use no security at all on a home wireless network. Using no security means that anyone within range of your wireless network can use your network resources—including Internet access, if your wireless network is connected to the Internet. The range of your wireless network may extend far beyond the walls of your home, allowing access to your network from the street or from your neighbors’ homes. Ad hoc networks, which do not use wireless access points or routers, may be safely used without security. The range of an ad hoc network is very short, making unauthorized access unlikely.

WEP

WEP (Wireless Equivalent Privacy) is the most basic and the weakest type of wireless security. WEP security relies on a series of characters called the WEP key.

Every device on the wireless network must use the same WEP key. WEP security can be used on both ad hoc and infrastructure networks.

A valid WEP key has:

- Exactly 10 or 26 hexadecimal characters. Hexadecimal characters are A-F, a-f, and 0-9
- Exactly 5 or 13 ASCII characters. ASCII characters are letters, numbers, punctuation, and symbols found on a keyboard.

WPA and WPA2

WPA (Wi-Fi Protected Access) and WPA2 (Wi-Fi Protected Access 2) offer stronger wireless network security than WEP. WPA and WPA2 are similar types of security. WPA2 is a newer version of WPA and is more secure than WPA. Both WPA and WPA2 use a series of characters, called the WPA pre-shared key or passphrase, to protect wireless networks from unauthorized access.
A valid WPA passphrase has:

- From 8 to 63 ASCII characters. ASCII characters in a WPA passphrase are case-sensitive.
  or
- Exactly 64 hexadecimal characters. Hexadecimal characters are A-F, a-f, and 0-9.

Every device on the wireless network must use the same WPA passphrase. WPA security is an option only on infrastructure networks with wireless access points and network cards that support WPA. Most newer wireless network equipment also offers WPA2 security as an option.

**How do I find out what type of security my network is using?**

You must know the WEP key or WPA passphrase and the type of security (WEP, WPA, or WPA2) used on the wireless network. To obtain this information, see the documentation that came with your wireless access point (wireless router), see the Web page associated with the wireless access point, or consult your system support person.

**Note:** The WEP key or WPA passphrase is not the same as the password for the wireless access point. The password allows you to access the wireless access point settings. The WEP key or WPA passphrase allows printers and computers to join your wireless network.

**How are home networks configured?**

For desktop computers, laptops, and printers to communicate with each other over a network, they must be connected by cables and/or have wireless network adapters built in or installed in them.

There are many different ways a network can be set up. Five common examples appear below.

**Note:** The printers in the following diagrams represent printers with internal print servers built in to them so that they can communicate over a network.

**Wired network example**

- A desktop computer, a laptop, and a printer are connected by Ethernet cables to a hub, router, or switch.
- The network is connected to the Internet through a DSL or cable modem.
Wireless network examples

Scenario 1: Mixed wired and wireless connections on a network with Internet access
- All computers and printers connect to the network through a router with Ethernet and wireless capabilities.
- Some computers and printers connect wirelessly to the router; others connect over a wired connection.
- The network is connected to the Internet through a DSL or cable modem.

Scenario 2: Wireless network with Internet access
- All computers and printers connect to the network using a wireless access point or wireless router.
- The wireless access point connects the network to the Internet through a DSL or cable modem.
Scenario 3: Wireless network with no Internet access

- Computers and printers connect to the network using a wireless access point.
- The network has no connection to the Internet.

![Diagram of wireless network](image)

Scenario 4: Computer connected wirelessly to a printer without Internet access

- A computer is directly connected to a printer without going through a wireless router.
- This configuration is referred to as an ad hoc network.
- The network has no connection to the Internet.

![Diagram of ad hoc network](image)

**Note:** Most computers can connect to only one wireless network at a time. If you access the Internet over a wireless connection, you will lose Internet access if you are connect to an ad hoc network.

**Why do I need an installation cable?**

When setting up the printer on your wireless network, the printer will need to temporarily connect to a computer using the installation cable. This temporary connection is used to set up the wireless settings of the printer.

The installation cable connects to a rectangular USB port on the installing computer and the square USB port on the printer.
How do I attach the installation cable?

The installation cable attaches to a USB port on the computer and to the square connector on the back of the printer. This connection allows you to configure the printer for a networked or locally attached installation.

1. Attach the large, rectangular connector to any USB port on your computer. USB ports may be on the front or the back of the computer, and may be horizontal or vertical.

2. Attach the small, square connector to the printer.

3. Continue following the on-screen instructions.

How are infrastructure and ad hoc networks different?

Wireless networks can operate in one of two modes: infrastructure or ad hoc.

In **infrastructure** mode, all devices on a wireless network connect to a wireless router (wireless access point). Devices on the wireless network must have valid IP addresses for the current network and share the same SSID and channel as the wireless access point.

In **ad hoc** mode, a computer with a wireless network adapter connects directly to a printer equipped with a wireless print server. There is no wireless router or access point in an ad hoc network. The computer must have a valid IP address for the current network and be set to ad hoc mode. The wireless print server must be configured to use the same SSID and channel that the computer is using.
The following table compares the characteristics and requirements of the two types of wireless networks.

<table>
<thead>
<tr>
<th>Characteristics</th>
<th>Infrastructure</th>
<th>Ad hoc</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication</td>
<td>Through wireless access point</td>
<td>Directly between devices</td>
</tr>
<tr>
<td>Security</td>
<td>More security options</td>
<td>WEP or no security</td>
</tr>
<tr>
<td>Range</td>
<td>Determined by range and number of wireless access points</td>
<td>Restricted to range of individual devices on network</td>
</tr>
<tr>
<td>Speed</td>
<td>Usually faster</td>
<td>Usually slower</td>
</tr>
</tbody>
</table>

**Requirements for all devices**

<table>
<thead>
<tr>
<th>Unique IP address for each device</th>
<th>Yes</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same SSID</td>
<td>Yes, including the wireless access point</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Lexmark recommends setting up a network in infrastructure mode using the installation CD that came with the printer.

Infrastructure mode is the recommended setup method because it offers:

- Increased network security
- Increased reliability
- Faster performance
- Easier setup

## Finding the signal strength

Wireless devices have built-in antennas that transmit and receive radio signals. The signal strength listed on the printer network setup page indicates how strongly a transmitted signal is being received. Many factors can affect the signal strength. One factor is interference from other wireless devices or other devices such as microwave ovens. Another factor is distance. The farther two wireless devices are from each other, the more likely it is that the communication signal will be weaker.

The strength of the signal received by your computer can also affect the connectivity of the printer with the network during configuration. When you installed the wireless adapter in your computer, the adapter software probably placed an icon in your system tray. Try double-clicking this icon, and it will tell you how strongly the computer is receiving the wireless signal from the network.

To improve signal quality, remove sources of interference and/or move wireless devices closer to the wireless access point (wireless router).
How can I improve wireless signal strength?

A common reason wireless printers fail to communicate over a network is poor wireless signal quality. If the signal is too weak, too distorted, or blocked by an object, it cannot carry information between the access point and the printer. To determine if the printer is receiving a strong signal from the access point, print a network setup page. The Quality field indicates the relative strength of the wireless signal the printer is receiving. Drops in signal strength can be intermittent, however, and although the signal quality appears high, it may drop during certain conditions.

If you think signal strength is a problem between your access point and the printer, try one or more of the following:

Notes:

- The solutions below are for infrastructure networks. If you are using an ad hoc network, adjust the computer when the solution suggests adjusting the access point.
- Ad hoc networks have a much shorter range than infrastructure networks. Try moving the printer closer to the computer if they seem to have trouble communicating.

Move the printer closer to the wireless access point/wireless router

If the printer is too far away from the access point, it will not be able to communicate with other devices on the network. For most indoor wireless networks, the maximum distance between the access point and the printer is approximately 100 feet (30 meters). This distance could be longer or shorter, depending upon the layout of the network and the limitations of the access point.

Remove obstacles between the access point and the printer

The wireless signal from your access point will pass through most objects. Most walls, floors, furniture and other objects will not block the wireless signal. However, there are materials that are too dense for the signal to pass through. Objects containing metal and concrete can block the signal. Arrange your printer and access point so that the signal is not blocked by such objects.

Remove sources of interference

Other types of radio frequencies can cause problems with the wireless signal on your network. These sources of interference can cause printing issues that seem to come and go. Turn off potential sources of interference where possible. Avoid using microwaves and cordless phones when printing over your wireless network.

If another wireless network is operating in the vicinity, change the wireless channel on the access point.

Do not place your access point on a printer. Printers can also interfere with the wireless signal.

Arrange the network to reduce signal absorption

Even when the wireless signal is able to pass through an object, it is slightly weakened. If it passes through too many objects, it can be significantly weakened. All objects absorb part of the wireless signal when it passes through them, and certain types of objects absorb enough to cause communications problems. Place your access point as high in the room as possible to avoid signal absorption.
Can I use my printer on a USB and a network connection at the same time?

Yes, the printer supports a simultaneous USB and network connection. The printer can be configured in the following ways:

- Locally attached (connected to a computer using a USB cable)
- Wireless network
- Wireless network and locally attached simultaneously

Note: Wireless connectivity is available on selected models only.

What is a MAC address?

A Media Access Control (MAC) address is a 48-bit identifier associated with the hardware of network equipment. The MAC address may also be called the physical address because it is connected to the hardware of a device instead of its software. The MAC address is displayed as a hexadecimal number in this format: 01-23-45-67-89-AB.

Every device capable of communicating on a network has a MAC address. Network printers, computers, and routers, whether Ethernet or wireless, all have MAC addresses.

While it is possible to change the MAC address of a network device, it is not common practice to do so. For this reason, MAC addresses are considered permanent. IP addresses are easily changed, so MAC addresses are a more reliable method of identifying a specific device on a network.

Routers with security capabilities may allow filtering of MAC addresses on networks. This allows a managed list of devices to access the network, identified by their MAC addresses. MAC address filtering can help prevent access on the network from unwanted devices, such as from intruders on a wireless network. MAC address filtering can also prevent legitimate access if you forget to add a new device to the router’s list of allowed addresses. If your network uses MAC address filtering, be sure to add the MAC address of the printer to the list of allowed devices.

How do I find the MAC address?

Most network equipment has a unique hardware identification number to distinguish it from other devices on the network. This is called the Media Access Control (MAC) address.
The MAC address is a series of letters and numbers located on the back of your printer.

Note: A list of MAC addresses can be set on an access point (router) so that only devices with matching MAC addresses are allowed to operate on the network. This is called MAC filtering. If MAC filtering is enabled in your access point (router) and you want to add a printer to your network, the MAC address of the printer must be included in the MAC filter list.

What is an IP address?

An IP address is a unique number used by devices (such as a wireless printer, computer, or wireless access point) on an IP network to locate and communicate with each other. Devices on an IP network can communicate with each other only if they have unique and valid IP addresses. A unique IP address means no two devices on the same network have the same IP address.

An IP address is a group of four numbers separated by periods. An example of an IP address is 192.168.100.110.

What is TCP/IP?

Networks are able to function because computers, printers, and other devices are able to send data to each other, either through cables or by using wireless signals. This transfer of data is made possible by sets of data transmission rules called protocols. A protocol can be thought of as a language, and like a language, it has rules allowing participants to communicate with each other.

Different types of networks use different protocols, but Transmission Control Protocol/Internet Protocol (TCP/IP) is the most popular. TCP/IP is used to send data over the Internet as well as over most corporate and home networks.

Because computers do not understand words and instead rely upon numbers for communication, TCP/IP requires that every device on a network using TCP/IP to communicate must have an IP address. IP addresses are essentially unique computer names in a numeric format, used to transfer data around a network. IP addresses allow TCP/IP to confirm requests for and receipt of data by various devices on the network.

How do I locate IP addresses?

How to locate a computer IP address using Windows

1. Do one of the following:
In Windows Vista
   a  Click 🌐.
   b  Click All Programs → Accessories.
   c  Click Command Prompt.

In Windows XP and earlier
   a  Click Start.
   b  Click All Programs or Programs → Accessories → Command Prompt.

2 Type ipconfig.
3 Press Enter.
   The IP address appears as four sets of numbers separated by periods, such as 192.168.0.100.

How to locate a computer IP address using Macintosh

1 Click ⌘→ System Preferences.
2 Click Network.

   For Mac OS X version 10.5
   a  Click AirPort.
   b  Click Advanced.
   c  Click TCP/IP.
      The IP address appears as four sets of numbers separated by periods, such as 192.168.0.100.

   For Mac OS X version 10.4 and earlier
   a  From the Show pop-up menu, select AirPort.
   b  Click TCP/IP.
      The IP address appears as four sets of numbers separated by periods, such as 192.168.0.100.

How to locate a printer IP address
- You can locate the printer IP address by viewing the printer network setup page.

How are IP addresses assigned?
An IP address may be assigned automatically by the network using DHCP. Once the printer is set up on a computer, the computer sends all print jobs across the network to the printer using this address.

If the IP address is not automatically assigned, you will be asked during wireless setup to manually enter an address and other network information after selecting your printer from the available list.

What is a key index?
A wireless access point (wireless router) can be configured with as many as four WEP keys. Only one key is used on the network at a time, however. The keys are numbered, and the number of a key is referred to as its key index. All devices on the wireless network must be configured to use the same key index when multiple WEP keys are configured on the wireless access point.
Select the same key index on your printer as you are using on your wireless access point.
Loading paper

1 Make sure:
   • You use paper designed for inkjet printers.
   • If you are using photo, glossy, or heavyweight matte paper, you load it with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.)
   • The paper is not used or damaged.
   • If you are using specialty paper, you follow the instructions that came with it.
   • You do not force paper into the printer.

2 Before loading paper the first time, press down on the paper adjustment lever to extend the paper guides.

3 Load the paper vertically in the center of the paper support, and then move the lever up or down to adjust the paper guides. The paper guides should rest against the edges of the paper.

   Note: To avoid paper jams, make sure the paper does not buckle when you adjust the paper guides.

Loading various paper types

Plain paper
You can load up to 100 sheets (depending on the thickness).

Make sure:
   • The paper is designed for use with inkjet printers.
   • The paper is loaded in the center of the paper support.
   • The paper guides rest against the edges of the paper.
Heavyweight matte paper, photo paper, glossy paper

You can load up to 25 sheets.

Make sure:
• The glossy or printable side of the paper faces you. (If you are not sure which side is the printable side, then see the instructions that came with the paper.)
• The paper is loaded in the center of the paper support.
• The paper guides rest against the edges of the paper.

Note: Photos require more drying time. Remove each photo as it exits, and then allow it to dry to avoid ink smudging.

Envelopes

You can load up to 10 envelopes.

Make sure:
• The print side of the envelopes faces you.
• The stamp location is in the upper left corner.
• The envelopes are designed for use with inkjet printers.
• The envelopes are loaded in the center of the paper support.
• The paper guides rest against the edges of the envelopes.

Warning—Potential Damage: Do not use envelopes that have metal clasps, string ties, or metal folding bars.

Notes:
• Do not load envelopes with holes, perforations, cutouts, or deep embossing.
• Do not use envelopes that have exposed flap adhesive.
• Envelopes require more drying time. Remove each envelope as it exits, and then allow it to dry to avoid ink smudging.

Labels

You can load up to 25 sheets.

Make sure:
• The print side of the labels faces you.
• The top of the label sheets feeds into the printer first.
• The adhesive on the labels does not extend to within 1 mm of the edge of the label sheets.
• You use full label sheets. Partial sheets (with areas exposed by missing labels) may cause labels to peel off during printing, resulting in a paper jam.
• The label sheets are loaded in the center of the paper support.
• The paper guides rest against the edges of the label sheets.

**Note:** Labels require more drying time. Remove each sheet of labels as it exits, and then allow it to dry to avoid ink smudging.

**Transparencies**

You can load up to 50 transparencies.

Make sure:
• The rough side of the transparencies faces you.
• If the transparencies have a removable strip, each strip faces away from you and down toward the printer.
• The transparencies are loaded in the center of the paper support.
• The paper guides rest against the edges of the transparencies.

**Notes:**
• Transparencies with paper backing sheets are not recommended.
• Transparencies require more drying time. Remove each transparency as it exits, and then allow it to dry to avoid ink smudging.

**Iron-on transfers**

You can load up to 10 transfers.

Make sure:
• You follow the loading instructions that came with the iron-on transfers.
• The print side of the transfers faces you.
• The transfers are loaded in the center of the paper support.
• The paper guides rest against the edges of the transfers.

**Note:** For best results, load transfers one at a time.

**Greeting cards, index cards, photo cards, postcards**

You can load up to 25 cards.

Make sure:
• The print side of the cards faces you.
• The cards are loaded in the center of the paper support.
• The paper guides rest against the edges of the cards.

**Note:** Photo cards require more drying time. Remove each photo card as it exits, and then allow it to dry to avoid ink smudging.
Custom-size paper
You can load up to 100 sheets (depending on the thickness).

Make sure:
• The print side of the paper faces you.
• The paper size fits within these dimensions:
  Width:
  – 76.2–215.9 mm
  – 3.0–8.5 inches
  Length:
  – 127.0–355.6 mm
  – 5.0–17.0 inches
• The paper is loaded in the center of the paper support.
• The paper guides rest against the edges of the paper.

Banner paper
You can load up to 20 sheets.

Make sure:
• You remove all the paper from the paper support before loading the banner paper.
• You tear off only the number of pages needed to print the banner.
• You place the required stack of banner paper on a flat surface behind the printer.
• The leading edge of the banner paper feeds into the printer first.
• The paper is loaded in the center of the paper support.
• The paper guides rest against the edges of the paper.
Loading original documents on the scanner glass

You can scan and then print photos, text documents, magazine articles, newspapers, and other publications. You can scan a document for faxing. You can also scan three-dimensional objects for use in catalogs, brochures, or product flyers.

Note: Place photos, postcards, small items, thin items (such as magazine clippings), and three-dimensional objects on the scanner glass instead of in the ADF.

1. Make sure the computer and the printer are on.
2. Open the top cover.

3. Place the original document facedown on the scanner glass in the upper left corner.

Note: Photos should be loaded as shown.
Close the top cover to avoid dark edges on the scanned image.

Loading original documents into the Automatic Document Feeder

You can load up to 25 sheets of an original document into the Automatic Document Feeder (ADF) for scanning, copying, and faxing. You can load A4-, letter-, or legal-size paper into the ADF.

Notes:

• Use only new, unwrinkled paper that is not curled.
• Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.

1 Adjust the paper guide on the ADF tray to the width of the original document.
2 Fan the original document.
3 Load the original document faceup and top edge first into the ADF until you hear a beep.

The document feeds into the ADF.

Note: Preview is not supported when using the ADF. You can preview one page at a time when using the scanner.
## Automatic Document Feeder (ADF) paper capacity

<table>
<thead>
<tr>
<th>Load up to</th>
<th>Make sure</th>
</tr>
</thead>
<tbody>
<tr>
<td>25 sheets of:</td>
<td>• You adjust the paper guide on the ADF tray to the width of the original document.</td>
</tr>
<tr>
<td>• Letter-size paper</td>
<td>• The original document is loaded faceup, top edge first, until you hear a <em>beep</em>.</td>
</tr>
<tr>
<td>• A4-size paper</td>
<td>• The paper size fits within these dimensions:</td>
</tr>
<tr>
<td>• Legal-size paper</td>
<td>Width:</td>
</tr>
<tr>
<td></td>
<td>– 210.0 mm–215.9 mm</td>
</tr>
<tr>
<td></td>
<td>– 8.25 in.–8.5 in.</td>
</tr>
<tr>
<td></td>
<td>Length:</td>
</tr>
<tr>
<td></td>
<td>– 279.4 mm–355.6 mm</td>
</tr>
<tr>
<td></td>
<td>– 11.0 in.–14.0 in.</td>
</tr>
<tr>
<td></td>
<td>• You allow preprinted media to dry thoroughly before loading into the ADF.</td>
</tr>
<tr>
<td></td>
<td>• You do <em>not</em> use media printed with metallic ink particles.</td>
</tr>
<tr>
<td></td>
<td>• You avoid embossed designs.</td>
</tr>
</tbody>
</table>

## Using the automatic paper type sensor

The printer is equipped with an automatic paper type sensing device. The Paper Type Sensor automatically detects the type of paper that has been loaded into the printer and adjusts the settings for you. For example, if you want to print a photo, load photo paper into the printer. The printer detects the type of paper and automatically adjusts the settings to give you optimum photo-printing results.
Printing

Printing basic documents

Printing a document

1. Load the paper.

2. Do one of the following to print:

   **Using Windows**
   a. With a document open in a Windows program, click **File ➔ Print**.
   b. Click **Properties, Preferences, Options, or Setup**.
   c. Select the print quality, the number of copies to print, the type of paper to be used, and how the pages should print.
   d. Click **OK** to close any printer software dialogs.
   e. Click **OK** or **Print**.

   **Using Macintosh**
   a. With a document open in a Macintosh application, click **File ➔ Print**.
   b. From the Printer pop-up menu, choose the printer.
   c. From the print options pop-up menu, choose the print quality, the number of copies to print, the type of paper to be used, and how the pages should print.
   d. Click **Print**.

Printing Web pages

If you chose to install the Lexmark Toolbar software for your Web browser, then you can use it to create a printer-friendly version of any Web page.

**Notes:**

- For Windows, the software supports Microsoft Internet Explorer 5.5 or later or a compatible version of Firefox.
- For Macintosh, the software supports a compatible version of Firefox.
1 Load paper.
2 Open a Web page using a supported browser.
3 Select a print option to print the page.
   You can also adjust settings or preview the page before printing.

**Printing multiple copies of a document**

**Using Windows**

1 With a document open, click **File → Print**.
2 Click **Properties, Preferences, Options, or Setup**.
3 From the Copies section of the Print Setup tab, enter the number of copies that you want to print.
4 Click **OK** to close any printer software dialogs.
5 Click **OK** or **Print**.

**Using Macintosh**

1 With a document open, click **File → Print**.
2 From the Printer pop-up menu, choose the printer.
3 In the Copies field, enter the number of copies that you want to print.
4 Click **Print**.

**Collating printed copies**

If you print multiple copies of a document, you can choose to print each copy as a set (collated) or to print the copies as groups of pages (not collated).

<table>
<thead>
<tr>
<th>Collated</th>
<th>Not collated</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 1 2 1 3 2 1</td>
<td>1 1 2 2 3 3</td>
</tr>
</tbody>
</table>

**Using Windows**

1 With a document open, click **File → Print**.
2 Click **Properties, Preferences, Options, or Setup**.
3 From the Copies section of the Print Setup tab, enter the number of copies that you want to print, and then select **Collate Copies**.
4 Click **OK** to close any printer software dialogs.
5 Click **OK** or **Print**.

*Note:* The collate option is available only when you are printing multiple copies.
Using Macintosh

1 With a document open, click **File ➔ Print**.
2 In the Copies field, enter the number of copies that you want to print, and then select **Collated**.
3 Click **Print**.

**Note:** To prevent smudging when printing photos, remove each photo as it exits the printer, and then let it dry before stacking.

Printing the last page first (reverse page order)

**Using Windows**

1 With a document open, click **File ➔ Print**.
2 Click **Properties**, **Preferences**, **Options**, or **Setup**.
3 From the Copies section of the Print Setup tab, select **Print Last Page First**.
4 Click **OK** to close any printer software dialogs.
5 Click **OK** or **Print**.

**Using Macintosh**

1 With a document open, click **File ➔ Print**.
2 From the Printer pop-up menu, choose the printer.
3 Do one of the following:
   - **For Mac OS X versions 10.5 and 10.4**
     a From the print options pop-up menu, choose **Paper Handling**.
     b From the Page Order menu, select **Reverse**.
   - **For Mac OS X version 10.3**
     a From the print options pop-up menu, choose **Paper Handling**.
     b Select **Reverse page order**.
4 Click **Print**.

Printing multiple pages on one sheet (N-Up)

**Using Windows**

1 With a document open, click **File ➔ Print**.
2 Click **Properties**, **Preferences**, **Options**, or **Setup**.
3 From the **Advanced** tab, select **N-Up** under the Layout drop-down menu.
4 Select the number of page images to print on each page.
   - If you want each page image to be surrounded by a border, then select **Print Page Borders**.
5 Click **OK** to close any printer software dialogs.

6 Click **OK** or **Print**.

Using Macintosh

1 With a document open, click **File → Print**.

2 From the print options pop-up menu, choose **Layout**.
   - From the Pages per Sheet pop-up menu, choose the number of page images that you want to print on one sheet.
   - From the Layout Direction area, click the icon that shows the order that you want the page images to print on one sheet.
   - If you want to print a border around each page image, then choose an option from the Border pop-up menu.

3 Click **Print**.

Printing documents from a memory card or flash drive

To enable the File print function:
- The printer must be connected to a computer through a USB cable or through a network.
- The printer and the computer must be on.
- The memory card or flash drive must contain document files that are supported by the printer.
- The computer must contain applications that support the file types in the memory device.

1 Insert a memory card or flash drive.
   The following file types are recognized:
   - .doc (Microsoft Word)
   - .xls (Microsoft Excel)
   - .ppt (Microsoft PowerPoint)
   - .pdf (Adobe Portable Document Format)
   - .rtf (Rich Text Format)
   - .docx (Microsoft Word Open Document Format)
   - .xlsx (Microsoft Excel Open Document Format)
   - .pptx (Microsoft PowerPoint Open Document Format)
   - .wps (Microsoft Works)
   - .wpd (WordPerfect)

   When the printer detects the memory device, the message **Memory Card Detected** or **Storage Device Detected** appears on the printer control panel display.

2 If only document files are stored on the memory device, then the printer automatically switches to File Print mode.
   If document files and image files are stored on the memory device, then press [OK] to select **Documents**.

3 Do one of the following:
USB connection

a Press the arrow buttons to select the file name of the document that you want to print or the folder where the document is saved in the memory device.

b Press OK, and then press to start printing the document.

Wireless connection (selected models only)

a Wait for the printer to connect to the network computer or to finish searching the network for available computers.

If prompted, press the arrow buttons to select a network computer, and then press OK.

Notes:

• You may be prompted to enter a PIN if the computer requires it. To assign a computer name and a PIN to the computer, see the Help for the printer software associated with your operating system.
• If your printer has a numeric keypad, enter the PIN using the keypad, and then press OK.
• If your printer does not have a numeric keypad, use the arrow buttons to decrease or increase the value for each digit (the default value is 0000) in the PIN, and then press OK each time you select a digit.

b Press the arrow buttons to select the file name of the document that you want to print or the folder where the document is saved in the memory device.

c Press OK, and then press to start printing the document.

Printing specialty documents

Choosing compatible specialty paper types

• Heavyweight matte paper—A photo paper with a matte finish used for printing high-quality graphics.
• Standard Glossy/Photo paper—Photo paper with a special coating. It is used specifically for printing photos with crisp, sharp images.
• Lexmark Photo Paper—An outstanding "everyday" heavyweight inkjet photo paper designed for use with Lexmark printers, but compatible with all brands of inkjet printers. Although inexpensive, it offers excellent image quality and outstanding value.
• Lexmark PerfectFinish™ Photo Paper—A high-quality photo paper specifically designed for Lexmark inkjet printers, but compatible with all inkjet printers. It is used specifically for printing professional quality photos with a glossy finish. It is best when used with genuine Lexmark evercolor™ 2 ink, providing photos that are fade- and water-resistant.
• Transparency—A clear, plastic media primarily used for overhead projectors.
• Card stock—A very thick paper used for printing sturdier items, such as greeting cards.
• Iron-On transfer—A type of media that has a reverse image printed on it that can be ironed onto fabric.
• Labels—A self-adhesive, inkjet-compatible paper that comes in different types, formats, and sizes.
Printing envelopes

1 Load the envelopes in the printer.

2 Do one of the following:

Using Windows

a With a document open, click File ➔ Print.

b Click Properties, Preferences, Options, or Setup.

c From the Media Type list of the Print Setup tab, select Plain.

d From the Paper Size list, select the envelope size.

Note: To print on a custom-size envelope, select Custom Size, and then specify the height and width of the envelope.

e Select Portrait or Landscape orientation.

f Click OK to close any printer software dialogs.

g Click OK or Print.

Using Macintosh

a Customize the settings as needed in the Page Setup dialog.

1 With a document open, click File ➔ Page Setup.

2 From the “Format for” pop-up menu, choose the envelope size. If no size matches the size of the envelope, then set a custom size.

3 Select an orientation.

4 Click OK.

b Customize the settings as needed in the Print dialog.

1 With a document open, click File ➔ Print.

2 From the Printer pop-up menu, choose the printer that you want to use.

3 Click Print.

Notes:

• Most envelopes use landscape orientation.

• Make sure the same orientation is also selected in the software application.

Printing labels

1 Load the label sheets in the printer.

2 Do one of the following:
Using Windows

a With a document open, click File ➔ Print.
b Click Properties, Preferences, Options, or Setup.
c From the Paper Size drop-down menu of the Print Setup tab, choose a paper size that matches the size of the label sheet. If no paper size matches the label sheet size, then set a custom size.
   If necessary, choose the appropriate type of media from the Media Type drop-down menu.
d Click OK to close any printer software dialogs.
e Click OK or Print.

Using Macintosh

a Customize the settings as needed in the Page Setup dialog.
   1 With a document open, choose File ➔ Page Setup.
   2 From the “Format for” pop-up menu, choose the printer that you want to use.
   3 From the Paper Size pop-up menu, choose a paper size that matches the size of the label sheet. If no paper size matches the label sheet size, then create a custom size.
b Customize the settings as needed in the Print dialog.
   1 With a document open, click File ➔ Print.
   2 From the Printer pop-up menu, choose the printer that you want to use.
   3 From the print options pop-up menu, choose Quality & Media.
   4 From the Paper type pop-up menu, choose a paper type.
   5 From the Print Quality menu, choose a print quality other than Quick Print.

Tips on loading label sheets

• Make sure the top of the label sheet feeds into the printer first.
• Make sure the adhesive on the labels does not extend to within 1 mm of the edge of the label sheet.
• Make sure the paper guide or paper guides rest against the edges of the label sheet.
• Use full label sheets. Partial sheets (with areas exposed by missing labels) may cause labels to peel off during printing, resulting in a paper jam.

Note: Labels require more drying time. Remove each label sheet as it exits, and then allow it to dry to avoid ink smudging.

Printing on custom-size paper

Before beginning these instructions, load the custom-size paper in the printer. For more information, see the “Loading Paper” chapter.

Using Windows

1 With a document open, click File ➔ Print.
2 Click Properties, Preferences, Options, or Setup.
   The Print Setup tab appears.
3 In the Paper Options section, from the “Paper size” list, select Custom Size.
   The Define Custom Paper Size dialog appears.
4 Select the measurement units to use (inches or millimeters).
5 Click OK to close any printer software dialogs that are open.
6 Print the document.

Using Macintosh
1 With a document open, click File → Page Setup.
2 From the Paper size pop-up menu, choose Manage Custom Sizes.
3 Create a custom size.
   a Click +.
   b In the Page Size menu, type the Width and Height of the paper.
   c From the Printer Margins pop-up menu, choose the printer that you want to use. The margins are set by the printer.
      If you want to set the margins, choose User defined, and then type the margins in the Printer Margins area.
   d From the custom sizes list on the left of the dialog, double-click Untitled, and then type a name for the custom paper size you set.
   e Click OK.
4 Open the Paper size pop-up menu again, and then choose the name of the custom paper size you added in Step 3d.
5 Click Print.

Managing print jobs

Pausing print jobs

Using the printer folder in Windows
1 Do one of the following:
   In Windows Vista
      a Click 🌐.
      b Click Control Panel.
      c Under Hardware and Sound, click Printer.
   In Windows XP
      a Click Start.
      b Click Printers and Faxes.
   In Windows 2000
      a Click Start.
      b Click Settings → Printers.
2 Right-click the printer, and then select Pause Printing.
Using the taskbar in Windows
1 Double-click the printer icon in the taskbar.
2 Right-click the document name, and then select Pause.

Using Macintosh
1 While the document is printing, click the printer icon in the Dock. The print queue dialog appears.
2 Do one of the following:
   • If you want to pause a particular print job, choose the document name, and then click Hold.
   • If you want to pause all print jobs in the queue, click Pause Printer or Stop Jobs, depending on the operating system version that you are using.

Resuming print jobs

Using the printer folder in Windows
1 Do one of the following:
   In Windows Vista
      a Click .
      b Click Control Panel.
      c Under Hardware and Sound, click Printer.
   In Windows XP
      a Click Start.
      b Click Printers and Faxes.
   In Windows 2000
      a Click Start.
      b Click Settings → Printers.
2 Right-click the printer name, and then select Open.
3 Do one of the following:
   • If you want to resume a particular print job, right-click the document name, and then select Resume.
   • If you want to resume all print jobs in the queue, click Printer, and then clear the selection for Pause Printing.

Using the taskbar in Windows
1 Double-click the printer icon in the taskbar.
2 Right-click the document name, and then select Resume.
Using Mac OS X version 10.5

1. From the menu bar, click 🔄 → System Preferences → Print & Fax.
2. Click Open Print Queue.
   
   The print queue dialog appears.
   
   • If you want to resume a particular print job, choose the document name, and then click Resume.
   
   • If you want to resume all print jobs in the queue, then click Resume Printer.

Using Mac OS X version 10.4 and earlier

1. From the menu bar, click Go → Utilities → Print Center or Printer Setup Utility.
   
   The Printer List dialog appears.
2. Double-click the printer.
   
   The print queue dialog appears.
3. Do one of the following:
   
   • If you want to resume all print jobs in the queue, click Start Jobs.
   
   • If you want to resume a particular print job, choose the document name, and then click Resume.

Canceling print jobs

Using the printer control panel

Press ✗.

Using the printing status window of the printer

The printing status window automatically opens at the bottom-right part of your screen when you send a print job. Click Cancel Printing to cancel the print job.

Using the printer folder in Windows

1. Do one of the following:

   In Windows Vista
   
   a. Click 🔄.
   
   b. Click Control Panel.
   
   c. Under Hardware and Sound, click Printer.

   In Windows XP
   
   a. Click Start.
   
   b. Click Printers and Faxes.

   In Windows 2000
   
   a. Click Start.
   
   b. Click Settings → Printers.
2. Right-click the printer name, and then select Open.
3 Do one of the following:
   • If you want to cancel a particular print job, right-click the document name, and then select Cancel.
   • If you want to cancel all print jobs in the queue, click Printer → Cancel All Documents.

Using the taskbar in Windows
1 Double-click the printer icon in the taskbar.
2 Do one of the following:
   • If you want to cancel a particular print job, right-click the document name, and then select Cancel.
   • If you want to cancel all print jobs in the queue, click Printer → Cancel All Documents.

Using Macintosh
1 While the document is printing, click the printer icon in the Dock.
2 From the print queue dialog, choose the job that you want to cancel, and then click Delete.
Inserting a memory card

1 Insert a memory card.
   - Insert the card with the brand name label facing up.
   - If there is an arrow on the card, make sure it points toward the printer.
   - If needed, make sure you connect the memory card to the adapter that came with it before inserting it into the slot.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Memory card</th>
</tr>
</thead>
</table>
| 1    | - Secure Digital (SD)  
|      | - High Capacity Secure Digital (with adapter)  
|      | - Micro Secure Digital (with adapter) (Micro SD)  
|      | - Mini Secure Digital (with adapter) (Mini SD)  
|      | - MultiMedia Card (MMC)  
|      | - Reduced Size MultiMedia Card (with adapter) (RS-MMC)  
|      | - MultiMedia Card mobile (with adapter) (MMCmobile)  
|      | - Memory Stick  
|      | - Memory Stick PRO  
|      | - Memory Stick Duo (with adapter)  
|      | - Memory Stick PRO Duo (with adapter)  
|      | - xD-Picture Card  
|      | - xD-Picture Card (Type H)  
|      | - xD-Picture Card (Type M)  |
| 2    | - Compact Flash Type I and Type II  
|      | - Microdrive |
2. Wait for the light located near the top memory card slot on the printer to come on. The light blinks to indicate the memory card is being read or is transmitting data.

**Warning—Potential Damage:** Do not touch cables, any network adapter, any connector, the memory card, or the printer in the area shown while actively printing, reading, or writing from the memory card. A loss of data can occur. Also, do not remove the memory card while actively printing, reading, or writing from it.

When the printer detects the memory card, the message *Memory Card Detected* appears on the printer control panel display.

If the printer does not read the memory card, then remove and reinsert it.

**Notes:**
- The printer recognizes one memory card at a time. If you insert more than one memory card, then a message appears on the display prompting you to remove one of the memory cards.
- If a flash drive or a digital camera set to mass storage mode is inserted into the PictBridge port while a memory card is in the card slot, then a message appears on the display prompting you to choose which memory device to use.

**Inserting a flash drive**

1. Insert the flash drive into the PictBridge port on the front of the printer.

   **Note:** An adapter may be necessary if your flash drive does not fit directly into the port.

2. Wait for the printer to recognize that a flash drive is installed. When the flash drive is recognized, the message *Storage Device Detected* appears.

   If the printer does not read the flash drive, remove and reinsert it.

   **Warning—Potential Damage:** Do not touch cables, any network adapter, any connector, the flash drive, or the printer in the area shown while actively printing, reading, or writing from the flash drive. A loss of data can occur. Also, do not remove the flash drive while actively printing, reading, or writing from the flash drive.
Note: The printer recognizes one active media device at a time. If you insert more than one media device, a message appears on the display prompting you to designate the device you want the printer to recognize.

Printing photos

Printing photos using the printer control panel

1 Load photo paper with the glossy or printable side facing you. (If you are not sure which side is the printable side, see the instructions that came with the paper.)

2 From the printer control panel, press  

3 Insert a memory card, flash drive, or digital camera set to mass storage mode.

4 Press the arrow buttons until Easy Photo or Print Photos appears, and then press  

Notes:
• Select Easy Photo if you want to print photos quickly.
• Select Print Photos if you want to customize the photos before printing the photos.

5 Press the arrow buttons to select an option on printing photos, and then press  

Note: You can choose to print the most recent photo, print all the photos, print photos that fall within a date range, or print photos by selecting the photo numbers that are on the proof sheet. If you want to check the photo numbers of the photos before printing, then print a proof sheet.

6 Do one of the following:
• If you are in the Easy Photo menu, use the arrow buttons to select the paper size and photo size. Press  each time you make a selection.
• If you are in the Print Photos menu, use the arrow buttons to select the photo size, paper size, paper type, layout, and quality of the photos, and to adjust the brightness and color effects of the photos. Press  each time you make a selection.

7 Press  

Note: To prevent smudging or scratching, avoid touching the printed surface with your fingers or sharp objects. For best results, remove each printed sheet individually from the paper exit tray, and allow the prints to dry at least 24 hours before stacking, displaying, or storing.

Working with photos
Printing photos from the computer using the printer software

1 Load photo paper with the glossy or printable side facing you. (If you are not sure which side is the printable side, then see the instructions that came with the paper.)

2 To print the photos:

   Using Windows
   a Do one of the following:
      • In Windows Vista, click 📱.
      • In Windows XP and earlier, click Start.
   b Click All Programs or Programs, and then select the printer program folder from the list.
   c Select Lexmark Productivity Studio.
      Note: This program may not appear in your printer program folder, depending on whether you chose to install it with the printer software during installation.
   d Open the photo that you want to print.
   e Follow the instructions on the computer screen to edit and print photos. You may also view the Help associated with the program.

   Using Macintosh
   a Customize the settings as needed in the Page Setup dialog.
      1 With a photo open, choose File → Page Setup.
      2 From the “Format for” pop-up menu, choose the printer.
      3 From the Paper Size pop-up menu, choose a paper size.
      4 Click OK.
   b Customize the settings as needed in the Print dialog.
      1 With a photo open, choose File → Print.
      2 From the Printer pop-up menu, choose the printer.
      3 From the print options pop-up menu, choose Quality & Media.
         • From the Paper Type pop-up menu, choose a paper type.
         • From the Print Quality menu, choose Automatic or Photo.
      4 Click Print.
      Note: Manually choosing a paper type, even if you have a paper type sensor, turns off the sensor for the current print job.

Printing photos from a memory device using the printer software

1 Load photo paper with the glossy or printable side facing you. (If you are not sure which side is the printable side, then see the instructions that came with the paper.)

2 Insert a memory card, flash drive, or digital camera set to mass storage mode.

3 From the printer control panel, press 📷.

4 Press the arrow buttons until Save Photos appears, and then press OK.

5 Transfer the photos to the computer.
USB connection

a  Press OK.

b  If you are using Windows:
   If you installed Lexmark Productivity Studio, then it launches when you insert the memory device. Follow the instructions on the computer screen to transfer the photos to the computer, and then use the programs installed on the computer to print the photos.

If you are using Macintosh:
   If you have iPhoto installed on the computer, then it launches when you insert the memory device. Follow the instructions on the computer screen to transfer the photos to the computer, and then use the applications installed on the computer to print the photos.

Wireless connection (selected models only)

a  Press the arrow buttons until Network appears, and then press OK.

b  If prompted, press the arrow buttons to select the network computer where you want to save the photos, and then press OK.

c  If you are using Windows:
   1  Do one of the following:
      • In Windows Vista, click .
      • In Windows XP and earlier, click Start.
   2  Click All Programs or Programs, and then select the printer program folder from the list.
   3  Click Lexmark Productivity Studio.
   4  From the Photo Printing section of the main screen, click Download to library.
   5  Browse to the location of the memory device, and then click Transfer.
   6  Select the network printer.
   7  Follow the instructions on the computer screen to transfer and print the photos.

If you are using Macintosh:
   If the printer is connected to the computer through a network, then the Lexmark Network Card Reader launches on the computer.
   Transfer the photos to the computer using the application, and then use the applications installed on the computer to print the photos.
   For more information on transferring photos using the Lexmark Network Card Reader, see the Help associated with the application.
Printing photos from a PictBridge-enabled digital camera

PictBridge is a technology available in most digital cameras that lets you print directly from your digital camera without using a computer. You can connect a PictBridge-enabled digital camera to the printer, and use the camera to control printing photos.

1 Insert one end of the USB cable into the camera.
   
   **Note:** Use only the USB cable that came with the camera.

2 Insert the other end of the cable into the PictBridge port on the front of the printer.

**Notes:**

- Make sure that the PictBridge-enabled digital camera is set to the correct USB mode. If the camera USB selection is incorrect, then the camera is detected as a USB storage device, or an error message will be displayed on the printer control panel. For more information, see the camera documentation.
- The printer reads only one media device at a time.

**Warning—Potential Damage:** Do not touch the USB cable, any network adapter, any connector, or the printer in the area shown while actively printing from a PictBridge-enabled digital camera. A loss of data can occur. Also, do not remove the USB cable or network adapter while actively printing from a PictBridge-enabled digital camera.

3 If the PictBridge connection is successful, then the following message appears on the display: **PictBridge Camera detected. Press OK to change settings.**

4 Use the camera to choose and print photos. If desired, you can also use the Pictbridge menu to select the paper size, paper type, photo size, and layout of the photos that you want to print.

   Press **OK** to access the PictBridge menu, and then press **OK** each time you make a selection.
Notes:

- If you insert the camera while the printer is performing another job, wait for the job to finish before printing from the camera.
- To use the camera to control printing photos, see the instructions in the camera documentation.

Printing photos stored on a memory device using the proof sheet

1. Load letter- or A4-size plain paper.
2. From the printer control panel, press \( \text{ } \).
3. Insert a memory card or flash drive.
4. Press the arrow buttons until Proof Sheet appears, and then press OK.
5. Press the arrow buttons to select an option to print a proof sheet.
   You can print a proof sheet:
   - For all photos on the memory device.
   - For the 20 most recent photos, if there are 20 or more photos on the memory device.
   - By date, if the photos on the card were taken on different dates. If you choose this option, use the arrow buttons on the printer control panel to choose the date range, and then press OK to save your selections.
6. Press OK.
   The proof sheet prints.
7. Follow the instructions on the proof sheet to select which photos to print, the number of copies per photo, red-eye reduction, page layout, print options, and paper size.
   **Note:** When making selections, make sure to fill in the circles completely.
8. Load the proof sheet facedown on the scanner glass.
   Scan Proof Sheet appears on the display.
   **Note:** If this option does not appear on the display, then press the arrow buttons until it appears on the display.
9. Press OK.
   The printer scans the proof sheet.
10. Load photo paper vertically in the center of the paper support, with the glossy or printable side facing you. (If you are not sure which side is the printable side, then see the instructions that came with the paper.)
    **Note:** Make sure that the paper matches the size that you selected on the proof sheet.
11. Press OK to print the photos.
    **Note:** To prevent smudging or scratching, avoid touching the printed surface with your fingers or sharp objects. For best results, remove each printed sheet individually from the paper exit tray, and then allow the prints to dry at least 24 hours before stacking, displaying, or storing.
Printing photos from a digital camera using DPOF

Digital Print Order Format (DPOF) is a feature available on some digital cameras. If your camera supports DPOF, then you can specify which photos to print, how many of each, and the print settings while the memory card is still in the camera. The printer recognizes these settings when you insert the memory card into the printer or connect the camera to the printer.

**Note:** If you specify a photo size while the memory card is still in the camera, then make sure that the size of the paper loaded in the printer is not smaller than the size you specify in the DPOF selection.

1. Load photo paper with the glossy or printable side facing you. (If you are not sure which side is the printable side, then see the instructions that came with the paper.)

2. Insert a memory card.
   - When the printer detects the memory card, the message Memory Card Detected appears on the printer control panel display.

3. Press the arrow buttons until Print Photos appears, and then press OK.

4. Press the arrow buttons until Print DPOF appears, and then press OK to print the photos.
   - **Note:** This option appears only if a DPOF file is detected in the memory card.

**Note:** To prevent smudging or scratching, avoid touching the printed surface with your fingers or sharp objects. For best results, remove each printed sheet individually from the paper exit tray, and allow the prints to dry at least 24 hours before stacking, displaying, or storing.
Scanning

For more options on scanning and customizing scanned images, see the Help associated with the programs installed with the printer software.

Scanning original documents

You can scan and then print photos, text documents, magazine articles, newspapers, and other publications. You can also scan a document for faxing.

Using the printer control panel

1 Load an original document faceup into the Automatic Document Feeder (ADF) or facedown on the scanner glass.

   Notes:
   - Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
   - Adjust the paper guide on the ADF tray to the width of the original document.
   - When using the scanner glass, close the top cover to avoid dark edges on the scanned image.

2 From the printer control panel, press ⌘.

   Scan to appears on the display. You can send the scanned image to a computer, flash drive, memory card, or to a computer over a network.

   • If you choose to send the scanned image to the computer:
     a Press OK.
     b Wait until the printer has finished downloading the scan applications list.
     c Press the arrow buttons until the application that you want appears, and then press OK.
     d Use the arrow buttons to select the quality and original image size, and then press OK each time you make a selection.
     e Press OK.
• If you choose to send the scanned image to a memory card or flash drive:
  a  Insert the memory device.

  **Note:** Make sure that the memory device is not write-protected.
  b  Press the arrow buttons until **Memory Card** or **USB Flash Drive** appears, and then press **OK**.
  c  Use the arrow buttons to select the quality and original image size, and then press **OK** each time you make a selection.
  d  Press **OK**.

  **Note:** Do not remove the memory device until the menu indicates that the file has been saved.

• If you choose to send the scanned image to a computer over the network (selected models only):
  a  Press the arrow buttons until **Network** appears, and then press **OK**.
  b  If prompted, press the arrow buttons until the computer name of the network computer appears, and then press **OK**.

  **Notes:**
  – You may be prompted to enter a PIN if the computer requires it. To assign a computer name and a PIN to the network computer, see the Help for the printer software associated with your operating system.
  – If your printer has a numeric keypad, enter the PIN using the keypad, and then press **OK**.
  – If your printer does not have a numeric keypad, use the arrow buttons to decrease or increase the value for each digit (the default value is 0000) in the PIN, and then press **OK** each time you select a digit.
  c  Wait until the printer has finished downloading the scan applications list.
  d  Press the arrow buttons until the application that you want appears, and then press **OK**.
  e  Use the arrow buttons to select the quality and original image size, and then press **OK** each time you make a selection.
  f  Press **OK**.

  **Note:** Do not remove the memory device until the menu indicates that the file has been saved.

### Using Windows

1  Open the top cover, and then load an original document facedown on the scanner glass.

2  Close the top cover to avoid dark edges on the scanned image.

3  Do one of the following:
   • In Windows Vista, click **Start**.
   • In Windows XP and earlier, click **Start**.

4  Click **All Programs** or **Programs**, and then select the printer program folder from the list.

5  Click **Lexmark Productivity Studio**.

6  From the main screen, click **Scan**.

7  Follow the instructions on the computer screen.
Using Macintosh

1. Open the top cover, and then load an original document facedown on the scanner glass.
2. Close the top cover to avoid dark edges on the scanned image.
3. From the Finder desktop, double-click the printer folder.
4. Double-click XXXX Series Center, where XXXX is the printer series.
5. From the “What is being scanned?” menu, choose the type of document to be scanned.
6. Click Scan.

Scanning color or black-and-white original documents

1. Load an original document faceup into the Automatic Document Feeder (ADF) or facedown on the scanner glass.

   Notes:
   - Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
   - Adjust the paper guide on the ADF tray to the width of the original document.
   - When using the scanner glass, close the top cover to avoid dark edges on the scanned image.

2. From the printer control panel, press .
3. Press the arrow buttons to choose where to send the scanned image. You can send the scanned image to a computer, flash drive, memory card, or to a computer over a network.
4. When the destination that you want appears, press OK.
5. To scan black-and-white documents, press Black.
   
   Note: The default setting when you are using the Scan mode is Color. You do not need to press Color if you are scanning a color document.
6. Press .

Scanning photos for editing

1. Open the top cover, and then load an original document facedown on the scanner glass.
2. Close the top cover to avoid dark edges on the scanned image.
3. From the printer control panel, press .
4. Press the arrow buttons until Computer or Network appears, and then press OK.
   
   Note: If you choose Network, you will be asked to select a network computer. If prompted, press the arrow buttons until the network computer that you want appears, and then press OK.
5 Wait for the printer to finish downloading the applications list.

   Note: This list is downloaded from the applications available on the computer. Make sure a photo-editing
   application is installed on the computer.

6 From the list of applications, press the arrow buttons until the application that you want appears.

7 Press \( \text{OK} \).
   The scanned image is sent to the photo-editing application that you selected.

---

Scanning to a computer over a network

1 Make sure that:
   • The printer is connected to a network through a print server or through a wireless network connection.
   • The printer, the print server (if used), and the computer receiving the scanned image are all turned on.
   • The printer is configured to scan over a network.

2 Load an original document faceup into the Automatic Document Feeder (ADF) or facedown on the scanner glass.

   Notes:
   • Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
     clippings) into the ADF. Place these items on the scanner glass.
   • Adjust the paper guide on the ADF tray to the width of the original document.
   • When using the scanner glass, close the top cover to avoid dark edges on the scanned image.

3 From the printer control panel, press \( \text{Cancel} \).

4 Press the arrow buttons until Network appears, and then press \( \text{OK} \).

5 If prompted, press the arrow buttons to select the computer name of the network computer where you want to
   send the scanned image, and then press \( \text{OK} \).

   Notes:
   • You may be prompted to enter a PIN if the computer requires it. To assign a computer name and a PIN to the
     network computer, see the Help for the printer software associated with your operating system.
   • If your printer has a numeric keypad, enter the PIN using the keypad, and then press \( \text{OK} \).
   • If your printer does not have a numeric keypad, use the arrow buttons to decrease or increase the value for
     each digit (the default value is 0000) in the PIN, and then press \( \text{OK} \) each time you select a digit.

6 Wait until the printer has finished downloading the scan applications list.

7 Press the arrow buttons until the application that you want appears, and then press \( \text{OK} \).

8 Press \( \text{OK} \).

---

Canceling scan jobs

Using the printer control panel

To cancel a scan job started in the printer control panel, press \( \times \).
Using Windows
To cancel a scan job started in the Lexmark Productivity Studio, click Stop on the computer screen.

Using Macintosh
To cancel a scan job started in the Lexmark All-in-One Center, click Cancel on the computer screen.
Making copies

1. Load paper.
2. Load an original document faceup into the Automatic Document Feeder (ADF) or facedown on the scanner glass.
   
   **Notes:**
   
   - Do *not* load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
   - Adjust the paper guide on the ADF tray to the width of the original document.
   - When using the scanner glass, close the top cover to avoid dark edges on the scanned image.

3. From the printer control panel, press 📢.
4. Press the arrow buttons to select the number of copies, and then press **Color** or **Black** to set a color or black-and-white copy.
5. Press 📌.

Copying photos

1. Load photo paper with the glossy or printable side facing you. (If you are not sure which side is the printable side, then see the instructions that came with the paper.)
2. Place a photo facedown on the scanner glass.
3. From the printer control panel, press 📢.
4. Press ✅ until **Photo Reprint** appears.
5. Press the arrow buttons until **Yes** appears, and then press ✅.
6. Press the arrow buttons until the desired paper size appears. If your desired paper size is not on the list, select **Other**. Additional paper size options appear on the display.
   
   Press ✅ when you make a selection.
7. Press 📌.

   **Note:** Make sure you loaded a photo paper into the printer.

   **Note:** To prevent smudging or scratching, avoid touching the printed surface with your fingers or sharp objects. For best results, remove each printed sheet individually from the paper exit tray, and allow the prints to dry at least 24 hours before stacking, displaying, or storing.

Enlarging or reducing images

1. Load paper.
2. Load an original document facedown on the scanner glass.
3 From the printer control panel, press 

4 Press OK until Resize appears.

5 Press the arrow buttons until the setting that you want appears.

   Notes:
   • If you select Custom Resize, press OK to enter the next menu, and then press the arrow buttons until the setting that you want appears. Press OK to save the setting that you selected.
   • If you select Borderless, then the printer will reduce or enlarge the document or photo as necessary to print a borderless copy on the paper size that you selected. For best results with this resize setting, use photo paper and set the paper type selection to Photo, or let the printer automatically detect the paper type.

6 Press OK.

Note: After the copy job is finished, press X to reset the settings to the default. The resize setting also switches to 100% after two minutes of printer inactivity.

### Adjusting copy quality

1 Load paper.

2 Load an original document faceup into the Automatic Document Feeder (ADF) or facedown on the scanner glass.

   Notes:
   • Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
   • Adjust the paper guide on the ADF tray to the width of the original document.
   • When using the scanner glass, close the top cover to avoid dark edges on the scanned image.

3 From the printer control panel, press 

4 Press OK until Quality appears.

5 Press the arrow buttons to set the copy quality to Automatic, Draft, Normal, or Photo, and then press OK to save your setting.

6 Press OK.

### Making a copy lighter or darker

1 Load paper.

2 Load an original document faceup into the Automatic Document Feeder (ADF) or facedown on the scanner glass.

   Notes:
   • Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
   • Adjust the paper guide on the ADF tray to the width of the original document.
   • When using the scanner glass, close the top cover to avoid dark edges on the scanned image.

3 From the printer control panel, press .
4 Press OK until Lighter/Darker appears.

5 Press the arrow buttons to adjust the slider, and then press OK to save your setting.

**Note:** Pressing the left arrow button makes the copy lighter, and pressing the right arrow button makes the copy darker.

6 Press .

**Collating copies using the printer control panel**

If you print multiple copies of a document, then you can choose to print each copy as a set (collated) or to print the copies as groups of pages (not collated).

<table>
<thead>
<tr>
<th>Collated</th>
<th>Not collated</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 2 1 3 2 1</td>
<td>1 1 2 2 3 3</td>
</tr>
</tbody>
</table>

1 Load paper.

2 Load an original document faceup into the Automatic Document Feeder (ADF) or facedown on the scanner glass.

**Notes:**

- Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
- Adjust the paper guide on the ADF tray to the width of the original document.
- When using the scanner glass, close the top cover to avoid dark edges on the scanned image.

3 From the printer control panel, press .

4 Press the arrow buttons to select the number of copies, and then press OK.

5 Press OK until Collate appears.

6 Press the arrow buttons until On appears.

7 Press to save the image of the page to the printer memory.

8 When prompted if you want to scan another page, press OK.

9 Load the next page of the original document facedown on the scanner glass, and then press OK.

10 Repeat steps 8 and 9 until all the pages that you want to copy have been saved to the printer memory.

11 When prompted if you want to scan another page, press the arrow buttons until No appears, and then press OK to start printing the copies.
Repeating an image on one page

You can print the same page image multiple times on one sheet of paper. This option is helpful when creating labels, decals, flyers, handouts, and so on.

1. Load paper.
2. Load an original document faceup into the Automatic Document Feeder (ADF) or facedown on the scanner glass.

   Notes:
   - Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
   - Adjust the paper guide on the ADF tray to the width of the original document.
   - When using the scanner glass, close the top cover to avoid dark edges on the scanned image.

3. From the printer control panel, press \(\text{COPY}\.\)
4. Press \(\text{OK}\) until \(\text{Copies per Sheet}\) appears.
5. Press the arrow buttons to choose the number of times that an image is repeated on a page: once, four times, nine times, or 16 times.
6. Press \(\text{OK}\).

Copying multiple pages on one sheet (N-Up)

The N-Up setting lets you copy multiple pages on one sheet by printing smaller images of each page. For example, you can condense a 20-page document into five pages if you use the N-Up setting to print four page images per sheet.

1. Load paper.
2. Load an original document faceup into the Automatic Document Feeder (ADF) or facedown on the scanner glass.

   Notes:
   - Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
   - Adjust the paper guide on the ADF tray to the width of the original document.
   - When using the scanner glass, close the top cover to avoid dark edges on the scanned image.

3. From the printer control panel, press \(\text{COPY}\.\)
4. Press \(\text{OK}\) until \(\text{Pages per Sheet}\) appears.
5. Press the arrow buttons to choose the number of pages that you want to copy on a sheet of paper. You may choose to copy one, two, or four page images on a sheet.

   Note: If you are copying four pages in landscape format, scan pages 3 and 4 first, and then scan pages 1 and 2.
6. Press \(\text{OK}\) to save the image of the page to the printer memory.
7. When prompted if you want to scan another page, press \(\text{OK}\) to choose \(\text{Yes}\).
8. Load the next page of the original document facedown on the scanner glass, and then press \(\text{OK}\).
9 Repeat steps 7 and 8 until all the pages that you want to copy have been saved to the printer memory.

10 When asked if you want to scan another page, press the arrow buttons until No appears, and then press OK to start printing.

**Canceling a copy job**

1 Press X.
   Scanning stops and the scanner bar returns to its home position.

2 Press ꚺ to turn off the printer.
Faxing

CAUTION—SHOCK HAZARD: Do not use the fax feature during a lightning storm. Do not set up this product or make any electrical or cabling connections, such as the power supply cord or telephone, during a lightning storm.

Sending a fax

Sending a fax using the printer control panel

1. Make sure the printer is on and is connected to a working phone line.

2. Load an original document faceup into the Automatic Document Feeder (ADF) or facedown on the scanner glass.

   Notes:
   - Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
   - Adjust the paper guide on the ADF tray to the width of the original document.
   - When using the scanner glass, close the top cover to avoid dark edges on the scanned image.

3. From the printer control panel, press 📞.

4. Enter a fax number, or press Address Book to select a number from the Speed Dial or Group Dial list.

   Notes:
   - You can include a calling card number as part of the fax number.
   - A fax number can include up to 64 numbers, commas, periods, and/or the symbols * or #.

5. If you want to send a fax to a group of numbers (broadcast fax):
   a. Press ☑️, and then press the arrow buttons until Yes appears.
   b. Repeat steps 4 through 5a until a maximum of 30 fax numbers have been entered.

6. Press Color or Black to select a color or black-and-white fax.

7. Press ✅ to start the fax job.

   Note: If you entered multiple numbers and you are using the scanner glass to scan the pages, the message Scan another page? appears after each page is scanned to prompt you to load another page on the scanner glass.

Sending a fax while listening to a call (On Hook Dial)

The manual dialing feature lets you dial a telephone number while listening to the call through a speaker on the printer. It is useful when you must navigate an automated answering system or enter a calling card number before sending your fax.

1. Make sure the printer is on and is connected to a working telephone line.

2. Load an original document faceup into the Automatic Document Feeder (ADF) or facedown on the scanner glass.
Notes:

- Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
- Adjust the paper guide on the ADF tray to the width of the original document.
- When using the scanner glass, close the top cover to avoid dark edges on the scanned image.

3 From the printer control panel, press Dialtone.
You can now hear the dial tone of the telephone line.

Note: The Dialtone button will be active only when the fax modem is idle, or when the printer is not sending or receiving a fax.

4 Press the keypad numbers to navigate through an automated answering system.

5 Enter a fax number.

Notes:
- You can include a calling card number as part of the fax number.
- A fax number can include up to 64 numbers, commas, periods, and/or the symbols * or #.
- Only one fax number can be entered for On Hook Dial.

6 Press .

Sending a broadcast fax at a scheduled time
You can send a fax to a combination of up to 30 people or groups at a time you choose.

1 Make sure the printer is on and is connected to a working telephone line.

2 Load an original document faceup into the Automatic Document Feeder (ADF) or facedown on the scanner glass.

Notes:
- Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings) into the ADF. Place these items on the scanner glass.
- Adjust the paper guide on the ADF tray to the width of the original document.
- When using the scanner glass, close the top cover to avoid dark edges on the scanned image.

3 From the printer control panel, press .

4 Press OK until Schedule Fax appears.

5 Press the arrow buttons until Send Later appears, and then press OK.

6 Enter the time you want to send the fax, and then press OK to save the time.

7 If the printer is not set to the 24-hour mode, press the arrow buttons to select AM or PM, and then press OK.

8 Select a recipient:
- If the recipient is listed in the Address Book, press Address Book, and then use the arrow buttons to scroll through the numbers in the Speed Dial or Group Dial list.
- If the recipient is not listed in the Address Book, press until Fax to appears, and then enter the number of the recipient.
9 If necessary, repeat step 8 and then press \( \text{OK} \) until a maximum of 30 fax numbers have been entered.

10 Press \( \text{Start} \) to start scanning the document.

**Note:** At the designated time, the fax numbers are dialed and the fax is sent to all of the designated fax numbers. If the fax transmission is unsuccessful to any of the numbers on the broadcast list, then the unsuccessful numbers will be dialed again.

## Receiving a fax

### Receiving a fax automatically

1 Make sure the printer is on and is connected to a working phone line.

2 Make sure that Auto Answer is on.

   To check if Auto Answer is on:
   a From the printer control panel, press \( \text{Menu} \).
   b Press the arrow buttons until Fax Setup appears, and then press \( \text{OK} \).
   c Press the arrow buttons until Ringing and Answering appears, and then press \( \text{OK} \).
   d Press \( \text{OK} \) again.
   Check to see if Auto Answer is set to On.
   e If Auto Answer is not set to on, press the arrow buttons until On appears, and then press \( \text{OK} \) to save the setting.

3 Set the number of times the telephone rings before the printer automatically receives faxes:
   a Press the arrow buttons until Pick-up On appears, and then press \( \text{OK} \).
   b Press the arrow buttons until the setting that you want appears, and then press \( \text{OK} \) to save the setting.

   When the number of rings you set is detected, the printer automatically receives the incoming fax.

### Receiving a fax manually

1 Make sure the printer is on and is connected to a working telephone line.

2 Make sure that Auto Answer is off.

3 To receive the fax, press \( \text{Start} \) or press \( * 9 * \) on the telephone after you answer it and hear fax tones.

4 Hang up the telephone.

   The printer receives the fax.

### Receiving a fax with an answering machine

1 Make sure that Auto Answer is on.

2 Make sure you have set the number of times the telephone rings before receiving a fax automatically.

   When a telephone ring is detected, the answering machine picks up the call.
   • If the printer detects a fax, it receives the fax and disconnects the answering machine.
   • If the printer does not detect a fax, the answering machine receives the call.
3 Set the answering machine to answer incoming calls before the printer does. For example, if you set the answering machine to answer calls after three rings, set the printer to answer calls after five rings.

**Forwarding faxes**

Use the fax-forwarding feature if you are going to be away, but still want to receive your faxes. There are three fax-forwarding values or settings:

- **Off**—(Default)
- **Forward**—The printer sends the fax to the designated fax number.
- **Print & Forward**—The printer prints the fax and then sends it to the designated fax number.

1 Make sure the printer is on and is connected to a working telephone line.
2 Press the arrow buttons until **Fax Setup** appears, and then press **OK**.
3 Press the arrow buttons until **Ringing and Answering** appears, and then press **OK**.
4 Press the arrow buttons until **Fax Forward** appears, and then press **OK**.
5 Press the arrow buttons until **Forward** or **Print & Forward** appears, and then press **OK**.
6 Enter the number to which you want to forward the fax, and then press **OK**.

**Customizing dial settings**

**Setting up the Address Book**

1 From the printer control panel, press the button.
2 Press the arrow buttons until **Fax Setup** appears, and then press **OK**.
3 Press **OK** again.
4 To add a fax number to your Address Book:
   a Press the arrow buttons until **Add** appears, and then press **OK**.
   b Press **OK** again.
   c Use the keypad to enter the fax number in the Enter Number field, and then press **OK**.
   d Use the keypad to enter the name of the person associated with the fax number in the Enter Name field, and then press **OK** to save the entry.
   e Repeat steps b through d to add additional entries as needed. You can enter up to 89 fax numbers.
5 To add a fax group:
   a Press **OK**.
   b Using the keypad, enter any number from 90 to 99, and then press **OK**.
   c Enter a fax number in the Enter Number field, and then press **OK**.
   d Press **OK**.
Repeat steps c through d as necessary. You can enter up to 30 fax numbers for the group.

If you do not want to add another fax number, press the arrow buttons until **No** appears, and then press **OK**.

Enter the group name in the **Enter name** field, and then press **OK** to save the entry.

**Notes:**
- You can include a calling card number as part of the fax number.
- A fax number can include up to 64 numbers, commas, periods, spaces, and/or these symbols: * # + - ()

**Setting up a dialing prefix**

You can add a prefix to the beginning of each number dialed. The prefix can include up to eight numbers, commas, periods, and/or these symbols: * # + - ()

1. From the printer control panel, press **fax**.
2. Press the arrow buttons until **Fax Setup** appears, and then press **OK**.
3. Press the arrow buttons until **Ringing and Answering** appears, and then press **OK**.
4. Press the arrow buttons until **Manual Pickup Code** appears, and then press **OK**.
5. Enter the prefix to be dialed before each telephone number, and then press **OK** to save the setting.

**Setting up Caller ID**

**Caller ID** is a service provided by some telephone companies that identifies the telephone number (and possibly the name) of the person who is calling. If you subscribe to this service, it works with the printer. When you receive a fax, the telephone number of the person who is sending you the fax appears on the display.

The printer supports two distinct Caller ID patterns: Pattern 1 (FSK) and Pattern 2 (DTMF). Depending on the country or region you live in and the telecommunications company you subscribe to, you may need to switch the pattern to display Caller ID information.

**Note:** Caller ID is available in only certain countries and regions.

1. From the printer control panel, press **fax**.
2. Press the arrow buttons until **Fax Setup** appears, and then press **OK**.
3. Press the arrow buttons until **Ringing and Answering** appears, and then press **OK**.
4. Press the arrow buttons until **Caller ID Pattern** appears, and then press **OK**.
5. Press the arrow buttons until the setting that you want appears, and then press **OK** to save the setting.

**Setting the distinctive ring**

Distinctive ring is a service provided by some telephone companies that assigns multiple phone numbers to a single telephone line. If you subscribe to this service, you can program your printer to have a distinctive ring pattern and phone number for incoming faxes.

1. From the printer control panel, press **fax**.
2. Press the arrow buttons until **Fax Setup** appears, and then press **OK**.
3. Press the arrow buttons until **Ringing and Answering** appears, and then press **OK**.
4 Press the arrow buttons until **Ring Pattern** appears, and then press **OK**.
5 Press the arrow buttons until the ring pattern that you want appears, and then press **OK**.

**Setting a fax manual answer code**

1 From the printer control panel, press 
2 Press the arrow buttons until **Fax Setup** appears, and then press **OK**.
3 Press the arrow buttons until **Ringing and Answering** appears, and then press **OK**.
4 Press the arrow buttons until **Manual Pickup Code** appears.
5 Enter the code you want to use.
   **Note:** The code can include up to seven numbers, commas, periods, and/or these symbols: * # + - ()
6 Press **OK** to save the setting.

**Setting up to fax while behind a PBX**

If the printer is being used in a business or office, it may be connected to a Private Branch Exchange (PBX) telephone system. Ordinarily, when dialing a fax number, the printer waits to recognize the dial tone and then dials the fax number. However, this method of dialing may not work if the PBX telephone system uses a dial tone that is not recognizable to most fax machines. The "Behind PBX (Dial Tone Detect Off)” feature enables the printer to dial the fax number without waiting to recognize the dial tone.

1 From the printer control panel, press 
2 Press the arrow buttons until **Fax Setup** appears, and then press **OK**.
3 Press the arrow buttons until **Dialing and Sending** appears, and then press **OK**.
4 Press the arrow buttons until **Dial Method** appears, and then press **OK**.
5 Press the arrow buttons until **Behind PBX** appears, and then press **OK** to save the setting.

**Managing faxes**

**Setting up a fax footer**

1 From the printer control panel, press 
2 Press the arrow buttons until **Fax Setup** appears, and then press **OK**.
3 Press the arrow buttons until **Fax Printing** appears, and then press **OK**.
4 Press the arrow buttons until **Fax Footer** appears, and then press **OK**.
5 Press the arrow buttons until **On** appears, and then press **OK** to save the setting.
6 During the initial setup of your printer, you were prompted to enter the date and time. If you have not entered this information:
   a Press twice.
   b Press the arrow buttons until **Device Setup** appears, and then press **OK**.
Press the arrow buttons until **Date/Time** appears, and then press **OK**.

Enter the date using the keypad, and then press **OK**.

Enter the time using the keypad, and then press **OK**.

If the hour you entered is 12 or less, press the arrow buttons until **AM**, **PM**, or **24hr** appears, and then press **OK** to save the setting.

**Printing fax activity reports**

You can print reports of faxes sent and/or received.

1. From the printer control panel, press ✉️.
2. Press the arrow buttons until **Fax Setup** appears, and then press **OK**.
3. Press the arrow buttons until **Reports** appears, and then press **OK**.
4. To set when to print fax activity reports:
   a. Press **OK** again.
   b. Press the arrow buttons to choose whether to print the fax activity reports after 40 faxes or on request only.
5. To print fax activity reports, press the arrow buttons until **Print Reports** appears, and then press **OK**.
   - To print sent fax history only, press the arrow buttons until **Send Log** appears, and then press **OK**.
   - To print received fax history only, press the arrow button until **Receive Log** is highlighted, and then press **OK**.

**Printing the Fax Settings List**

1. From the printer control panel, press ✉️.
2. Press the arrow buttons until **Fax Setup** appears, and then press **OK**.
3. Press the arrow buttons until **Reports** appears, and then press **OK**.
4. Press the arrow buttons until **Print Reports** appears, and then press **OK**.
5. Press the up or down arrow button until **Settings List** is highlighted, and then press **OK**.
   The user default settings list prints, which lists each fax setting in the printer, the value it is set to, and its factory default.

**Blocking junk faxes**

If you have Caller ID, you can block faxes sent from specific numbers and/or all faxes which do not include a Caller ID number.

1. To turn on the Block List feature:
   a. From the printer control panel, press ✉️.
   b. Press the arrow buttons until **Fax Setup** appears, and then press **OK**.
   c. Press the arrow buttons until **Fax Blocking** appears, and then press **OK**.
   d. Press the arrow buttons until **Turn On/Off** appears, and then press **OK**.
   e. Press the arrow buttons until **On** appears, and then press **OK** to save the setting.
To add each fax number you want to block:

a From the printer control panel, press .
b Press the arrow buttons until Fax Setup appears, and then press OK.
c Press the arrow buttons until Fax Blocking appears, and then press OK.
d Press the arrow buttons until Add appears, and then press OK.
e Use the keypad to enter the fax number in the Fax Number field, and then press OK to save.
f Use the keypad to enter the name of the person associated with the fax number in the Name field.
g Repeat steps 2e through 2f until you have added all the numbers you want to block. You can block up to 50 numbers.

To block faxes sent from an unidentified number (a number with no Caller ID):

a From the printer control panel, press .
b Press the arrow buttons until Fax Setup appears, and then press OK.
c Press the arrow buttons until Fax Blocking appears, and then press OK.
d Press the arrow buttons until Block No-ID appears, and then press OK.
e Press the arrow buttons until On appears, and then press OK to save the setting.

If you want to print a list of blocked faxes:

a From the printer control panel, press .
b Press the arrow buttons until Fax Setup appears, and then press OK.
c Press the arrow buttons until Fax Blocking appears, and then press OK.
d Press the arrow buttons until Print appears, and then press OK to print the list.

Note: This feature is available only when there are blocked fax entries.

Blocking unwanted changes to fax settings

This feature blocks network users from changing the fax settings of the printer.

1 From the printer control panel, press .
2 Press the arrow buttons until Device Setup appears, and then press OK.
3 Press the arrow buttons until Host Fax Settings appears, and then press OK.
4 Press the arrow buttons until Block appears, and then press OK to save the setting.
Maintaining the printer

Maintaining print cartridges

Installing print cartridges

1. Open the printer, and then press down on the cartridge carrier levers.

2. Remove the used print cartridge or cartridges.

3. If you are installing new print cartridges, remove the tape from the back and bottom of the color cartridge, insert the cartridge in the right carrier, and then close the color cartridge carrier lid.

Warning—Potential Damage: Do not touch the gold contact area on the back or the metal nozzles on the bottom of the cartridge.
4 If a black cartridge is included in the box contents, remove the tape from the back and bottom of the black cartridge, insert the cartridge in the left carrier, and then close the black cartridge carrier lid.

![Image showing black cartridge insertion process]

**Warning—Potential Damage:** Do not touch the gold contact area on the back or the metal nozzles on the bottom of the cartridge.

5 Close the printer, making sure to keep your hands out from underneath the scanner unit.

![Image showing printer closure]

**Removing a used print cartridge**

1 Make sure the printer is on.

2 Lift the scanner unit.
The print cartridge carrier moves and stops at the loading position, unless the printer is busy.

3. Press down on the cartridge carrier latch to raise the cartridge carrier lid.

4. Remove the used print cartridge.

Note: If you are removing both cartridges, repeat step 3 and step 4 for the second cartridge.

Refilling print cartridges

The warranty does not cover repair of failures or damage caused by a refilled cartridge. Lexmark does not recommend use of a refilled cartridge. Refilling a cartridge can affect print quality and may cause damage to the printer. For best results, use Lexmark supplies.

Using genuine Lexmark print cartridges

Lexmark printers, print cartridges, and photo paper are designed to perform together for superior print quality.

If you receive an Out of Original Lexmark Ink message, the original Lexmark ink in the indicated cartridge(s) has been depleted.

If you believe you purchased a new, genuine Lexmark print cartridge, but the Out of Original Lexmark Ink message appears:

1. Click Learn More on the message.
2. Click Report a non-Lexmark print cartridge.

To prevent the message from appearing again for the indicated cartridge(s):

- Replace your cartridge(s) with new Lexmark print cartridge(s).
- If you are printing from a computer, click Learn more on the message, select the check box, and then click Close.
If you are using the printer without a computer, press **Cancel**.

Lexmark's warranty does not cover damage caused by non-Lexmark ink or print cartridges.

**Aligning print cartridges**

**Using the printer control panel**

1. Load plain Letter-size paper.
2. From the printer control panel, press †, and then press OK.
3. Press the arrow buttons until **Align Cartridges** appears, and then press OK. An alignment page prints.

**Using Windows**

1. Load plain Letter-size paper.
2. Do one of the following:
   - In Windows Vista, click ☀.
   - In Windows XP and earlier, click **Start**.
3. Click **All Programs** or **Programs**, and then select the printer program folder from the list.
4. From the printer folder, click **Maintenance → Align Cartridges**.
5. Click **Print**.
6. Follow the instructions on the computer screen.

**Using Macintosh**

1. Load plain Letter-size paper.
2. From the Finder desktop, double-click the printer folder.
3. Double-click the printer utility icon.
4. From the Maintenance tab, click **Print Alignment Page**.
5. Follow the instructions on the computer screen.

If you aligned the cartridges to improve print quality, print your document again. If print quality has not improved, then clean the print cartridge nozzles.

**Cleaning the print cartridge nozzles**

**Using the printer control panel**

1. Load plain Letter-size paper.
2. From the printer control panel, press †, and then press OK.
3 Press the arrow buttons until **Clean Cartridges** appears, and then press OK.
   A page prints, forcing ink through the print cartridge nozzles to clean them.

4 Print the document again to verify that the print quality has improved.

**Using Windows**

1 Load plain Letter-size paper.

2 Do one of the following:
   - In Windows Vista, click 📚.
   - In Windows XP and earlier, click **Start**.

3 Click **All Programs** or **Programs**, and then select the printer program folder from the list.

4 From the printer folder, click **Maintenance → Clean Cartridges**.

5 Click **Print**.
   A page prints, forcing ink through the print cartridge nozzles to clean them.

6 Print the document again to verify that the print quality has improved.

**Using Macintosh**

1 Load plain Letter-size paper.

2 From the Finder desktop, double click the printer folder.

3 Double-click the printer utility icon.

4 From the Maintenance tab, click **Clean Print Nozzles**.
   A page prints, forcing ink through the print cartridge nozzles to clean them.

5 Print the document again to verify that the print quality has improved.

If print quality has not improved, then try cleaning the nozzles up to two more times, or wipe the print cartridge nozzles and contacts.

**Checking ink levels**

**Using the printer control panel**

1 From the printer control panel, press ⌂, and then press OK.

2 Press OK again.

3 Press the arrow buttons until **Color Ink** appears, and then press OK.
   Check the ink level of the color cartridge. Install a new cartridge if necessary.

4 Press ⌂.

5 If a black cartridge is included in the box contents, and if you have installed a black cartridge in the printer, then press the arrow buttons until **Black Ink** appears, and then press OK.
   Check the ink level of the black cartridge. Install a new cartridge if necessary.

6 Press ⌂ until you exit Setup, or press another mode button.
Using Windows

Use the Lexmark Service Center to check the ink levels of the cartridges.

1  Do one of the following:
   • In Windows Vista, click 🌍.
   • In Windows XP and earlier, click Start.

2  Click All Programs or Programs, and then select the printer program folder from the list.

3  Select Lexmark Service Center.

4  Check the ink levels of the cartridges on the Printer Maintenance page.
   Install a new cartridge if necessary.

Using Macintosh

1  From the Finder desktop, double click the printer folder.

2  Double-click the printer utility icon.
   The Lexmark Printer Utility appears.

3  If an exclamation point (!) appears on a print cartridge, then the ink level is low. Install a new cartridge if necessary.

Wiping the print cartridge nozzles and contacts

1  Remove the print cartridge(s).

2  Dampen a clean, lint-free cloth with water, and then place the cloth on a flat surface.

3  Gently hold the nozzles against the cloth for about three seconds, and then wipe in the direction shown.
4 Using another clean section of the cloth, gently hold the cloth against the contacts for about three seconds, and then wipe in the direction shown.

5 With another clean section of the cloth, repeat step 3 and step 4, and then let the nozzles and contacts dry completely.

6 Reinsert the print cartridge(s), and then print the document again.

7 If the print quality does not improve, clean the print nozzles, and then try printing the document again.

8 Repeat step 7 up to two more times.

9 If print quality is still not satisfactory, replace the print cartridge(s).

Preserving the print cartridges

- Keep new cartridges in their packaging until you are ready to install them.
- Do not remove a cartridge from the printer except to replace, clean, or store it in an airtight container. The cartridges do not print correctly if left exposed for an extended period of time.

Cleaning the scanner glass

1 Dampen a clean, lint-free cloth with water.

2 Gently wipe the scanner glass clean.

Note: Make sure all ink or corrective fluid on a document is dry before placing the document on the scanner glass.

Cleaning the exterior of the printer

1 Make sure that the printer is turned off and unplugged from the wall outlet.

   CAUTION—SHOCK HAZARD: To avoid the risk of electric shock, unplug the power cord from the wall outlet and disconnect all cables to the printer before proceeding.

2 Remove paper from the paper support and paper exit tray.
3 Dampen a clean, lint-free cloth with water.

**Warning—Potential Damage:** Do not use household cleaners or detergents, as they may damage the finish of the printer.

4 Wipe only the outside of the printer, making sure to remove any ink residue that has accumulated on the paper exit tray.

**Warning—Potential Damage:** Using a damp cloth to clean the interior may cause damage to your printer.

5 Make sure the paper support and paper exit tray are dry before beginning a new print job.

## Ordering supplies

### Ordering print cartridges

Lexmark 5600-6600 Series models (except Lexmark 5690 and Lexmark 6690)

<table>
<thead>
<tr>
<th>Item</th>
<th>Part number</th>
<th>Average cartridge standard page yield is up to¹</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black cartridge</td>
<td>36A</td>
<td></td>
</tr>
<tr>
<td>Black cartridge²</td>
<td>36</td>
<td></td>
</tr>
<tr>
<td>High yield black cartridge</td>
<td>36XLA</td>
<td></td>
</tr>
<tr>
<td>High yield black cartridge²</td>
<td>36XL</td>
<td></td>
</tr>
<tr>
<td>Color cartridge</td>
<td>37A</td>
<td></td>
</tr>
<tr>
<td>Color cartridge²</td>
<td>37</td>
<td></td>
</tr>
<tr>
<td>High yield color cartridge</td>
<td>37XLA</td>
<td></td>
</tr>
<tr>
<td>High yield color cartridge²</td>
<td>37XL</td>
<td></td>
</tr>
<tr>
<td>Photo cartridge</td>
<td>31</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

¹ Values obtained by continuous printing. Declared yield value in accordance with ISO/IEC 24711.
² Licensed Return Program Cartridge

Page yield values available at www.lexmark.com/pageyields.

Lexmark 5690 and Lexmark 6690 models

<table>
<thead>
<tr>
<th>Item</th>
<th>Part number</th>
<th>Average cartridge standard page yield is up to¹</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black cartridge</td>
<td>4A</td>
<td></td>
</tr>
<tr>
<td>Black cartridge²</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>Color cartridge</td>
<td>5A</td>
<td></td>
</tr>
<tr>
<td>Color Cartridge²</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Photo cartridge</td>
<td>31</td>
<td>Not applicable</td>
</tr>
</tbody>
</table>

¹ Values obtained by continuous printing. Declared yield value in accordance with ISO/IEC 24711.
² Licensed Return Program Cartridge

Page yield values available at www.lexmark.com/pageyields.
Ordering paper and other supplies

To purchase supplies or to locate a dealer near you, visit our Web site at www.lexmark.com.

For best results when printing photos or other high-quality images, use Lexmark Photo Paper or Lexmark PerfectFinish Photo Paper and Lexmark print cartridges.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lexmark Photo Paper</td>
<td>• Letter</td>
</tr>
<tr>
<td></td>
<td>• A4</td>
</tr>
<tr>
<td></td>
<td>• 4 x 6 in.</td>
</tr>
<tr>
<td></td>
<td>• 10 x 15 cm</td>
</tr>
<tr>
<td>Lexmark PerfectFinish Photo Paper</td>
<td>• Letter</td>
</tr>
<tr>
<td></td>
<td>• A4</td>
</tr>
<tr>
<td></td>
<td>• 4 x 6 in.</td>
</tr>
<tr>
<td></td>
<td>• 10 x 15 cm</td>
</tr>
<tr>
<td></td>
<td>• L</td>
</tr>
<tr>
<td>USB cable</td>
<td>Part number 1021294</td>
</tr>
</tbody>
</table>

Resetting to factory settings

Resetting all settings

You can reset your printer to the original settings without using the printer menus.

**Note:** Resetting to factory default settings will delete all the printer settings you have previously selected.

1. Turn off the printer.

   **Note:** Make sure the printer is not in Power Saver mode. Press and hold the power button for 2 seconds to turn off the printer. If you have set the Power Saver timeout in the Setup menu, press and hold the power button according to the time you set in the menu.

2. From the printer control panel, press and hold the power button and \(\times\), and then press the power button to turn the printer on.

Resetting menu settings

1. From the printer control panel, press the menu button.

2. Press the arrow buttons until Defaults appears, and then press the OK button.

3. Press the arrow buttons until Set Defaults appears, and then press the OK button.

4. Press the arrow buttons until Use Factory appears, and then press the OK button.

5. Press the arrow buttons to select a language, and then press the OK button.

6. Press the arrow buttons to select a country or region, and then press the OK button.

7. Use the keypad to enter the month, day, and year, and then press the OK button.

Maintaining the printer

119
8 Enter the time, and then press \textit{OK}.

9 Enter a fax number and fax name, and then press \textit{OK}.

\textit{Initial Setup Complete} appears on the display.
Troubleshooting

Using the printer troubleshooting software (Windows only)

The Lexmark Service Center provides step-by-step troubleshooting help and contains links to printer maintenance tasks and customer support.

To open the Lexmark Service Center, use one of these methods:

<table>
<thead>
<tr>
<th>Method 1</th>
<th>Method 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>If it appears on an error message dialog, click the For additional assistance, use the Lexmark Service Center link.</td>
<td>1  Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• In Windows Vista, click 📧.</td>
</tr>
<tr>
<td></td>
<td>• In Windows XP and earlier, click Start.</td>
</tr>
<tr>
<td></td>
<td>2  Click All Programs or Programs, and then select the printer program folder from the list.</td>
</tr>
<tr>
<td></td>
<td>3  Select Lexmark Service Center.</td>
</tr>
</tbody>
</table>

Setup troubleshooting

Incorrect language appears on the display

These are possible solutions. Try one of the following:

**CHANGE THE LANGUAGE SELECTION DURING INITIAL SETUP**

During initial setup, and every time you reset the printer to factory default settings, you will be asked to select a language.

To select a language, press the arrow buttons until the language that you want appears on the display, and then press OK.

**SELECT A DIFFERENT LANGUAGE AFTER INITIAL SETUP**

In case the wrong language was set during initial setup, you can still change the language settings of the printer.

1  From the printer control panel, press 🔄.

2  Press the right arrow button, and then press OK.

3  Press OK again.

4  Press the arrow buttons until the language that you want appears on the display, and then press OK.

5  If you are sure, press the right arrow button, and then press OK to change the language.
Power button is not lit

These are possible solutions. Try one or more of the following:

PRESS POWER BUTTON

Make sure the printer is on by pressing .

DISCONNECT AND RECONNECT THE POWER CORD

1 Disconnect the power cord from the wall outlet, and then from the printer.
2 Plug the cord all the way into the power supply on the printer.
3 Plug the cord into an electrical outlet that other electrical devices have been using.
4 If the light is not on, press .

Software did not install

If you encountered problems while installing, or if your printer does not appear in the list in the Printers folder or as a printer option when sending a print job, you can try uninstalling and reinstalling the software.

These are some other possible solutions. Try one or more of the following:

MAKE SURE YOUR OPERATING SYSTEM IS SUPPORTED

The following operating systems are supported: Windows Vista, Windows XP, Windows 2000 with Service Pack 3 or later, and Mac OS X versions 10.5, 10.4 and 10.3.

CHECK THAT YOUR COMPUTER MEETS THE MINIMUM SYSTEM REQUIREMENTS LISTED ON THE PRINTER BOX

CHECK THE USB CONNECTION

1 Check the USB cable for any obvious damage. If the cable is damaged, use a new one.
2 Firmly plug the square end of the USB cable into the back of the printer.
3 Firmly plug the rectangular end of the USB cable into the USB port of the computer.
   The USB port is marked with the USB symbol.
**RECONNECT THE POWER SUPPLY**

1. Press \( \bigcirc \) to turn the printer off.
2. Disconnect the power cord from the wall outlet.
3. Gently remove the power supply from the printer.
4. Reconnect the power supply to the printer.
5. Plug the power cord into the wall outlet.
6. Press \( \bigcirc \) to turn the printer on.

**TEMPORARILY DISABLE SECURITY PROGRAMS IN WINDOWS**

1. Close all open programs.
2. Disable any security programs.
3. Do one of the following:
   - In Windows Vista, click 🌐.
   - In Windows XP and earlier, click **Start**.
4. Click **Computer** or **My Computer**.
5. Double-click the CD or DVD drive icon.
6. If necessary, double-click **setup.exe**.
7. Follow the instructions on the computer screen to install the software.
8. When the installation is completed, enable the security software again.

**Page does not print**

These are possible solutions. Try one or more of the following:

**CHECK MESSAGES**

If an error message appears, then resolve the error before trying to print again.

**CHECK POWER**

If the \( \bigcirc \) light is not on, then make sure that the power cord is properly connected to the printer and plugged into a known working electrical outlet that other electrical devices have been using.

**REMOVE AND THEN RELOAD PAPER**

**CHECK INK**

Check the ink levels, and then install new print cartridges if necessary.
CHECK CARTRIDGES

1 Remove the print cartridges.
2 Make sure the sticker and tape have been removed.
3 Reinsert the cartridges.

CHECK PRINTER DEFAULT AND PAUSE SETTINGS

Using Windows

1 Do one of the following:

   In Windows Vista
   a Click 🌐.
   b Click Control Panel.
   c Under Hardware and Sound, click Printer.

   In Windows XP
   a Click Start.
   b Click Printers and Faxes.

   In Windows 2000
   a Click Start.
   b Click Settings → Printers.

2 Double-click the printer.
3 Click Printer.
   • Make sure no check mark appears next to Pause Printing.
   • If a check mark does not appear next to Set As Default Printer, then you must select the printer for each file that you want to print.
Using Macintosh

For Mac OS X version 10.5

1  From the Finder desktop, click  → System Preferences → Print & Fax.
2  From the Default Printer pop-up menu, check if the printer is the default printer.
   If the printer is not the default printer, then you must select the printer for each file that you want to print.
   If you want to set the printer as the default printer, then select the printer from the Default Printer pop-up menu.
3  Click Open Print Queue.
   The print queue dialog appears.
   Make sure that the print job is not on hold. If the print job is on hold:
   •  If you want to resume a particular print job, choose the document name, and then click Resume.
   •  If you want to resume all print jobs in the queue, then click Resume Printer.

For Mac OS X version 10.4 and earlier

1  From the Finder desktop, click Go → Utilities → Print Center or Printer Setup Utility.
   The Printer List dialog appears.
2  Double-click the printer.
   The print queue dialog appears.
   •  Make sure that the print job is not on hold.
      If the print job is on hold:
      –  If you want to resume a particular print job, choose the document name, and then click Resume.
      –  If you want to resume all print jobs in the queue, then click Start Jobs.
      •  If the printer is not in bold, then it is not the default printer. You must select the printer for each file that you want to print.
      If you want to set the printer as the default printer:
      a  Go back to the Printer List dialog, and then select the printer.
      b  Click Make Default.

DISCONNECT AND RECONNECT POWER SUPPLY

1  Press ⌧ to turn off the printer.
2  Disconnect the power cord from the wall outlet.
3  Remove the power supply from the printer.
4  Reconnect the power supply to the printer.
5  Plug the power cord into the wall outlet.
6  Press ⌧ to turn on the printer.

Troubleshooting
REMOVE AND REINSTALL THE SOFTWARE

If you encountered problems while installing, or if your printer does not appear in the printers folder or as a printer option when sending a print job, then try uninstalling and reinstalling the software.

Solving printer power problems

The printer and the computer cannot exchange data.

These are possible solutions. Try one or more of the following:

MAKE SURE THE PRINTER POWER SUPPLY IS ATTACHED CORRECTLY

1. Press \( \bigcirc \) to turn the printer off.
2. Disconnect the power cord from the wall outlet.
3. Remove the power supply from the printer.
4. Reconnect the power supply to the printer.
5. Plug the power cord into the wall outlet.
6. Press \( \bigcirc \) to turn the printer on.

MAKE SURE THE PRINTER IS NOT IN SLEEP MODE

If the power light is blinking on and off slowly, then the printer is in sleep mode.

1. Unplug the power cord from the wall outlet.
2. Wait ten seconds, and then insert the power cord into the wall outlet.
3. Press \( \bigcirc \) to turn the printer on.

Removing and reinstalling the software

If the printer is not functioning properly, or if a communications error message appears when you try to use the printer, then you may need to remove and reinstall the printer software.

Using Windows

1. Do one of the following:
   - In Windows Vista, click \( \bigcirc \).
   - In Windows XP and earlier, click Start.
2. Click All Programs or Programs, and then select the printer program folder from the list.
3. Select Uninstall.
4. Follow the instructions on the computer screen to remove the printer software.
5. Restart the computer before reinstalling the printer software.
6. Click Cancel on all New Hardware Found screens.
7. Insert the installation CD, and then follow the instructions on the computer screen to reinstall the software.
   If the install screen does not appear automatically after you restart your computer, do one of the following:
In Windows Vista
  a  Click 🌐.
  b  In the Start Search box, type `D:\setup.exe`, where `D` is the letter of your CD or DVD drive.

In Windows XP and earlier
  a  Click Start.
  b  Click Run.
  c  Type `D:\setup.exe`, where `D` is the letter of your CD or DVD drive.

Using Macintosh
  1  Close all open software applications.
  2  From the Finder desktop, double-click the printer folder.
  3  Double-click the Uninstaller icon.
  4  Follow the instructions on the computer screen to remove the printer software.
  5  Restart the computer before reinstalling the printer software.
  6  Insert the installation CD, and then follow the instructions on the computer screen to reinstall the software.

If the software still does not install correctly, visit our Web site at www.lexmark.com to check for the latest software.
  1  In all countries or regions except the United States, select your country or region.
  2  Click the links for drivers or downloads.
  3  Select your printer family.
  4  Select your printer model.
  5  Select your operating system.
  6  Select the file that you want to download, and then follow the instructions on the computer screen.

Enabling the USB port in Windows
To confirm that the USB port is enabled on the computer:
  1  Do one of the following:

In Windows Vista
  a  Click 🌐 → Control Panel.
  b  Click System and Maintenance → System.
  c  Click Device Manager.

In Windows XP
  a  Click Start.
  b  Click Control Panel → Performance and Maintenance → System.
  c  From the Hardware tab, click Device Manager.
In Windows 2000

a Click Start.
b Click Settings → Control Panel → System.
c From the Hardware tab, click Device Manager.

2 Click the plus sign (+) beside Universal Serial Bus Controller.

If USB Host Controller and USB Root Hub are listed, then the USB port is enabled.

For more information, see the computer documentation.

Wireless troubleshooting

Wireless troubleshooting checklist

Before beginning to troubleshoot the wireless printer, verify the following:

• The power supply is connected to the printer, and ✗ is on.

• Your SSID is correct.
  Print a network setup page to verify the SSID the printer is using.
  If you are not sure if your SSID is correct, run the wireless setup again.

• Your WEP key or WPA passphrase is correct (if your network is secure).
  Log into the wireless access point (wireless router) and check the security settings.
  A security key is like a password. All devices on the same wireless network using WEP, WPA, or WPA2 share the same security key.
  If you are not sure if your security information is correct, run the wireless setup again.

• The wireless network is working properly.
  Try accessing other computers on your wireless network.
  If your network has Internet access, try connecting to the Internet over a wireless connection.

• The printer is within the range of the wireless network.
  For most networks, the printer should be within 100 feet (30 meters) of the wireless access point (wireless router).

• The Wi-Fi indicator light is lit.

• The printer driver is installed on the computer from which you are performing a task.

• The correct printer port is selected.

• The computer and printer are both connected to the same wireless network.

• The printer is located away from obstacles or electronic devices that could interfere with the wireless signal.
  Make sure the printer and wireless access point are not separated by poles, walls, or support columns containing metal or concrete.
  Many devices can interfere with the wireless signal, including baby monitors, motors, cordless phones, security system cameras, other wireless networks, and some Bluetooth devices.
Printing a network setup page

A network setup page lists the configuration settings of the printer, including the IP address and MAC address of the printer. You can print a network setup page only if your printer has an internal wireless print server.

1 Load plain paper.
2 From the printer control panel, press \( \rightarrow \).
3 Press the arrow buttons until Network Setup appears, and then press OK.
   Print Setup Page appears on the display.
4 Press OK.
5 Press OK again.
   The network setup page prints.

Wireless configuration does not continue after the USB cable is attached

Check the USB cable

If the configuration software does not allow you to continue configuring your printer wirelessly after you attach the USB cable, there may be a problem with the cable. Try one or more of the following:

- Make sure that the USB cable is not damaged. If there is any visible damage to the USB cable, try using a new one.
- Attach the cable directly to the computer and the printer. Hubs, switch boxes, and docking stations can sometimes interfere with the USB connection.
- Make sure the USB cable is correctly attached.

1 Attach the large, rectangular connector to any USB port on your computer. USB ports may be on the front or the back of the computer, and may be horizontal or vertical.
2 Attach the small, square connector to the printer.

Why isn't my printer in this list?

When you are attempting to set up a wireless printer on another computer, the printer may not appear in the list of printers available on your network. If this happens, check the following:

MAKE SURE THAT YOUR COMPUTER AND PRINTER ARE CONNECTED TO THE SAME WIRELESS NETWORK

The printer may not be on the same wireless network as the computer. The SSID of the printer must match the SSID of the computer, if the computer is already connected to the wireless network.

1 Obtain the SSID of the network that the computer is connected to.
   a Type the IP address of your wireless access point (wireless router) into the address field of your Web browser.
      If you do not know the IP address of the wireless access point:
         1 Do one of the following:

         In Windows Vista
            a Click 🌐.
            b Click All Programs → Accessories.
            c Click Command Prompt.

         In Windows XP and earlier
            a Click Start.
            b Click All Programs or Programs → Accessories → Command Prompt.

         2 Type ipconfig.
         3 Press Enter.
            • The “Default Gateway” entry is typically the wireless access point.
            • The IP address appears as four sets of numbers separated by periods, such as 192.168.2.134.

   b Type the user name and password of the router when prompted.
   c Click OK.
d On the main page, click **Wireless** or any other selection where settings are stored. The SSID will be displayed.
e Write down the SSID.

**Note:** Make sure you copy it exactly, including any capital letters.

2 Print the printer network setup page.
In the Wireless section, look for **SSID**.

3 Compare the SSID of the computer and SSID of the printer.
If the SSIDs are the same, then the computer and the printer are connected to the same wireless network.
If the SSIDs are not the same, then run the Lexmark Wireless Setup Utility again to set up the printer on the wireless network used by the computer.

**MAKE SURE THAT THE COMPUTER IS NOT CONNECTED TO A VIRTUAL PRIVATE NETWORK (VPN)**

Most Virtual Private Networks allow computers to communicate with only the VPN and no other network at the same time. Disconnect from the VPN before installing the driver on the computer or before running the wireless setup on the computer.

To check if the computer is currently connected to a VPN, open your VPN Client software and check your VPN connections. If you do not have a VPN Client software installed, check the connections manually using the Windows VPN Client.

If you would like to have the ability to connect to your local network and to a VPN at the same time, the system support person for the VPN must enable split tunneling. Be aware that some organizations will not allow split tunneling due to security or technical concerns.

**Cannot print over wireless network**

If you encountered problems while installing, or if your printer does not appear in the printers folder or as a printer option when sending a print job, you can try uninstalling and reinstalling the software.

These are possible solutions. Try one or more of the following:

**MAKE SURE YOUR COMPUTER IS CONNECTED TO YOUR WIRELESS ACCESS POINT (WIRELESS ROUTER)**

- See if you have access to the Internet by opening your Web browser and accessing any site.
- If there are other computers or resources on your wireless network, check to see if you can access them from your computer.

**MOVE THE COMPUTER AND/OR PRINTER CLOSER TO THE WIRELESS ROUTER**

Although the possible distance between devices in 802.11b or 802.11g networks is 300 feet, the maximum range for optimal performance is generally 100–150 feet.

**MOVE YOUR ACCESS POINT TO MINIMIZE INTERFERENCE**

There may be temporary interference from other devices such as microwave ovens or other appliances, cordless phones, baby monitors, and security system cameras. Make sure your access point is not positioned too closely to these devices.
CHECK WHETHER THE PRINTER IS ON THE SAME WIRELESS NETWORK AS THE COMPUTER

Print a network setup page. Refer to the documentation that came with your printer for details on printing a network setup page.

Make sure the SSID the printer is using matches the wireless network SSID. If you are not sure how to find the network SSID, use one of the following:

Using Windows

1. Type the IP address of the wireless access point in the address field of your Web browser.
   
   If you do not know the IP address of the wireless access point:
   
   a. Do one of the following:
      
      In Windows Vista
      
      1. Click .
      
      2. Click All Programs → Accessories.
      
      3. Click Command Prompt.
      
      In Windows XP and earlier
      
      1. Click Start.
      
      2. Click All Programs or Programs → Accessories → Command Prompt.
      
   b. Type ipconfig.
   
   c. Press Enter.
      
      • The “Default Gateway” entry is typically the wireless access point.
      
      • The IP address appears as four sets of numbers separated by periods, such as 192.168.0.100. Your IP address might also start with the numbers 10 or 169. This is determined by your operating system or wireless network software.

2. Type your user name and password for the wireless access point when prompted.

3. Click OK.

4. On the main page, click Wireless or another selection where settings are stored. The SSID appears.

5. Write down the SSID, security type, and the WEP key/WPA passphrase (if shown).
   
   Note: Make sure you copy the network information down exactly, including any capital letters.

6. Store the SSID and the WEP key or WPA passphrase in a safe place for future reference.

Using Macintosh with an AirPort base station

In Mac OS X version 10.5

1. From the menu bar, click System Preferences.

2. Click Network.

3. Click AirPort.
   
   The SSID of the network the computer is connected to is displayed in the Network Name pop-up menu.

4. Write down the SSID.

Troubleshooting

132
In Mac OS X version 10.4 and earlier
1. From the menu bar, click Go ➔ Applications.
2. From the Applications folder, double-click Internet Connect.
3. From the toolbar, click AirPort.
   The SSID of the network the computer is connected to is displayed in the Network pop-up menu.
4. Write down the SSID.

Using Macintosh with a wireless access point
1. Type the IP address of the wireless access point in the address field of your Web browser and continue to Step 2.
   If you do not know the IP address of the wireless access point, then do the following:
   
   In Mac OS X version 10.5
   a. From the menu bar, click Apple ➔ System Preferences.
   b. Click Network.
   c. Click AirPort.
   d. Click Advanced.
   e. Click TCP/IP.
      The “Router” entry is typically the wireless access point.

   In Mac OS X version 10.4 and earlier
   a. From the menu bar, click Apple ➔ System Preferences.
   b. Click Network.
   c. From the Show pop-up menu, select Airport.
   d. Click TCP/IP.
      The “Router” entry is typically the wireless access point.
2. Type your user name and password when prompted.
3. Click OK.
4. On the main page, click Wireless or another selection where settings are stored. The SSID will be displayed.
5. Write down the SSID, security type and the WEP key/WPA passphrase (if shown).
   
   Notes:
   - Make sure you copy the network information down exactly, including any capital letters.
   - Store the SSID and the WEP key or WPA passphrase in a safe place for future reference.

CHECK YOUR WEP KEY OR WPA PASSPHRASE

If your wireless access point is using Wireless Equivalent Privacy (WEP) security, the WEP key should be:
- Exactly 10 or 26 hexadecimal characters. Hexadecimal characters are A-F, a-f, and 0-9.
  or
- Exactly 5 or 13 ASCII characters. ASCII characters are letters, numbers, and symbols found on a keyboard. ASCII characters in a WEP key are case-sensitive.
If your wireless access point is using Wi-Fi Protected Access (WPA) security the WPA passphrase should be:

- From 8 to 63 ASCII characters. ASCII characters in a WPA passphrase are case-sensitive.
  
or
- Exactly 64 hexadecimal characters. Hexadecimal characters are A-F, a-f, and 0-9.

**Note:** If you do not know this information, see the documentation that came with the wireless network, or contact the person who set up your wireless network.

**DISCONNECT FROM VPN SESSION**

When you are connected to another network through a VPN connection, you will not be able to access the printer over your wireless network. End your VPN session and try printing again.

**CHECK YOUR ADVANCED SECURITY SETTINGS**

- If you are using MAC address filtering to limit access to your wireless network, you must add the printer MAC address to the list of addresses allowed to connect to the wireless access point.
- If you set the wireless access point to issue a limited number of IP addresses, you must change this so that the printer can be added.

**Note:** If you do not know how to make these changes, see the documentation that came with the wireless network, or contact the person who set up your wireless network.

**Cannot print and there is a firewall on the computer**

Third-party (non-Microsoft) firewalls can interfere with wireless printing. If the printer and computer are configured correctly, and the wireless network is working, but the printer will not print wirelessly, a firewall could be the problem. If there is a firewall (other than the Windows firewall) on the computer, try one or more of the following:

- Update the firewall using the most recent update available from the manufacturer. Refer to the documentation that came with your firewall for instructions on how to do this.
- If programs request firewall access when you install the printer or try to print, make sure you allow those programs to run.
- Temporarily disable the firewall and install the wireless printer on the computer. Re-enable the firewall when you have completed the wireless installation.

**Wi-Fi indicator light is not lit**

**CHECK POWER**

Make sure the power light is on.
Wi-Fi indicator light is green but the printer does not print (Windows only)

If you have completed the configuration for wireless printing and all of the settings appear to be correct, but the printer does not print, try one or more of the following:

**ALLOW THE WIRELESS INSTALLATION TO COMPLETE**

Do not attempt to print, remove the installation CD, or detach the installation cable until you see the Wireless Setup Successful screen.

**ENABLE THE PRINTER**

Confirm that the printer is enabled.

1. Do one of the following:
   - **In Windows Vista**
     - a. Click 🍾.
     - b. Click **Control Panel**.
     - c. Under Hardware and Sound, click **Printer**.
   - **In Windows XP**
     - a. Click **Start**.
     - b. Click **Printers and Faxes**.
   - **In Windows 2000**
     - a. Click **Start**.
     - b. Click **Settings → Printers**.

2. Right-click the new printer. From the menu, select **Use Printer Online**.
3. Close the Printers or Printers and Faxes window and try printing again.

**SELECT THE WIRELESS PRINTER**

You may need to select the wireless printer from your computer to use the printer wirelessly.

1. Do one of the following:
   - **In Windows Vista**
     - a. Click 🍾.
     - b. Click **Control Panel**.
     - c. Under Hardware and Sound, click **Printer**.
   - **In Windows XP**
     - a. Click **Start**.
     - b. Click **Printers and Faxes**.
In Windows 2000
a Click Start.
b Click Settings \(\rightarrow\) Printers.

d  Right-click the printer named **Lexmark XXXX Series (Network)**, where XXXX is the model number of your printer.
e  Select **Use Printer Online** from the menu.
f  Close the Printers or Printers and Faxes window and try printing again.

**SELECT THE WIRELESS PORT**

If you have previously set up your printer as a locally attached printer, you may need to select the wireless printer to use the printer wirelessly.

1  Do one of the following:

   **In Windows Vista**
   a Click 🔄.
   b Click **Control Panel**.
   c Under Hardware and Sound, click **Printer**.

   **In Windows XP**
   a Click Start.
   b Click **Printers and Faxes**.

   **In Windows 2000**
   a Click Start.
   b Click Settings \(\rightarrow\) Printers.

d  Right-click the printer, and then select **Properties** from the menu.
e  Click the **Ports** tab.
f  Locate the selected port. The selected port has a check beside it in the Port column.

   5  If the Description column of the selected port indicates that it is a USB port, scroll through the list and select the port with Printer Port in the Description column.

   6  Click **OK**, and then try to print again.
Wi-Fi indicator light is blinking orange during installation (Windows only)

When the Wi-Fi indicator light is blinking orange, it indicates that the printer has been set up for wireless networking but cannot connect to the network for which it has been configured. The printer may be unable to join the network because of interference, its distance from the wireless access point (wireless router), or until its settings are changed.

These are possible solutions. Try one or more of the following:

MAKE SURE THE ACCESS POINT IS ON
Check the access point and, if necessary, turn it on.

MOVE YOUR ACCESS POINT TO MINIMIZE INTERFERENCE
There may be temporary interference from other devices such as microwave ovens or other appliances, cordless phones, baby monitors, and security system cameras. Make sure your access point is not positioned too closely to these devices.

TRY ADJUSTING EXTERNAL ANTENNAS
Antennas usually work best if they are pointing straight up. You may find that reception improves if you experiment with different angles for the printer and/or wireless access point antennas.

MOVE YOUR PRINTER
Move the printer closer to the access point. Although the possible distance between devices in 802.11b or 802.11g networks is 300 feet, the maximum range for optimal performance is generally 100–150 feet.

You can find the signal strength of the network on the network setup page.

CHECK SECURITY KEYS

If you are using WEP security
A valid WEP key is:
- Exactly 10 or 26 hexadecimal characters. Hexadecimal characters are A–F, a–f, and 0–9.
  or
- Exactly 5 or 13 ASCII characters. ASCII characters are letters, numbers, and symbols found on a keyboard.

If you are using WPA security
A valid WPA passphrase is:
- From 8 to 63 ASCII characters. ASCII characters in a WPA passphrase are case-sensitive.
  or
- Exactly 64 hexadecimal characters. Hexadecimal characters are A-F, a-f, and 0-9.

If your wireless network is not using security, then you will not have a security key. Using a wireless network with no security is not recommended because it can allow intruders to use your network resources without your consent.
CHECK MAC ADDRESS

If your network uses MAC address filtering, make sure that you include the MAC address of the printer in the MAC address filter list. This will allow the printer to operate on the network. For more information, see “How do I find the MAC address?” on page 62.

PING THE ACCESS POINT TO MAKE SURE THE NETWORK IS WORKING

1 If you do not already know it, find the IP address of the access point.
   a Do one of the following:

   **In Windows Vista**
   1 Click 🌐.
   2 Click All Programs → Accessories.
   3 Click Command Prompt.

   **In Windows XP and earlier**
   1 Click Start.
   2 Click All Programs or Programs → Accessories → Command Prompt.
   b Type `ipconfig`.
   c Press Enter.
   • The “Default Gateway” entry is typically the access point.
   • The IP address appears as four sets of numbers separated by periods, such as 192.168.0.100. Your IP address might also start with the numbers 10 or 169. This is determined by your operating system or wireless network software.

2 Ping the access point.
   a Do one of the following:

   **In Windows Vista**
   1 Click 🌐.
   2 Click All Programs → Accessories.
   3 Click Command Prompt.

   **In Windows XP and earlier**
   1 Click Start.
   2 Click All Programs or Programs → Accessories → Command Prompt.
   b Type `ping` followed by a space and the IP address of the wireless access point. For example:

   ```
PING 192.168.0.100
   ```
   c Press Enter.

3 Check to see whether the access point responds:
   • If the access point responds, you will see several lines appear that start with “Reply from.”
     It is possible that the printer did not connect to the wireless network. Turn off and then restart the printer to try to connect again.
   • If the access point does not respond, it will take several seconds and then you will see “Request timed out.”
Try the following:

a  Do one of the following:

**In Windows Vista**
1  Click 🌐.
2  Click Control Panel.
3  Click Network and Internet.
4  Click Network and Sharing Center.

**In Windows XP and earlier**
1  Click Start.
2  Click Control Panel.
3  Click Network Connection.

b  Select the appropriate connection from the ones shown.

**Note:** If the computer is connected to the access point by an Ethernet cable, the connection may not include the word “wireless” in its name.

c  Right-click the connection, and then click Repair.

**RUN THE WIRELESS SETUP AGAIN**

If your wireless settings have changed, you must run the printer wireless setup again. Some reasons your settings may have changed include your having manually changed your WEP or WPA keys, channel, or other network settings; or the access point having been reset to factory defaults.

Running the wireless setup again can also resolve issues due to misconfigurations that occurred when configuring the printer for wireless access.

**Notes:**

- If you change network settings, change them on all the network devices before changing them for the access point.
- If you have already changed the wireless network settings on your access point, then you must change the settings on all the other network devices before you can see them on the network.

1  Do one of the following:
   - In Windows Vista, click 🌐.
   - In Windows XP and earlier, click Start.

2  Click All Programs or Programs, and then select the printer program folder from the list.

3  Click Tools ➔ Lexmark Wireless Setup Utility.

   **Note:** You may be prompted to connect the printer to the computer again using the installation cable as part of the setup process.

4  Follow the instructions on the computer screen.
Wi-Fi indicator light is blinking orange during installation (Macintosh only)

When the Wi-Fi indicator light is blinking orange, it indicates that the printer has been set up for wireless networking but cannot connect to the network for which it has been configured. The printer may be unable to join the network because of interference, its distance from the wireless access point (wireless router), or until its settings are changed.

These are possible solutions. Try one or more of the following:

**MAKE SURE THE WIRELESS ACCESS POINT IS ON**

Check the wireless access point and, if necessary, turn it on.

**MOVE YOUR WIRELESS ACCESS POINT TO MINIMIZE INTERFERENCE**

There may be temporary interference from other devices such as microwave ovens or other appliances, cordless phones, baby monitors, and security system cameras. Make sure the wireless access point is not positioned too closely to these devices.

**TRY ADJUSTING EXTERNAL ANTENNAS**

Antennas usually work best if they are pointing straight up. You may find that reception improves if you experiment with different angles for the printer and/or wireless access point antennas.

**MOVE YOUR PRINTER**

Move the printer closer to the wireless access point. Although the possible distance between devices in 802.11b or 802.11g networks is 300 feet, the effective range for optimal performance is generally 100–150 feet.

You can find the signal strength of the network on the network setup page.

**CHECK SECURITY KEYS**

**If you are using WEP security**

A valid WEP key is:

- Exactly 10 or 26 hexadecimal characters. Hexadecimal characters are A–F, a–f, and 0–9.

  or

- Exactly 5 or 13 ASCII characters. ASCII characters are letters, numbers, and symbols found on a keyboard.

**If you are using WPA security**

A valid WPA passphrase is:

- From 8 to 63 ASCII characters. ASCII characters in a WPA passphrase are case-sensitive.

  or

- Exactly 64 hexadecimal characters. Hexadecimal characters are A-F, a-f, and 0-9.

If your wireless network is not using security, then you will not have a WEP key or WPA passphrase. Using a wireless network with no security is not recommended because it can allow intruders to use your network resources without your consent.
CHECK THE MAC ADDRESS

If your network uses MAC address filtering, make sure that you include the MAC address of the printer in the MAC address filter list. This will allow the printer to operate on the network.

PING THE ACCESS POINT TO MAKE SURE THE NETWORK IS WORKING

1 Check the AirPort status and, if you do not already know it, find the IP address of the wireless access point.

In Mac OS X version 10.5
a From the menu bar, click System Preferences.
b Click Network.
c Click AirPort.
   Check Status. It should be on. If it is off, click Turn AirPort On.
   The AirPort status indicator should also be green. Green means the port is active (turned on) and connected.
   Notes:
   • Yellow means the port is active but is not connected.
   • Red means the port has not been configured.
d Click Advanced.
e Click TCP/IP.
   • The IP address appears as four sets of numbers separated by periods, such as 192.168.0.100.
   • The “Router” entry is typically the wireless access point.

In Mac OS X version 10.4 and earlier
a Click System Preferences.
b Click Network.
c If necessary, select Network Status in the Show pop-up menu.
   The AirPort status indicator should be green. Green means the port is active (turned on) and connected.
   Notes:
   • Yellow means the port is active but is not connected.
   • Red means the port has not been configured.
d From the Show pop-up menu, select AirPort.
e Click TCP/IP.
   • The IP address appears as four sets of numbers separated by periods, such as 192.168.0.100.
   • The “Router” entry is typically the wireless access point.

2 Ping the wireless access point.
a From the menu bar, click Go → Utilities.
b Double-click Network Utility.
c Click the Ping tab.
d Type the IP address of the wireless access point in the network address field. For example:
   10.168.0.100
e Click Ping.
If the wireless access point responds, you will see several lines that display the number of bytes received from the access point. This ensures that your computer is connected to the access point. If the wireless access point does not respond, nothing is displayed. You can use Network Diagnostics to help resolve the problem.

**RUN THE WIRELESS SETUP AGAIN**

1. From the Finder desktop, double-click the printer folder.
2. Double-click **Lexmark Wireless Setup Assistant**.
3. Follow the instructions on the computer screen.

**Wi-Fi indicator light is still orange**

When the Wi-Fi indicator light is orange, it may indicate that the printer is:

- Not configured in infrastructure mode
- Waiting to make an ad hoc connection to another wireless device

The printer may be unable to join the network because of interference, its distance from the wireless access point (wireless router), or until its settings are changed.

These are possible solutions. Try one or more of the following:

**CHECK NETWORK NAME**

Make sure your network does not have the same name as another network near you. For example, if you and your neighbor both use a manufacturer’s default network name, your printer could be connecting to your neighbor’s network.

If you are not using a unique network name, consult the documentation for your wireless access point (wireless router) to learn how to set a network name.

If you set a new network name, you must reset the printer and computer SSID to the same network name.

**CHECK SECURITY KEYS**

**If you are using WEP security**

A valid WEP key is:

- Exactly 10 or 26 hexadecimal characters. Hexadecimal characters are A–F, a–f, and 0–9.
  or
- Exactly 5 or 13 ASCII characters. ASCII characters are letters, numbers, and symbols found on a keyboard.

**If you are using WPA security**

A valid WPA passphrase is:

- From 8 to 63 ASCII characters. ASCII characters in a WPA passphrase are case-sensitive.
  or
- Exactly 64 hexadecimal characters. Hexadecimal characters are A-F, a-f, and 0-9.

If your wireless network is not using security, then you will not have a security key. Using a wireless network with no security is not recommended because it can allow intruders to use your network resources without your consent.
**Move Your Printer**

Move the printer closer to the wireless access point (wireless router). Although the possible distance between devices in 802.11b or 802.11g networks is 300 feet, the maximum range for optimal performance is generally 100-150 feet.

You can find the strength of the network signal on the printer network setup page.

**Check MAC Address**

If your network uses MAC address filtering, make sure that you include the MAC address of the printer in the MAC address filter list. This will allow the printer to operate on the network.

**Wireless Print Server Not Installed**

You may see a message during installation indicating that the printer does not have a wireless print server installed. If you are sure the printer is capable of wireless printing, try the following:

**Check Power**

Make sure the \( \bigcirc \) light is on.

**“Communication Not Available” Message Displays When Printing Wirelessly**

If you are using a laptop and have power saving settings enabled, you may see the *Communication not available* message on your computer screen when you attempt to print wirelessly. This can occur if the laptop hard drive has powered down.

If you see this message, wait a few seconds and then try to print again. The laptop and printer require a few seconds to power up again and reattach to the wireless network.

If you see this message again after you have waited long enough for the printer and the laptop to attach to the network, there may be a problem with your wireless network. Make sure that the laptop and printer have both received IP addresses. For more information on locating IP addresses, refer to “How do I locate IP addresses?” on page 63.

If the printer and/or the laptop does not have an IP address, or if either has an address of 169.254.x.y (where x and y are any two numbers between 0 and 255):

1. Shut down the device that does not have a valid IP address (the laptop, the printer, or both).
2. Turn on the device(s).
3. Check the IP addresses again.

If the laptop and/or printer still does not receive a valid IP address, there is a problem with your wireless network. Make sure your wireless access point (wireless router) is working, and remove any obstacles that could be blocking the wireless signal.
Communication with printer lost when connected to Virtual Private Network (VPN)

You will lose your connection to a wireless printer on your local network when connected to most Virtual Private Networks (VPNs). Most VPNs allow users to communicate with only the VPN and no other network at the same time. If you would like to have the ability to connect to your local network and to a VPN at the same time, the system support person for the VPN must enable split tunneling. Be aware that some organizations will not allow split tunneling due to security or technical concerns.

Resetting the internal wireless print server to factory default settings

1. From the printer control panel, press .
2. Press the arrow buttons until Network Setup appears, and then press .
3. Press the arrow buttons until Reset Network Adapter Defaults appears, and then press .
4. Press the arrow buttons until Yes appears, and then press .

The internal wireless print server is reset to factory default settings. To verify, print a network setup page.

Fax troubleshooting

Cannot send or receive a fax

These are possible solutions. Try one of the following:

CHECK MESSAGES
If an error message is displayed, follow the instructions on the error message dialog.

CHECK POWER
If the light is not on, then make sure that the power cord is properly connected to the printer and plugged into a known working electrical outlet that other electrical devices have been using.

CHECK CABLE CONNECTIONS
Make sure that the cable connections for the following hardware are secure, if applicable:
- Power supply
- Telephone
- Handset
- Answering machine

CHECK THE TELEPHONE WALL JACK
1. Plug a telephone into the wall jack.
2. Listen for a dial tone. If you hear a dial tone, the wall jack is working.
3 If you do not hear a dial tone, plug a different telephone into the wall jack.

4 If you still do not hear a dial tone, plug a telephone into a different wall jack.

5 If you hear a dial tone, connect the printer to that wall jack.

**REVIEW DIGITAL PHONE SERVICE CHECKLIST**

The fax modem is an analog device. Certain devices can be connected to the printer so that digital telephone services can be used.

- If you are using an ISDN telephone service, connect the printer to an analog telephone port (an R-interface port) on an ISDN terminal adapter. For more information and to request an R-interface port, contact your ISDN provider.
- If you are using DSL, connect to a DSL filter or router that will support analog use. For more information, contact your DSL provider.
- If you are using a PBX telephone service, make sure you are connecting to an analog connection on the PBX. If none exists, consider installing an analog telephone line for the fax machine. For more information on faxing when using a PBX telephone service, see the instructions for setting up the printer to fax while behind a PBX.

**VERIFY DIAL TONE**

- Place a test call to the telephone number to which you want to send a fax to make sure that it is working correctly.
- If the telephone line is being used by another device, wait until the other device is finished before sending a fax.
- If you are using the On Hook Dial feature, turn up the volume to verify a dial tone.

**DISCONNECT OTHER EQUIPMENT TEMPORARILY**

To ensure the printer is working correctly, connect it directly to the telephone line. Disconnect any answering machines, computers with modems, or telephone line splitters.

**CHECK FOR PAPER JAMS**

Check for and clear any paper jams.

**DISABLE CALL WAITING TEMPORARILY**

Call Waiting can disrupt fax transmissions. Disable this feature before sending or receiving a fax. Call your telephone company to obtain the keypad sequence for temporarily disabling Call Waiting.

**DO YOU HAVE VOICE MAIL service?**

Voice Mail offered through your local telephone company may disrupt fax transmissions. To enable both Voice Mail and the printer to answer calls:

- See the instructions for setting the distinctive ring. Setting selections include single ring, double ring, triple ring, and any ring.
- Consider adding a second telephone line for the printer.
CHECK COUNTRY CODE

Make sure the country code has been set for the country or region where you are operating the printer:

1. From the printer control panel, press \( \text{OK} \).
2. Press the arrow buttons until Device Setup appears, and then press \( \text{OK} \).
3. Press the arrow buttons until Country appears, and then press \( \text{OK} \).
   Check the country or region on the display.
4. If the country or region name is incorrect, press the arrow buttons until the country or region where you are operating the printer appears, and then press \( \text{OK} \).

IS YOUR PRINTER MEMORY FULL?

1. Dial the receiving number.
2. Scan the original document one page at a time.

Can send but not receive faxes

These are possible causes and solutions. Try one or more of the following:

LOAD PAPER

Load paper to print any faxes that have been stored in the printer.

MAKE SURE THAT AUTO ANSWER IS ON

If the Auto Answer light is on:
- The printer will answer after the preset number of telephone rings.
- If you are using a distinctive ring, see the instructions for setting a distinctive ring for the printer.
1. From the printer control panel, press \( \text{OK} \).
2. Press the arrow buttons until Fax Setup appears, and then press \( \text{OK} \).
3. Press the arrow buttons until Ringing and Answering appears, and then press \( \text{OK} \).
4. Press \( \text{OK} \) again.
   Check to see if Auto Answer is set to On.
5. If Auto Answer is not selected, press the arrow buttons until On appears, and then press \( \text{OK} \) to save the setting.

CHECK INK

Check the ink levels, and install a new cartridge if necessary.

CHECK WHETHER FAX FORWARDING IS SELECTED

1. From the printer control panel, press \( \text{OK} \).
2. Press the arrow buttons until Fax Setup appears, and then press \( \text{OK} \).
3 Press the arrow buttons until **Ringing and Answering** appears, and then press **OK**.
4 Press the arrow buttons until **Fax Forward** appears, and then press **OK**.
   Check to see if Fax Forward is set to **Forward** or **Print & Forward**.
5 If fax forward is set to on, press the arrow buttons until **Off** appears, and then press **OK**.

**Can receive but not send faxes**

These are possible solutions. Try one or more of the following:

**CHECK MODE SELECTION**

To make sure that the printer is set for faxing, check to see if the *** light is on.
   If the *** light is not on, press *** on the printer control panel.

**CHECK DOCUMENT PLACEMENT**

Load the original document faceup into the Automatic Document Feeder (ADF) or facedown on the scanner glass.

**CHECK THE DIAL PREFIX SETTING**

1 From the printer control panel, press ***.
2 Press the arrow buttons until **Fax Setup** appears, and then press **OK**.
3 Press the arrow buttons until **Dialing and Sending** appears, and then press **OK**.
4 Press the arrow buttons until **Dial Prefix** appears, and then press **OK**.
5 To change the setting, press the arrow buttons until the prefix that you want appears, and then press **OK**.
6 If you have not yet created a setting for the dialing prefix:
   a Press the arrow buttons until **Create** appears, and then press **OK**.
   b Using the keypad, enter the prefix to be dialed before each telephone number, and then press **OK** to save the setting.

**CHECK SPEED DIAL NUMBER**

- Check to make sure Speed Dial has been programmed for the number that you want to dial. For more information, see the instructions for setting up Speed Dial.
- As an alternative, dial the telephone number manually.

**MAKE SURE THE PRINTER DETECTS DIAL TONE**

- See the instructions for sending a fax while listening to a call (on hook dial).
- Check the Dial Method setting:
   1 Listen for a dial tone. If you hear a dial tone but the printer hangs up without dialing, this means it did not recognize the dial tone.
   2 From the printer control panel, press ***.
   3 Press the arrow buttons until **Fax Setup** appears, and then press **OK**.
4 Press the arrow buttons until **Dialing and Sending** appears, and then press **OK**.

5 Press the arrow buttons until **Dial Method** appears, and then press **OK**.

6 Press the arrow buttons until **Behind PBX** appears, and then press **OK** to save the setting.

---

**Printer receives a blank fax**

These are possible causes and solutions. Try one or more of the following:

**CHECK ORIGINAL DOCUMENT**

Ask the sender to verify the original document was loaded correctly.

**CHECK INK**

Check the ink levels, and install a new print cartridge if necessary.

**CHECK CARTRIDGES**

1 Remove the print cartridges.

2 Make sure the sticker and tape have been removed.

3 Reinsert the print cartridges.

---

**Received fax has poor print quality**

These are possible solutions. Try one or more of the following:

**REVIEW CHECKLIST FOR SENDER**

- Check that the quality of the original document is satisfactory.
- Resend the fax. There may have been a problem with the quality of the telephone line connection.
- Increase the fax scan resolution.

**CHECK INK**

Check the ink levels, and install a new print cartridge if necessary.

**DECREASE THE TRANSMISSION SPEED**

1 From the printer control panel, press 

2 Press the arrow buttons until **Fax Setup** appears, and then press **OK**.

3 Press the arrow buttons until **Dialing and Sending** appears, and then press **OK**.
4 Press the arrow buttons until **Max Send Speed** appears, and then press **OK**.
5 Press the arrow buttons to select a lower transmission speed, and then press **OK**.
6 Resend the fax.
7 If the problem persists, repeat step 1 through step 5 to resend the fax at successively lower transmission speeds.

**Note:** 2400 bps is the lowest transmission speed.

**Notes:**
- The lower the transmission speed, the longer it will take your fax to print.
- This solution will reduce the speed for future faxes until you reset the transmission speed.

**Caller ID information is not displayed**

**CALLER ID PATTERN MAY NOT BE SET CORRECTLY**

The printer supports two distinct Caller ID patterns: Pattern 1 (FSK) and Pattern 2 (DTMF). Depending on the country or region you live in and the telecommunications company you subscribe to, you may need to switch the pattern for the printer to display Caller ID information. For more information, see the instructions for setting up Caller ID.

**Fax Error**

The fax machines have stopped communicating.
Resend the fax. There may have been a problem with the quality of the telephone line connection.

**Fax Mode Unsupported**

The fax machine of the recipient does not support legal-size paper, color, or the resolution of the fax you are sending.
These are possible solutions. Try one or more of the following:

**REFORMAT THE DOCUMENT ON LETTER-SIZE PAPER**

**LOWER THE SCAN RESOLUTION**

1 From the printer control panel, pressaths.
2 Press **OK** until **Quality** appears.
3 Press the arrow buttons until a lower quality appears, and then press **OK**.

**ENABLE AUTO FAX CONVERSION**

1 From the printer control panel, pressaths.
2 Press the arrow buttons until **Fax Setup** appears, and then press **OK**.
3 Press the arrow buttons until **Dialing and Sending** appears, and then press **OK**.
4 Press the arrow buttons until Auto Fax Convert appears, and then press OK.

5 If auto fax conversion is not set to on, press the arrow buttons until On appears, and then press OK.

Remote Fax Error
These are possible solutions. Try one or more of the following:

**CHECK THE PHONE LINE**
Resend the fax. There may have been a problem with the quality of the telephone line connection.

**DECREASE THE TRANSMISSION SPEED**

1 From the printer control panel, press .
2 Press the arrow buttons until Fax Setup appears, and then press OK.
3 Press the arrow buttons until Dialing and Sending appears, and then press OK.
4 Press the arrow buttons until Max Send Speed appears, and then press OK.
5 Press the arrow buttons to select a lower transmission speed, and then press OK.
6 Resend the fax.
7 If the problem persists, repeat step 1 through step 5 to resend the fax at successively lower transmission speeds.

**Note:** 2400 bps is the lowest transmission speed.

**Notes:**
- The lower the transmission speed, the longer it will take your fax to print.
- This solution will reduce the speed for future faxes until you reset the transmission speed.

Phone Line Busy
These are possible causes and solutions. Try one or more of the following:

**CHANGE REDIAL SETTINGS**
The printer automatically redials three times at two-minute intervals. You can change the default settings to redial up to five times at intervals up to eight minutes.

To change the redial settings:

1 From the printer control panel, press .
2 Press the arrow buttons until Dialing and Sending appears, and then press OK.
3 To change the number of times the printer will redial:
   a Press the arrow buttons until Redial Attempts appears, and then press OK.
   b Press the arrow buttons until the setting that you want appears, and then press OK.
4 To change the length of time between redials:
   a Press the arrow buttons until Redial Time appears, and then press OK.
   b Press the arrow buttons until the setting that you want appears, and then press OK.

Schedule to Resend Fax at a Later Time
See the instructions for sending a broadcast fax at a scheduled time.

Phone Line Error
These are possible causes and solutions. Try one or more of the following:

Review Digital Phone Service Checklist
The fax modem is an analog device. Certain devices can be connected to the printer so that digital telephone services can be used.
   • If you are using an ISDN telephone service, connect the printer to an analog telephone port (an R-interface port) on an ISDN terminal adapter. For more information and to request an R-interface port, contact your ISDN provider.
   • If you are using DSL, connect to a DSL filter or router that will support analog use. For more information, contact your DSL provider.
   • If you are using a PBX telephone service, make sure you are connecting to an analog connection on the PBX. If none exists, consider installing an analog telephone line for the fax machine. For more information on faxing when using a PBX telephone service, see the instructions for setting up to fax while behind a PBX.

Check Phone Line
If the telephone line is being used by another device, wait until the other device is finished before sending the fax.

Check Cable Connections
Make sure cable connections for the following hardware are secure, if applicable:
   • Power supply
   • Telephone
   • Handset
   • Answering machine

No Answer
These are possible solutions. Try one or more of the following:

Use Phone Line Checklist
   • Resend the fax. There may have been a problem with the quality of the telephone line connection.
   • Place a test call to the telephone number to which you want to send a fax to make sure that it is working correctly.
MAKE SURE THE PRINTER DETECTS DIAL TONE

- See the instructions for sending a fax while listening to a call (on hook dial).
- Check the Dial Method setting:
  1. Listen for a dial tone. If you hear a dial tone but the printer hangs up without dialing, this means it did not recognize the dial tone.
  2. From the printer control panel, press \(\text{ok}\).
  3. Press the arrow buttons until Fax Setup appears, and then press \(\text{ok}\).
  4. Press the arrow buttons until Dialing and Sending appears, and then press \(\text{ok}\).
  5. Press the arrow buttons until Dial Method appears, and then press \(\text{ok}\).
  6. Press the arrow buttons until the dialing method that you want appears, and then press \(\text{ok}\) to save the setting.

Failed to Connect

These are possible solutions. Try one or more of the following:

USE PHONE LINE CHECKLIST

- Resend the fax. There may have been a problem with the quality of the telephone line connection.
- Place a test call to the telephone number to which you want to send a fax to make sure that it is working correctly.
- If the telephone line is being used by another device, wait until the other device is finished before sending the fax.

MAKE SURE THE PRINTER DETECTS DIAL TONE

- See the instructions for sending a fax while listening to a call (on hook dial).
- Check the Dial Method setting:
  1. Listen for a dial tone. If you hear a dial tone but the printer hangs up without dialing, this means it did not recognize the dial tone.
  2. From the printer control panel, press \(\text{ok}\).
  3. Press the arrow buttons until Fax Setup appears, and then press \(\text{ok}\).
  4. Press the arrow buttons until Dialing and Sending appears, and then press \(\text{ok}\).
  5. Press the arrow buttons until Dial Method appears, and then press \(\text{ok}\).
  6. Press the arrow buttons until the dialing method that you want appears, and then press \(\text{ok}\) to save the setting.
Product information

Product name:
Lexmark 5600 Series
Machine type:
4437
Model(s):
001, 002

Product name:
Lexmark 6600 Series
Machine type:
4437
Model number 2:
W02, WE2, WE3

Edition notice

July 2008

The following paragraph does not apply to any country where such provisions are inconsistent with local law: LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions; therefore, this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in later editions. Improvements or changes in the products or the programs described may be made at any time.

References in this publication to products, programs, or services do not imply that the manufacturer intends to make these available in all countries in which it operates. Any reference to a product, program, or service is not intended to state or imply that only that product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any existing intellectual property right may be used instead. Evaluation and verification of operation in conjunction with other products, programs, or services, except those expressly designated by the manufacturer, are the user’s responsibility.

For Lexmark technical support, visit support.lexmark.com.
For information on supplies and downloads, visit www.lexmark.com.
If you don't have access to the Internet, you can contact Lexmark by mail:

Lexmark International, Inc.
Bldg 004-2/CSC
740 New Circle Road NW
Lexington, KY 40550
USA

© 2008 Lexmark International, Inc.
All rights reserved.

UNITED STATES GOVERNMENT RIGHTS

This software and any accompanying documentation provided under this agreement are commercial computer software and documentation developed exclusively at private expense.

Trademarks

Lexmark and Lexmark with diamond design are trademarks of Lexmark International, Inc., registered in the United States and/or other countries.

evercolor and PerfectFinish are trademarks of Lexmark International, Inc.

All other trademarks are the property of their respective owners.

Licensing notices

The following document can be viewed from the \Drivers\XPS directory on the installation software CD: Zopen.PDF.

Federal Communications Commission (FCC) compliance information statement

This product has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

The FCC Class B limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult your point of purchase or service representative for additional suggestions.
The manufacturer is not responsible for radio or television interference caused by using other than recommended cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could void the user’s authority to operate this equipment.

**Note:** To assure compliance with FCC regulations on electromagnetic interference for a Class B computing device, use a properly shielded and grounded cable such as Lexmark part number 1021294 for USB attach. Use of a substitute cable not properly shielded and grounded may result in a violation of FCC regulations.

Any questions regarding this compliance information statement should be directed to:

Director of Lexmark Technology & Services  
Lexmark International, Inc.  
740 West New Circle Road  
Lexington, KY 40550  
(859) 232–3000

### Exposure to radio frequency radiation

The following notice is applicable if your printer has a wireless network card installed.

The radiated output power of this device is far below the radio frequency exposure limits of the FCC and other regulatory agencies. A minimum separation of 20 cm (8 inches) must be maintained between the antenna and any persons for this device to satisfy the RF exposure requirements of the FCC and other regulatory agencies.

### Industry Canada compliance statement

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Standard ICES-003.

### Avis de conformité aux normes de l'industrie du Canada

Cet appareil numérique de classe B est conforme aux exigences de la norme canadienne relative aux équipements pouvant causer des interférences NMB-003.

### Industry Canada notice

The following notices are applicable if your printer has a wireless network card installed.

#### Industry Canada (Canada)

This device complies with Industry Canada specification RSS-210. Operation is subject to the following two conditions: 
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.  

This device has been designed to operate only with the antenna provided. Use of any other antenna is strictly prohibited per regulations of Industry Canada.  

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to licensing.
The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not emit RF fields in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable from Health Canada's Web site www.hc-sc.gc.ca/rpb.

The term "IC:" before the certification/registration number only signifies that the Industry Canada technical specifications were met.

**Industry Canada (Canada)**

Cet appareil est conforme à la norme RSS-210 d'Industry Canada. Son fonctionnement est soumis aux deux conditions suivantes:

(1) cet appareil ne doit pas provoquer d'interférences et (2) il doit accepter toute interférence reçue, y compris celles risquant d'altérer son fonctionnement.

Cet appareil a été conçu pour fonctionner uniquement avec l'antenne fournie. L'utilisation de toute autre antenne est strictement interdite par la réglementation d'Industry Canada.

En application des réglementations d'Industry Canada, l'utilisation d'une antenne de gain supérieur est strictement interdite.

Pour empêcher toute interférence radio au service faisant l'objet d'une licence, cet appareil doit être utilisé à l'intérieur et loin des fenêtres afin de garantir une protection optimale.

Si le matériel (ou son antenne d'émission) est installé à l'extérieur, il doit faire l'objet d'une licence.

L'installateur de cet équipement radio doit veiller à ce que l'antenne soit implantée et dirigée de manière à n'émettre aucun champ HF dépassant les limites fixées pour l'ensemble de la population par Santé Canada. Reportez-vous au Code de sécurité 6 que vous pouvez consulter sur le site Web de Santé Canada www.hc-sc.gc.ca/rpb.

Le terme « IC » précédant le numéro de d'accréditation/inscription signifie simplement que le produit est conforme aux spécifications techniques d'Industry Canada.

**European Community (EC) directives conformity**

This product is in conformity with the protection requirements of EC Council directives 2004/108/EC and 2006/95/EC on the approximation and harmonization of the laws of the Member States relating to electromagnetic compatibility and safety of electrical equipment designed for use within certain voltage limits.

A declaration of conformity with the requirements of the directives has been signed by the Director of Manufacturing and Technical Support, Lexmark International, Inc., S.A., Boigny, France.

This product satisfies the Class B limits of EN 55022 and safety requirements of EN 60950.

**European EC directives conformity statement for radio products**

**The following notices are applicable if your printer has a wireless network card installed**

This product is in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC, and 1999/5/EC on the approximation and harmonization of the laws of the Member States relating to electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits and on radio equipment and telecommunications terminal equipment.
Compliance is indicated by the CE marking.

The Alert sign indicates that there are restrictions within certain member states.

A declaration of conformity with the requirements of the directives is available from the Director of Manufacturing and Technical Support, Lexmark International, S. A., Boigny, France.

The following restrictions apply:

<table>
<thead>
<tr>
<th>Country/region</th>
<th>Restriction</th>
</tr>
</thead>
<tbody>
<tr>
<td>All countries/regions</td>
<td>This product is for indoor use only. This product may not be used outdoors.</td>
</tr>
</tbody>
</table>
| L'Italia | Si fa presente inoltre che l'uso degli apparati in esame è regolamentato da:  
- D.Lgs 1.8.2003, n.259, articoli 104 (attività soggette ad autorizzazione generale) e 105 (libero uso), per uso privato;  
- D.M. 28.5.03, per la fornitura al pubblico dell'accesso R-LAN alle reti e ai servizi di telecomunicazioni. |

This product satisfies the limits of EN 55022; safety requirements of EN 60950; radio spectrum requirements of ETSI EN 300 328; and the EMC requirements of EN 55024, ETSI EN 301 489-1 and ETSI EN 301 489-17.

Notices
Noise emission levels

The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.

**Note:** Some modes may not apply to your product.

<table>
<thead>
<tr>
<th>1-meter average sound pressure, dBA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
</tr>
<tr>
<td>Scanning</td>
</tr>
<tr>
<td>Copying</td>
</tr>
<tr>
<td>Ready</td>
</tr>
</tbody>
</table>

Values are subject to change. See [www.lexmark.com](http://www.lexmark.com) for current values.
Waste from Electrical and Electronic Equipment (WEEE) directive

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the European Union. We encourage the recycling of our products. If you have further questions about recycling options, visit the Lexmark Web site at www.lexmark.com for your local sales office phone number.

Product disposal

Do not dispose of the printer or supplies in the same manner as normal household waste. Consult your local authorities for disposal and recycling options.

Federal Communications Commission (FCC) compliance information statement

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council for Terminal Attachments (ACTA). On the back of this equipment is a label that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to your telephone company.

This equipment uses the RJ-11C Universal Service Order Code (USOC) jack.

A plug and jack used to connect this equipment to the premises’ wiring and telephone network must comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular plug is provided with this product. It is designed to be connected to a compatible modular jack that is also compliant. See your setup documentation for more information.

The Ringer Equivalence Number (REN) is used to determine the number of devices that may be connected to a telephone line. Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices that may be connected to a line, as determined by the total RENs, contact your local telephone company. For products approved after July 23, 2001, the REN for this product is part of the product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is shown separately on the label.

If this equipment causes harm to the telephone network, the telephone company will notify you in advance that temporary discontinuance of service may be required. If advance notice is not practical, the telephone company will notify the customer as soon as possible. You will also be advised of your right to file a complaint with the FCC.

The telephone company may make changes in its facilities, equipment, operations or procedures that could affect the operation of this equipment. If this happens, the telephone company will provide advance notice in order for you to make necessary modifications to maintain uninterrupted service.
If you experience trouble with this equipment, for repair or warranty information, contact Lexmark International, Inc. at [www.lexmark.com](http://www.lexmark.com) or your Lexmark representative. If the equipment is causing harm to the telephone network, the telephone company may request that you disconnect the equipment until the problem is resolved.

This equipment contains no user serviceable parts. For repair and warranty information, contact Lexmark International, Inc. See the previous paragraph for contact information.

Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service commission, or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the installation of this equipment does not disable your alarm equipment. If you have questions about what will disable alarm equipment, consult your telephone company or a qualified installer.

Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer terminal equipment connected to AC power sources. This has been identified as a major nationwide problem. It is recommended that the customer install an appropriate AC surge arrester in the AC outlet to which this device is connected. An appropriate AC surge arrester is defined as one that is suitably rated, and certified by UL (Underwriter's Laboratories), another NRTL (Nationally Recognized Testing Laboratory), or a recognized safety certification body in the country/region of use. This is to avoid damage to the equipment caused by local lightning strikes and other electrical surges.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic device, including fax machines, to send any message unless said message clearly contains in a margin at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent and an identification of the business or other entity, or other individual sending the message, and the telephone number of the sending machine or such business, other entity, or individual. (The telephone number provided may not be a 900 number or any other number for which charges exceed local or long-distance transmission charges.) See your user documentation in order to program this information into your fax machine.

**Notice to users of the Canadian telephone network**

This product meets the applicable Industry Canada technical specifications. The Ringer Equivalence Number (REN) is an indication of the maximum number of terminals allowed to be connected to a telephone interface. The terminus of an interface may consist of any combination of devices, subject only to the requirement that the sum of the RENs of all the devices does not exceed five. The modem REN is located on the rear of the equipment on the product labeling.

Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer terminal equipment connected to AC power sources. This has been identified as a major nationwide problem. It is recommended that the customer install an appropriate AC surge arrester in the AC outlet to which this device is connected. An appropriate AC surge arrester is defined as one that is suitably rated, and certified by UL (Underwriter's Laboratories), another NRTL (Nationally Recognized Testing Laboratory), or a recognized safety certification body in the country/region of use. This is to avoid damage to the equipment caused by local lightning strikes and other electrical surges.

This equipment uses CA11A telephone jacks.
Avis réservé aux utilisateurs du réseau téléphonique du Canada

Ce produit est conforme aux spécifications techniques d’Industrie Canada. Le numéro REN (ringer equivalence number : numéro d’équivalence de sonnerie) fournit une indication du nombre maximum de terminaux pouvant être connectés à l’interface téléphonique. En bout de ligne, le nombre d’appareils qui peuvent être connectés n’est pas directement limité, mais la somme des REN de ces appareils ne doit pas dépasser cinq. Le numéro REN du modem est indiqué sur l’étiquette produit située à l’arrière de l’équipement.

Les compagnies de téléphone constatent que les surtensions électriques, en particulier celles dues à la foudre, entraînent d’importants dégâts sur les terminaux privés connectés à des sources d’alimentation CA. Il s’agit-là d’un problème majeur d’échelle nationale. En conséquence, il vous est recommandé de brancher un parasurtenseur dans la prise de courant à laquelle l’équipement est connecté. Utilisez un parasurtenseur répondant à des caractéristiques nominales satisfaisantes et certifié par le laboratoire d’assureurs UL (Underwriter’s Laboratories), un autre laboratoire agréé de type NRTL (Nationally Recognized Testing Laboratory) ou un organisme de certification agréé dans votre région ou pays. Ceci prévient tout endommagement de l’équipement causé par les orages et autres surtensions électriques.

Cet équipement utilise des prises de téléphone CA11A.

Notice to users of the New Zealand telephone network

The following are special conditions for the Facsimile User Instructions. The grant of a telepermit for any item of terminal equipment indicates only that Telecom has accepted that the item complies with minimum conditions for connection to its network. It indicates no endorsement of the product by Telecom, nor does it provide any sort of warranty. Above all, it provides no assurance that any item will work correctly in all respects with another item of telepermitted equipment of a different make or model, nor does it imply that any product is compatible with all of Telecom’s network services.

This equipment shall not be set up to make automatic calls to the Telecom’s 111 Emergency Service.

This equipment may not provide for the effective hand-over of a call to another device connected to the same line.

This equipment should not be used under any circumstances that may constitute a nuisance to other Telecom customers.

Some parameters required for compliance with Telecom’s telepermit requirements are dependent on the equipment associated with this device. The associated equipment shall be set to operate within the following limits for compliance to Telecom’s specifications:

- There shall be no more than 10 call attempts to the same number within any 30 minute period for any single manual call initiation, and
- The equipment shall go on-hook for a period of not less than 30 seconds between the end of one attempt and the beginning of the next call attempt.
- The equipment shall be set to ensure that automatic calls to different numbers are spaced such that there is not less than 5 seconds between the end of one call attempt and the beginning of another.

South Africa telecommunications notice

This modem must be used in conjunction with an approved surge protection device when connected to the PSTN.
Using this product in Switzerland

This product requires a Swiss billing tone filter (Lexmark part number 14B5109 or 80D1877) to be installed on any line which receives metering pulses in Switzerland. The Lexmark filter must be used, as metering pulses are present on all analog telephone lines in Switzerland.

Utilisation de ce produit en Suisse

Cet appareil nécessite l’utilisation d’un filtre de tonalité de facturation suisse (n° de référence Lexmark : 14B5109 ou 80D1877) devant être installé sur toute ligne recevant des impulsions de comptage en Suisse. Ce filtre doit être utilisé pour toute installation car ces impulsions existent sur toutes les lignes téléphoniques suisses.

Verwendung dieses Produkts in der Schweiz

Für dieses Produkt muss ein schweizerischer Billing Tone Filter zur Zählzeichenübertragung (Lexmark Teilenummer 14B5109 oder 80D1877) für jede Leitung installiert werden, über die in der Schweiz Zeitsteuertakte übertragen werden. Die Verwendung des Lexmark Filters ist obligatorisch, da in allen analogen Telefonleitungen in der Schweiz Zeitsteuertakte vorhanden sind.

Uso del prodotto in Svizzera

Questo prodotto richiede un filtro toni Billing svizzero, (codice Lexmark 14B5109 o 80D1877) da installare su tutte le linee che ricevono impulsi remoti in Svizzera. È necessario utilizzare il filtro Lexmark poiché gli impulsi remoti sono presenti su tutte le linee analogiche in Svizzera.

Temperature information

<table>
<thead>
<tr>
<th>Temperature Type</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ambient temperature</td>
<td>15–32° C (60–90° F)</td>
</tr>
<tr>
<td>Shipping temperature</td>
<td>-40–60° C (-40–140° F)</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>1–60° C (34–140° F)</td>
</tr>
</tbody>
</table>

ENERGY STAR

Notices
## Power consumption

### Product power consumption

The following table documents the power consumption characteristics of the product.

**Note:** Some modes may not apply to your product.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
<th>Power consumption (Watts)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing</td>
<td>The product is generating hard-copy output from electronic inputs.</td>
<td>Lexmark 5600 Series: 23.4; Lexmark 6600 Series: 23.89</td>
</tr>
<tr>
<td>Copying</td>
<td>The product is generating hard-copy output from hard-copy original documents.</td>
<td>Lexmark 5600 Series: 18.42; Lexmark 6600 Series: 20.53</td>
</tr>
<tr>
<td>Scanning</td>
<td>The product is scanning hard-copy documents.</td>
<td>Lexmark 5600 Series: 9.67; Lexmark 6600 Series: 11.80</td>
</tr>
<tr>
<td>Ready</td>
<td>The product is waiting for a print job.</td>
<td>Lexmark 5600 Series: 7.4; Lexmark 6600 Series: 9.84</td>
</tr>
<tr>
<td>Power Saver</td>
<td>The product is in energy-saving mode.</td>
<td>Lexmark 5600 Series: 3.94; Lexmark 6600 Series: 5.89</td>
</tr>
<tr>
<td>Off</td>
<td>The product is plugged into a wall outlet, but the power switch is turned off.</td>
<td>Lexmark 5600 Series 0.27; Lexmark 6600 Series 0.29</td>
</tr>
</tbody>
</table>

The power consumption levels listed in the previous table represent time-averaged measurements. Instantaneous power draws may be substantially higher than the average.

Values are subject to change. See [www.lexmark.com](http://www.lexmark.com) for current values.

### Power Saver

This product is designed with an energy-saving mode called Power Saver. The Power Saver Mode is equivalent to the EPA Sleep Mode. The Power Saver Mode saves energy by lowering power consumption during extended periods of inactivity. The Power Saver Mode is automatically engaged after this product is not used for a specified period of time, called the Power Saver Timeout.

**Factory default Power Saver Timeout for this product (in minutes):** 60

### Off mode

If this product has an off mode which still consumes a small amount of power, then to completely stop product power consumption, disconnect the power supply cord from the wall outlet.

### Total energy usage

It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are provided in power units of Watts, the power consumption should be multiplied by the time the product spends in each mode in order to calculate energy usage. The total product energy usage is the sum of each mode's energy usage.
LEXMARK LICENSE AGREEMENTS

PLEASE READ CAREFULLY: BY USING THIS PRODUCT, YOU AGREE TO BE BOUND BY ALL THE TERMS AND CONDITIONS OF THESE LICENSE AGREEMENTS. IF YOU DO NOT AGREE WITH THE TERMS OF THESE LICENSE AGREEMENTS, PROMPTLY RETURN THE PRODUCT UNUSED AND REQUEST A REFUND OF THE AMOUNT YOU PAID. IF YOU ARE INSTALLING THIS PRODUCT FOR USE BY OTHER PARTIES, YOU AGREE TO INFORM THE USERS THAT USE OF THE PRODUCT INDICATES ACCEPTANCE OF THESE TERMS.

CARTRIDGE LICENSE AGREEMENT

I agree that the patented print cartridge(s) shipped with this printing device are sold subject to the following license/agreement: The patented print cartridge(s) contained inside is/are licensed for a single use only and is/are designed to stop working after delivering a fixed amount of ink. A variable amount of ink will remain in the cartridge when replacement is required. After this single use, the license to use the print cartridge terminates, and the used cartridge must be returned only to Lexmark for remanufacturing, refilling or recycling. If I buy another cartridge in the future that is sold subject to the above terms, I accept such terms as to that cartridge. If you do not accept the terms of this single use license/agreement; return this product in its original packaging to your point of purchase. A replacement cartridge sold without these terms is available at www.lexmark.com.

LEXMARK SOFTWARE LICENSE AGREEMENT

This Software License Agreement ("License Agreement") is a legal agreement between you (either an individual or a single entity) and Lexmark International, Inc. ("Lexmark") that, to the extent your Lexmark product or Software Program is not otherwise subject to a written software license agreement between you and Lexmark or its suppliers, governs your use of any Software Program installed on or provided by Lexmark for use in connection with your Lexmark product. The term “Software Program” includes machine-readable instructions, audio/visual content (such as images and recordings), and associated media, printed materials and electronic documentation, whether incorporated into, distributed with or for use with your Lexmark product.

1 STATEMENT OF LIMITED WARRANTY. Lexmark warrants that the media (e.g., diskette or compact disk) on which the Software Program (if any) is furnished is free from defects in materials and workmanship under normal use during the warranty period. The warranty period is ninety (90) days and commences on the date the Software Program is delivered to the original end-user. This limited warranty applies only to Software Program media purchased new from Lexmark or an Authorized Lexmark Reseller or Distributor. Lexmark will replace the Software Program should it be determined that the media does not conform to this limited warranty.

2 DISCLAIMER AND LIMITATION OF WARRANTIES. EXCEPT AS PROVIDED IN THIS LICENSE AGREEMENT AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, LEXMARK AND ITS SUPPLIERS PROVIDE THE SOFTWARE PROGRAM "AS IS" AND HEREBY DISCLAIM ALL OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, TITLE, NON-INFRINGEMENT, MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ABSENCE OF VIRUSES, ALL WITH REGARD TO THE SOFTWARE PROGRAM. This Agreement is to be read in conjunction with certain statutory provisions, as that may be in force from time to time, that imply warranties or conditions or impose obligations on Lexmark that cannot be excluded or modified. If any such provisions apply, then to the extent Lexmark is able, Lexmark hereby limits its liability for breach of those provisions to one of the following: replacement of the Software Program or reimbursement of the price paid for the Software Program.
3 LICENSE GRANT. Lexmark grants you the following rights provided you comply with all terms and conditions of this License Agreement:

a Use. You may Use one (1) copy of the Software Program. The term “Use” means storing, loading, installing, executing, or displaying the Software Program. If Lexmark has licensed the Software Program to you for concurrent use, you must limit the number of authorized users to the number specified in your agreement with Lexmark. You may not separate the components of the Software Program for use on more than one computer. You agree that you will not Use the Software Program, in whole or in part, in any manner that has the effect of overriding, modifying, eliminating, obscuring, altering or de-emphasizing the visual appearance of any trademark, trade name, trade dress or intellectual property notice that appears on any computer display screens normally generated by, or as a result of, the Software Program.

b Copying. You may make one (1) copy of the Software Program solely for purposes of backup, archiving, or installation, provided the copy contains all of the original Software Program’s proprietary notices. You may not copy the Software Program to any public or distributed network.

c Reservation of Rights. The Software Program, including all fonts, is copyrighted and owned by Lexmark International, Inc. and/or its suppliers. Lexmark reserves all rights not expressly granted to you in this License Agreement.

d Freeware. Notwithstanding the terms and conditions of this License Agreement, all or any portion of the Software Program that constitutes software provided under public license by third parties (“Freeware”) is licensed to you subject to the terms and conditions of the software license agreement accompanying such Freeware, whether in the form of a discrete agreement, shrink-wrap license, or electronic license terms at the time of download. Use of the Freeware by you shall be governed entirely by the terms and conditions of such license.

4 TRANSFER. You may transfer the Software Program to another end-user. Any transfer must include all software components, media, printed materials, and this License Agreement and you may not retain copies of the Software Program or components thereof. The transfer may not be an indirect transfer, such as a consignment. Prior to the transfer, the end-user receiving the transferred Software Program must agree to all these License Agreement terms. Upon transfer of the Software Program, your license is automatically terminated. You may not rent, sublicense, or assign the Software Program except to the extent provided in this License Agreement, and any attempt to do so shall be void.

5 UPGRADES. To Use a Software Program identified as an upgrade, you must first be licensed to the original Software Program identified by Lexmark as eligible for the upgrade. After upgrading, you may no longer use the original Software Program that formed the basis for your upgrade eligibility.

6 LIMITATION ON REVERSE ENGINEERING. You may not alter, decrypt, reverse engineer, reverse assemble, reverse compile or otherwise translate the Software Program, except as and to the extent expressly permitted to do so by applicable law for the purposes of inter-operability, error correction, and security testing. If you have such statutory rights, you will notify Lexmark in writing of any intended reverse engineering, reverse assembly, or reverse compilation. You may not decrypt the Software Program unless necessary for the legitimate Use of the Software Program.

7 ADDITIONAL SOFTWARE. This License Agreement applies to updates or supplements to the original Software Program provided by Lexmark unless Lexmark provides other terms along with the update or supplement.

8 LIMITATION OF REMEDIES. To the maximum extent permitted by applicable law, the entire liability of Lexmark, its suppliers, affiliates, and resellers, and your exclusive remedy shall be as follows: Lexmark will provide the express limited warranty described above. If Lexmark does not remedy defective media as warranted, you may terminate your license and your money will be refunded upon the return of all of your copies of the Software Program.
9 LIMITATION OF LIABILITY. To the maximum extent permitted by applicable law, for any claim arising out of Lexmark’s limited warranty, or for any other claim whatsoever related to the subject matter of this Agreement, Lexmark’s and its suppliers’ liability for all types of damages, regardless of the form of action or basis (including contract, breach, estoppel, negligence, misrepresentation, or tort), shall be limited to the greater of $5,000 or the money paid to Lexmark or its Authorized remarketers for the license hereunder for the Software Program that caused the damages or that is the subject matter of, or is directly related to, the cause of action.

In no event will Lexmark, its suppliers, subsidiaries, or resellers be liable for any special, incidental, exemplary, punitive, or consequential damages (including but not limited to lost profits or revenues, lost savings, interruption of use or any loss of, inaccuracy in, or damage to, data or records, for claims of third parties, or damage to real or tangible property, for loss of privacy arising out or in any way related to the use of or inability to use the Software Program, or otherwise in connection with any provision of this License Agreement), regardless of the nature of the claim, including but not limited to breach of warranty or contract, tort (including negligence or strict liability), and even if Lexmark, or its suppliers, affiliates, or remarketers have been advised of the possibility of such damages, or for any claim by you based on a third-party claim, except to the extent this exclusion of damages is determined legally invalid. The foregoing limitations apply even if the above-stated remedies fail of their essential purpose.

10 TERM. This License Agreement is effective unless terminated or rejected. You may reject or terminate this license at any time by destroying all copies of the Software Program, together with all modifications, documentation, and merged portions in any form, or as otherwise described herein. Lexmark may terminate your license upon notice if you fail to comply with any of the terms of this License Agreement. Upon such termination, you agree to destroy all copies of the Software Program together with all modifications, documentation, and merged portions in any form.

11 TAXES. You agree that you are responsible for payment of any taxes including, without limitation, any goods and services and personal property taxes, resulting from this Agreement or your Use of the Software Program.

12 LIMITATION ON ACTIONS. No action, regardless of form, arising out of this Agreement may be brought by either party more than two years after the cause of action has arisen, except as provided under applicable law.

13 APPLICABLE LAW. This Agreement is governed by the laws of the Commonwealth of Kentucky, United States of America. No choice of law rules in any jurisdiction shall apply. The UN Convention on Contracts for the International Sale of Goods shall not apply.

14 UNITED STATES GOVERNMENT RESTRICTED RIGHTS. The Software Program has been developed entirely at private expense. Rights of the United States Government to use the Software Program is as set forth in this Agreement and as restricted in DFARS 252.227-7014 and in similar FAR provisions (or any equivalent agency regulation or contract clause).

15 CONSENT TO USE OF DATA. You agree that Lexmark, its affiliates, and agents may collect and use information you provide in relation to support services performed with respect to the Software Program and requested by you. Lexmark agrees not to use this information in a form that personally identifies you except to the extent necessary to provide such services.

16 EXPORT RESTRICTIONS. You may not (a) acquire, ship, transfer, or reexport, directly or indirectly, the Software Program or any direct product therefrom, in violation of any applicable export laws or (b) permit the Software Program to be used for any purpose prohibited by such export laws, including, without limitation, nuclear, chemical, or biological weapons proliferation.

17 AGREEMENT TO CONTRACT ELECTRONICALLY. You and Lexmark agree to form this License Agreement electronically. This means that when you click the “Agree” or “Yes” button on this page or use this product, you acknowledge your agreement to these License Agreement terms and conditions and that you are doing so with the intent to “sign” a contract with Lexmark.
18  CAPACITY AND AUTHORITY TO CONTRACT. You represent that you are of the legal age of majority in the place
you sign this License Agreement and, if applicable, you are duly authorized by your employer or principal to enter
into this contract.

19  ENTIRE AGREEMENT. This License Agreement (including any addendum or amendment to this License
Agreement that is included with the Software Program) is the entire agreement between you and Lexmark relating
to the Software Program. Except as otherwise provided for herein, these terms and conditions supersede all prior
or contemporaneous oral or written communications, proposals, and representations with respect to the
Software Program or any other subject matter covered by this License Agreement (except to the extent such
extraneous terms do not conflict with the terms of this License Agreement, any other written agreement signed
by you and Lexmark relating to your Use of the Software Program). To the extent any Lexmark policies or programs
for support services conflict with the terms of this License Agreement, the terms of this License Agreement shall
control.
Index

A
ad hoc 51
SSID 51
WEP 51
ad hoc network 59
ad hoc wireless network
  adding a printer 53
  creating using Macintosh 51
  creating using Windows 51
additional computers
  installing wireless printer 46
Address Book
  setting up 106
ADF (Automatic Document Feeder)
  loading documents 71
  paper capacity 73
AliceBox 47
aligning print cartridges 114
answering machine
  receiving a fax with 105
appliances
  wireless network 61
assigning IP address 64
Automatic Document Feeder tray 20
Automatic Document Feeder (ADF) 20
  output tray 20
  paper guide 20

B
banner paper, loading 66
blocking host fax settings 110
broadcast fax, sending
  at a scheduled time 104
  immediately 103
buttons, printer control panel
  Address Book 23
  Back 23
  Cancel 23
  Color/Black 23
  Copy 23
  Dialtone 23
  Display 23
  Down arrow 23
  Keypad 23
  Left arrow 23
  OK 23
  Photo 23
  Power 23
  Redial / Pause 23
  Right arrow 23
  Scan 23
  Settings 23
  Start 23
  Two-sided (Duplex) 23
  Up arrow 23
changing wireless settings after installation (Mac) 48
check ink levels 115
cleaning exterior of the printer 117
cleaning print cartridge nozzles 114
Club Internet 47
collating copies 100
Communication not available message 143
configuring IP address 48
connecting using RJ11 adapter 35
connecting the printer telephone wall jack 40
connecting the printer to answering machine 39
computer modem 42
telephone 43
telephone wall jack in Germany 41
connection configurations 62
copy
  making 98
  copy quality, adjusting 99
copying 98
  adjusting quality 99
  collating copies 100
  enlarging an image 98
  making a copy lighter or darker 99
  multiple page images on one sheet 101
  N-up 101
  photos 98
  reducing an image 98
  repeating an image 101
custom-size paper, loading 66, 80
custom-size paper, printing 80
cards
  loading 66
  memory card 85
cartridges, print
  aligning 114
cleaning 114
  installing 111
  ordering 118
  preserving 117
  removing 112
  using genuine Lexmark 113
  wiping 116
changing default settings 28
  Power Saver timeout 28
  temporary settings 28
changing wireless settings after installation (Windows) 48

d
defaults
  resetting factory defaults 119
distinctive ring patterns 107
Index

document
  multiple copies, printing 75
  documents
    faxing using the control panel 103
loading into the Automatic Document Feeder (ADF) 71
loading on scanner glass 70, 93
making color or black-and-white scan 95
printing 74
scanning using the printer control panel 93
duplex cover 20

E
  emission
    notices 154, 155, 156, 157, 158
  enlarging an image 98
  envelopes
    loading 66, 79
    printing 79
error messages
  failed to connect 152
  fax error 149
  fax mode unsupported 149
  no answer 151
  phone line busy 150
  phone line error 151
  remote fax error 150
Ethernet 62
exterior of the printer
  cleaning 117

F
  factory default settings
    resetting internal wireless print server 144
  factory default settings, resetting to 119
  failed to connect error message 152
  fax
    activity reports 109
    forwarding 106
    receiving automatically 105
    receiving manually 105
    setting a manual answer code 108
    fax error 149
    fax footer, setting up 108
  fax mode unsupported error message 149
  fax settings
    blocking unwanted changes 110
  Fax Settings List, printing 109
  fax troubleshooting
    Caller ID not displayed 149
    can receive but not send fax 147
    can send but not receive fax 146
    cannot send or receive fax 144
    printer receives blank fax 148
    received fax has poor print quality 148
  faxing
    Address Book 106
    blocking unwanted faxes 109
    choosing a fax connection 38
    sending a broadcast fax at a scheduled time 104
    sending a broadcast fax immediately 103
    sending using the control panel 103
    sending while behind a PBX 108
    setting up dialing prefix 107
    using digital telephone service 44
    using DSL 44
    using ISDN 44
    using the control panel 103
    while listening to call 103
  FCC notices 154, 155, 159
  finding
    information 10
    MAC address 62
    publications 10
    Web site 10
  finding IP address of computer
    (Mac) 63
  finding IP address of computer
  flash drive
    inserting 86
    printing documents from 77
    printing photos using the proof sheet 91
  forwarding a fax 106
  France
    special wireless setup instructions 47
    FreeBox 47

G
glossy and photo paper,
  loading 74
glossy paper, loading 66
greeting cards
  loading 66

H
heavyweight matte paper,
  loading 66

I
incorrect language appears on display 121
index cards
  loading 66
information needed for setting up printer on wireless network 45
information, finding 10
infrastructure network 59
ink levels, checking 115
inserting
  flash drives 86
  memory cards 85
installation
  cable 58, 59
  installing
    network printer 64
    print cartridges 111
    printer software 30, 126
  installing printer
    on wireless network
      (Macintosh) 45
    on wireless network
      (Windows) 45
  installing wireless printer
    additional computers 46
  interference
    wireless network 61
  internal wireless print server
    resetting to factory default settings 144
  IP address 63
    configuring 48
  IP address, assigning 64
  iron-on transfers, loading 66

J
junk faxes, blocking 109
K
key index 64

L
labels, loading 66
labels, printing 79
language changing 121
last page first, printing 76
LiveBox 47
loading
banner paper 66
custom-size paper 66, 80
documents into the Automatic Document Feeder (ADF) 71
documents on scanner glass 70
envelopes 66, 79
glossy and photo paper 74
glossy paper 66
greeting cards 66
heavyweight matte paper 66
index cards 66
iron-on transfers 66
labels 66
on scanner glass 93
paper 66, 74
photo cards 66
photo paper 66
photos on scanner glass 70
postcards 66
transparencies 66
locating
SSID 55
WEP key 54
WPA key 54

M
MAC address 62
MAC address filtering 62
MAC address, finding 62
Mac printer software using 33
Macintosh
installing printer on wireless network 45
USB 50
wireless 50
magazine articles, loading on scanner glass 70
memory card inserting 85
printing documents from 77
printing photos using the proof sheet 91
memory card slots 20
menus
diagram of 26
menus list 26
multiple copies, printing 75
multiple WEP keys 64

N
N9UF Box 47
network connection
with USB 62
network printer installing 64
network printer does not show up in printer selection list during installation (Windows) 130
network scanning 96
network security 56
network setup page
printing 129
networking
finding IP address of computer 63
finding IP address of computer (Mac) 63
finding IP address of printer 63
IP addresses 63
newspapers, loading on scanner glass 70
no answer error message 151
no wireless network 51
noise emission levels 158
notices 154, 155, 156, 157, 158, 159, 160, 161, 162, 163
N-up copies 101
N-up feature 76

O
On Hook Dial feature 103
ordering paper and other supplies 119

P
page does not print 123
paper
choosing specialty types 78
paper adjustment lever 20

Index
170
photos, printing
using printer control panel 87
PictBridge port 20
PictBridge-enabled camera, connecting 90
postcards
loading 66
power button is not lit 122
power supply port 20
print cartridge carrier 20
print cartridge nozzles, cleaning 114
print cartridges
aligning 114
cleaning 114
installing 111
ordering 118
preserving 117
refilling 113
removing 112
using genuine Lexmark 113
wiping 116
print jobs, canceling 83
print jobs, resuming 82
printer
setting up without a computer 13
printer cannot connect to wireless network 131
printer control panel 20
using 23
printer does not print
wireless 134
printer does not print wirelessly 135
printer menus 26
printer receives blank fax 148
printer software
installing 30
reinstalling 126
removing 126
printing
blocked fax list 109
collate 75
custom-size paper 80
documents 74
documents from memory card or flash drive 77
envelopes 79
labels 79
last page first 76
multiple copies 75
multiple pages on one sheet 76
network setup page 129
photos from digital camera using DPOF 92
photos using printer control panel 87
photos using printer software 88
photos using the proof sheet 91
reverse page order 76
Web page 74
proof sheet, using 91
protocol 63
publications, finding 10
Q
Quick Connect laptop port 34
R
rear USB port 34
received fax has poor print quality 148
receiving a fax automatically 105
fax forwarding 106
manually 105
using an answering machine 105
recycling
WEEE statement 159
reducing an image 98
refilling print cartridges 113
remote fax error 150
removing print cartridges 112
repeating an image 101
reports, fax activity 109
resetting
internal wireless print server to factory default settings 144
resuming
print jobs 82
reverse page order 76
ring patterns, setting 107
RJ11 adapter 35
S
safety information 9
saving
settings 28
scanner glass 20
cleaning 117
loading documents 70
scanner unit 20
scanning
canceling a scan 96
making color or black-and-white scan 95
over a network 96
photos for editing 95
to a computer 93
to a flash drive 93
to a memory card 93
to a network 93
to computer 96
using the printer control panel 93
security
wireless network 55
security information 13
wireless network 56
security key 56
Service Center 121
setting up
Address Book 106
setting up printer
on wireless network (Macintosh) 45
on wireless network (Windows) 45
settings
changing Power Saver timeout 28
disabling timeout 28
saving 28
Setup menu
Fax Settings List 109
setup troubleshooting
incorrect language appears on display 121
page does not print 123
power button is not lit 122
software did not install 122
setup, printer 13
software
removing and reinstalling 126
Service Center 121
XPS driver 31
software did not install 122
solving printer communication problems 126
SSID
ad hoc 51
locating 55
wireless network 54
Index
network printer does not show up in printer selection list during installation (Windows) 130
printer cannot connect to wireless network 131
Wi-Fi indicator light is blinking orange 137, 140
Wi-Fi indicator light is not lit 134
Wi-Fi indicator light is still orange 142
Wi-Fi indicator 20
description of colors 47
interpreting colors 47
light is not lit 134
Wi-Fi indicator light is blinking orange 137, 140
Wi-Fi indicator light is green
printer does not print 135
Wi-Fi indicator light is still orange 142
Wi-Fi Protected Setup 54
WPA 55
WPA key
locating 54
WPA2 55
WPS 54

X

XPS driver
installing 31